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Introduction

The Mobile Analytics Kit (MAKit) code examples demonstrate the core features of MAKit charts, such as
dashboard configuration, applying analytical capability to the charts using the dynamic analytic panels,
chart drilldown and filtering, and semantic zooming. Additionally, all charts have a built-in e-mail sharing
feature, which captures a snapshot image of the chart, and allows the device user to first annotate, then
send the image via the configured e-mail application. MAKit can be used with the SAP Mobile Platform
Hybrid Web Container.

Code Examples Setup

Note: These setup instructions are specific to the Xcode 4.2 IDE. For earlier versions of Xcode, the steps
may differ.

1. CopyMAKitCodeExamples.zip toyour Mac.
2. Unzip MAKitCodeExamples.zip. This creates a folder called MAKitCodeExamples.

3. Inthe Xcode IDE, double-click MAKitCodeExamples.xcodeproj. You should see a screen similar to:

800

@ (.) | MAKitCodeExamples » iPad 5.0 Simulatc

Run Stop Scheme

|| @ A = =» B
D MAKitCodeExamples
1 target, i05 DK 5.0

MAKit.bundle
| _|Resources
| | MetaData
| | Database
| | Model Classes
| | Ul Classes
| |MAKitCodeExamples
|£| MaKitCodeExamplesAppDelegate.h
@ MaAKitCodeExamplesAppDelegate.m
o MainWindow.xib

+ RootViewController.xib
| | Supporting Files

| | Frameworks

| | Products
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e Classes —contains the application source code for the code examples.
e XIB Files —contains the Interface Builder files used in the code examples.

e Database — contains the SQLite® database MAKitSampleDb.sqglite, which is the
datasource for the code examples.

e MetaData — has all the metadata files for each individual feature in the code examples.
All other folders are created by default for any Xcode 4.2 project.
4. Torunthe code example in iPad Simulator, select Product > Run, or click the Run toolbar button.

0% Simulator - iPad [/ i08 5.0 (9A334)

11:36 AN

MAKit Code Examples

Chart Types Dashboard
Sales Dashboard

Dynamic Analytic Panel

Drilldown Example 1

Drilldown Example 2

Filter Example 1

Filter Example 2

Zooming Chart - Example 1
Zooming Chart - Example 2

What-If Analysis Chart

Column Chart

Drilidown Chart

To run the code example on an Apple iPad, install a valid device-provisioning profile in the Xcode IDE
before deploying to the device.

Code Examples
Basic Dashboards
This section demonstrates the chart types supported by MAKit. You can group related charts together to

create a meaningful dashboard, for example, a sales or stock information dashboard. See the
Dashboard ChartTypes.xml metadata file content to learn how to configure different chart types.
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Configure all charts using the <pashboard>..</Dashboard>tags.

Examples of Chart Configuration

<Chart Name="ColumnChart" Title="Region/Product Sales" ChartType="Column" Query="SalesOrder">

<Category Format="" Column="Region" DisplayName="Region" />
<Series Format="" Column="Product" DisplayName="Region" />
<Values>

<Value Format="Currency" Expression="SalesAmount" ValueSequence="1"
DisplayName="Sales Amount" /> </Values>
</Chart>

<Chart Name="BarChart" Title="Salary By Dept/Gender" ChartType="Bar" Query="DeptSalary">

<Category Format="" Column="Department" DisplayName="Department" />
<Series Format="" Column="Sex" DisplayName="Gender" />
<Values>
<Value Format="Rounded2" Expression="Salary" ValueSequence="1" DisplayName="Salary" />
</Values>
</Chart>

<Chart Name="LineChart" Title="Number Of Sales Orders" ChartType="Line" Query="NumberOfOrders">

<Category Format="" Column="Year" DisplayName="Year" />
<Series Format="" Column="Region" DisplayName="Region" />
<Values>

<Value Format="Rounded0" Expression="OrderCount" ValueSequence="1"
DisplayName="Number Of Orders" />
</Values>
</Chart>

<Chart Name="PieChart" Title="Printer Sales" ChartType="Pie" Query="PrinterSales">

<Category Format="" Column="SalesRep" DisplayName="Sales Rep" />
<Series Format="" Column="Product" DisplayName="Type" />
<Values>
<Value Format="Currency" Expression="Sales" ValueSequence="1" DisplayName="Sales Amount " />
</Values>
</Chart>

<Chart Name="BubbleChart" Title="US Crime Data" ChartType="Bubble" Query="CrimeData">

<Category Format="" Column="State" DisplayName="State" />
<Series Format="" Column="CrimeType" DisplayName="CrimeType" />
<Values>

<Value Format="Rounded2" Expression="Ratio" ValueSequence="1" DisplayName="Crime Ratio" />
<Value Format="Rounded2" Expression="Ratio" ValueSequence="2" DisplayName="Crime Ratio" />
</Values>
</Chart>

The metadata file also configures the dashboard layouts for either portrait or landscape mode.

Example of Dashboard Layout

<DashboardLayout>
<Landscape>
<Layout Name="ColumnChart" Top="1" Left="1" Width="49" Height="32" />
<Layout Name="BarChart" Top="1" Left="51" Width="48" Height="32" />
<Layout Name="LineChart" Top="34" Left="1" Width="49" Height="32" />
<Layout Name="PieChart" Top="34" Left="51" Width="48" Height="32" />
<Layout Name="BubbleChart" Top="67" Left="1" Width="98" Height="32" />
</Landscape>
<Portrait>
<Layout Name="ColumnChart" Top="1" Left="1" Width="49" Height="32" />
<Layout Name="BarChart" Top="1" Left="51" Width="48" Height="32" />
<Layout Name="LineChart" Top="34" Left="1" Width="49" Height="32" />
<Layout Name="PieChart" Top="34" Left="51" Width="48" Height="32" />
<Layout Name="BubbleChart" Top="67" Left="1" Width="98" Height="32" />
</Portrait>
</DashboardLayout>
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This dashboard layout configuration renders a chart similar to:
r
Carrier = 1:29 PM

MAKIt Code Examples Chart Types Dashboard

Region/Product Sales : Salary By Dept/Gender
Region: Canada, Sales Amount: o

" Baseball Cap: $13,369 W Shorts: $15,267

117700.00
k

uLlJJHJJﬂJjﬂJ

Number Of Sales Orders X Printer Sales

Year: 2003, Number Of Orders:

T Canada:8 @ Central: 29 | [ Eastern: 29 @ Stellar: 32.2%

US Crime Data

State: Alabama

T Aggravated_Assault: Crime Ratio: 247.80 Crime Ratio: 247.80 | @ Burglary: Crime Ratio: 953.80 @
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Dynamic Analytic Panel

This section demonstrates the dynamic analytic (DA) capabilities of MAKit. Dynamic analytics is a powerful
feature that lets you interactively visualize reports by changing some parameters at runtime, and
refreshing the charts based on the new values.

The heart of dynamic analytics is the variable definition in the metadata, which constructs the value axis
expressions using the variables. When the device user changes a variable value at runtime, MAKit
evaluates the value axis expression, and refreshes the charts based on the new value.

Define variables in the metadata using the <variables>...</Variables> tags, and group them in the
Dynamic Analytic panel metadata using the <paranel>....</DAaPanel> tags. Configure the Dynamic Analytic
panel using a dashboard layout that is similar to that used for configuring charts.

MAKit automatically generates Ul controls to manipulate the values of these variables:

Variable Type User Interface Generated by MAKit

integer Slider control

float PickerView control
boolean Switch control
enum PickerView control
datetime Date Picker control
<Variables>

<Variable Name="$salesdrive" DisplayName="Sales Promotion ?" VariableType="boolean" Value="0" />

<Variable Name="S$region" DisplayName="Sales Promotion in " VariableType="enum" Selection="0">
<Choices>
<Choice Display="Eastern" Value="Eastern" />
<Choice Display="Western" Value="Western" />
<Choice Display="Central" Value="Central" />
<Choice Display="South" Value="South" />
<Choice Display="Canada" Value="Canada" />
</Choices>
</Variable>
<Variable Name="S$dept" DisplayName="Pay Raise Department " VariableType="enum" Selection="0">
<Choices>
<Choice Display="R &amp; D" Value="R &amp; D" />
<Choice Display="Sales" Value="Sales" />
<Choice Display="Finance" Value="Finance" />
<Choice Display="Marketing" Value="Marketing" />
<Choice Display="Shipping" Value="Shipping" />
</Choices>
</Variable>
<Variable Name="S$hike" DisplayName="Pay Raise % " VariableType="float" Value="0" Min="0"
Max="18" Decimals="1" />
</Variables>

The variables defined in the metadata are used in value expressions of chart configuration as shown here:
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<Chart Name="ProductSales" Title="Region/Product Sales" ChartType="Column" Query="SalesOrder">

<Category Format="" Column="Region" DisplayName="Region" />
<Series Format="" Column="Product" DisplayName="Product" />
<Values>

<Value Format="Currency" Expression="if ($salesdrive==1,SalesAmount+ (SalesAmount *
0.30),1if (Region==$region, SalesAmount+ (SalesAmount * 0.80),SalesAmount))"
ValueSequence="1" DisplayName="Sales Amount" />
</Values>
</Chart>

<Chart Name="Orders" Title="Number Of Sales Orders" ChartType="Line" Query="NumberOfOrders">

<Category Format="" Column="Year" DisplayName="Year" />
<Series Format="" Column="Region" DisplayName="Region" />
<Values>
<Value Format="Rounded0" Expression="if ($salesdrive==1,0rderCount * 2,
if (Region==$region, OrderCount * 6,0rderCount))" ValueSequence="1"
DisplayName="Number Of Orders" />
</Values>
</Chart>

<Chart Name="PayRaise" Title="Department Salary" ChartType="Bar" Query="DeptSalary">

<Category Format="" Column="Department" DisplayName="Department" />
<Series Format="" Column="Sex" DisplayName="Gender" />
<Values>

<Value Format="Rounded2" Expression="if (Department==$dept, (Salary + Salary *
(Shike/100)),Salary)" ValueSequence="1" DisplayName="Salary" />
</Values>
</Chart>

Dynamic Analytic Panel Configuration in Dashboard and DashboardLayout

<DAPanel Name="SalesDA" Title="Sales Dynamic Analytic Panel">
<VariableName Name="$salesdrive" Sequence="1" />
<VariableName Name="$region" Sequence="2" />

</DAPanel>

<DAPanel Name="EmpDA" Title="Salary Dynamic Analytic Panel">
<VariableName Name="$dept" Sequence="1" />
<VariableName Name="$hike" Sequence="2" />
</DAPanel>
<DashboardLayout>
<Landscape>
<Layout Name="ProductSales" Top="1" Left="1" Width="49" Height="35" />
<Layout Name="Orders" Top="1" Left="51" Width="48" Height="35" />
<Layout Name="SalesDA" Top="37" Left="1" Width="98" Height="20" />
<Layout Name="PayRaise" Top="60" Left="1" Width="53" Height="35" />
<Layout Name="EmpDA" Top="60" Left="55" Width="44" Height="35" />
</Landscape>

<Portrait>
<Layout Name="ProductSales" Top="1" Left="1" Width="49" Height="35" />
<Layout Name="Orders" Top="1" Left="51" Width="48" Height="35" />
<Layout Name="SalesDA" Top="37" Left="1" Width="98" Height="18" />
<Layout Name="PayRaise" Top="57" Left="1" Width="53" Height="40" />
<Layout Name="EmpDA" Top="57" Left="55" Width="44" Height="40" />

</Portrait>

</DashboardLayout>
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The Dynamic Analytic panel renders in the dashboard in the same manner as individual chart items. When
variable values are changed, relevant charts are refreshed based on the expression evaluation.

Carrier = 1:45 PM

MAKIt Code Examples Dynamic Analytic Panel

Region/Product Sales ¢ Number Of Sales Orders

Region: Canada, Sales Amount: Year: 2003, Number Of Orders:

" Baseball Cap: $13,369 | @ Shorts: $15,267 | " Canada:8 | @ Central: 29 @ Eastern: 29

LLI_LI_JIIJIL

Sales Dynamic Analytic Panel

Department Salary : Salary Dynamci Analytic Panel

117700.00
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The Dynamic Analytic panel appears when the chart is in full-view mode:

3:07 PM

Number Of Sales Orders

Year: 2003, Number Of Orders:

© Canada: 8 @ Central: 29 | @ Eastern: 29 | @ South: 12 | @ Western: 30
200 -
150 -
100 -
50 -
0
2003 2004 2005 2006
T o
Sales Promotion ? OFF | Isales Promotionin ~ Western
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This figure shows the refreshed chart based on a new variable value (“Eastern”):

3:08 PM

Number Of Sales Orders

Year: 2003, Number Of Orders:

Canada: 8 @ Central: 29 | @ Eastern: 174 | @ South: 12 = Western: 5

700 -

2005 2006

Sales Promotion ? OFF | Iscles Promotionin ~ Eastern

Drilldown Charts

MAKit lets you drill down by category or by series, or both, on a single chart. You can define any level of
drilldown chart in the metadata definition.

You can drill down only when the chart is in full-view mode, by double-tapping the chart (drilldown by
category) or by double-tapping either the category value or the series value in the data grid table of the
chart.

Configure the drilldown charts using <prillbownGroup>...</DrillDownGroup> tags; configure individual
charts at each level using <chart> ... </Chart>tags.

Seethe Drilldown Sales.xml and Drilldown Energy.xml metadata files in the code example
to see drilldown configurations.
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Example of Drilldown Configuration

<DrillDownGroup Name="Reseller" Title="Reseller Drilldown Charts">
<Chart Name="ResellerSales" Title="Reseller Sales Summary " ChartType="Bar" ChartSequence="1"
Query="ResellerSummary" >

<Category Format="" Column="Region" DisplayName="Sales Region" />
<Series Format="" Column="ProductCategory" DisplayName="ProductCategory" />
<Values>

<Value Format="Currency" Expression="SalesAmount" ValueSequence="1"
DisplayName="Sales Amount in US Dollars" />
</Values>
</Chart>
<Chart Name="SalesByCountry" Title="Reseller Sales By Country" ChartType="Bar" ChartSequence="2"
Query="ResellerByCountry" >

<Category Format="" Column="Country" DisplayName="Country" />
<Series Format="" Column="ProductCategory" DisplayName="Product Category" />
<Values>

<Value Format="Currency" Expression="SalesAmount" ValueSequence="1"
DisplayName="Sales Amount in US Dollars" />
</Values>
</Chart>
<Chart Name="SalesByCategory" Title="Sales By Product Category " ChartType="Bar" ChartSequence="3"
Query="ResellerByCategory">

<Category Format="" Column="ProductSubCategory" DisplayName="Product Sub Category" />
<Series Format="" Column="Country" DisplayName="Country" />
<Values>

<Value Format="Currency" Expression="SalesAmount" ValueSequence="1"
DisplayName="Sales Amount in US Dollars" />
</Values>
</Chart>
</DrillDownGroup>

The Drilldown chart renders similarly to other charts configured in the dashboard layout:
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1:52 PM

Carrier =

MAKit Code Examples Drilldown Example 1

Reseller Sales Summary

$5,531,144

$10,977,163

$10,855,859

$26,589,696

Online Sales Drive

Driver For Sales: Manufacturer, Sales Amount in US Dollars:

" Europe: $1,207,251 W North America: $2,767,663

B Pacific: $2,023,208
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Drilldown chart in full-view mode:

3:09 PM

Reseller Sales Summary

Sales Region  Sales Amount in US Dollars 10M 20M 30M 40M 50M 60M
| | |

3 4
$5,531,144
$10,977,163

Europe
$10,855,859

526,589,696

$18,662,273

$56,469,132

North America

$22,662,153

548,392,837

$12,641,135

$15,881,877 |

Pacific
$8,044,825

$12,848,150

7 Accessories [ Bikes [ Clothing [ Components
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Drilldown by category (double-tap “Europe” in the bar chart):

iPad 7 3:09 PM
Reseller Sales Summary Reseller Sales By Country
Europe B O =
Country Sales Amount in US Dollars oM aM oM aM 1M 12M 140
e R ———
France ‘ [
54,365,383

$12,078,586

$1,543,655 -

$1,990,490
Germany

52,440,790

$4,636.825

$4,393,414

United Kingdom

$9,874,286

Drilldown by series (double-tap ”Bikes” in the table):

Carrier = 2:11 PM

Reseller Sales By Country Sales By Product Category

Europe > France, Bikes

Product Sub Category ~ Sales Amount in US Dollars M 2M 3M aM SM
Bib-Shorts $366,665 | | |

Bike Racks 5942771

Bottles and Cages 528,779
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Dashboard Filters

MAKit dashboard filters let you filter chart data using query arguments. Filters are global in nature and
affect all charts associated with that filter. Data that does not fulfill the range or criteria specified is
filtered out.

Filters are initially defined in the metadata using <pashboard> ...</Dashboard>tags, and individual charts
configured in the metadata can apply previously defined filters.

There are two types of filter: a range filter lets you specify an integer range, and a picklist filter lets you
select discrete sets of data criteria.

<!-- Filter Definition in Dashboard -->

<Filters>
<Filter Name="Products" Sequence="1" SourceQuery="ResellerQry" FilterType="picklist"

Column="ProductCategory" />
<Filter Name="Region" Sequence="2" SourceQuery="ResellerQry" FilterType="picklist" Column="Region" />
<Filter Name="Sales Reason" Sequence="3" SourceQuery="OnlineSalesQry" FilterType="picklist"
Column="SalesReason" /
</Filters>

<!-- Configuring Charts with Filters -->

<Chart Name="ResellerSales" Title="Reseller Sales By Product" ChartType="Column" Query="ResellerQry">

<Category Format="" Column="ProductCategory" DisplayName="Product Category" />
<Series Format="" Column="Region" DisplayName="Sales Region"/>
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName=" " />
</Values>
<Filters>

<FilterName Name="Products" />
<FilterName Name="Region" />
</Filters>
</Chart>

<Chart Name="OnlineSales" Title="Online Sales Drive" ChartType="StackedColumn" Query="OnlineSalesQry">

<Category Format="" Column="SalesReason" DisplayName="Sales Reason" />
<Series Format="" Column="Region" DisplayName="Sales Region"/>
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="" />
</Values>
<Filters>

<FilterName Name="Sales Reason" />
<FilterName Name="Region" />
</Filters>
</Chart>

Dashboard filters work only in the dashboard view; they are unavailable in full-view mode.
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The filters defined on the dashboard appear in the top row:

=

Carrier = 2:15PM

MAKIt Code Examples Filter Example 1

ucts | Region | Sales Reason

Reseller Sales By Product
Product Category: Accessories, Sales Amount in Local Currency:

" Europe: $5,531,144 | North America: $18,552,273 | Pacific: $12,641,135

Online Sales Drive
Sales Reason: Manufacturer, Sales Amount in Local Currency:

" Europe: $1,207,251 [ North America: $2,767,663 @ Pacific: $2,023,208
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Picklist filter:

Carrier = 2:18 PM

MAKit Code Examples Filter Example 1
Products | Region | Sales Reason
AN

Sales By Product

cancel ProductCategory Done

ories, Sales Amount in Local Currency:
Accessories

th America: $18,552,273 | W Pacific: $12,641,135
Bikes
Clothing

Components

Online Sales Drive

Sales Reason: Manufacturer, Sales Amount in Local Currency:

© Europe: $1,207,251 | North America: $2,767,663 | @ Paclfic: $2,023,208
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Result of filters applied:

Carrier = 2:20 PM

MAKit Code Examples Filter Example 1

‘Products: 3 | Region | Sales Reason

Reseller Sales By Product

Product Category: Accessories, Sales Amount in Local Currency:

Europe: $5,531,144 | North America: $18,552,273 W Pacific: $12,641,135

Zooming Charts
Semantic zooming lets device users view a large data set in different scales—for example, an overview of
a large chart by zooming out, or every detail by zooming in.

Configure zooming charts, and the behavior of a chart at each zooming level, in the metadata

configuration file.

Like drilldown charts, zooming can be performed only in full-view mode, via hierarchy buttons.
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<Chart Name="ZoomingChart" Title="Sales By Product Category" ChartType="Column">

<Category Format="" DisplayName="" />
<Values>
<Value Format="Rounded2" Expression="SalesAmount" ValueSequence="1" DisplayName="Sales Amount" />
</Values>
<ZoomingLevels>

<ZoomingLevel Query="SalesByCategory" CategoryColumn="ProductCategory"
Title="ProductCategory" />
<ZoomingLevel Query="SalesBySubCategory" CategoryColumn="SubCategory"
Title="ProductSubCategory" />
<zZoomingLevel Query="SalesBySubCategoryAndYear" CategoryColumn="Year" Title="Year" />
</ZoomingLevels>
</Chart>

Chart at ZoomLevel=1:

3:11 PM

Sales By Product Category

ProductCategory ProductSubCategory

ProductCat: y: A ies, Sales Amount:

-

| 67445112.00 |

160M -

140M -

120M -

100M -

BOM -

60M -

40M -

20M -

Accessories Bikes Components
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Chart at ZoomLevel=2:

3:11 PM

Sales By Product Category

ProductCategot ProductSubCategory

ProductCategory: Accessories, ProductSubCategory: Bike Racks, Sales Amount: ‘

1726342.25

7OM -

6OM -

50M -
40M -
30M -
20M -
10M -
0 | — | -

Accessories Bikes Components
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Chart at ZoomLevel=3:

3:11 PM

Sales By Product Category

ProductCategory ProductSubCategory

ProductCategory: Accessories, ProductSubCategory: Bike Racks, Year: 2003, Sales Amount:

u 986353.94

E0M -

50M -
40M -
30M
20M -
10M
o= - =

Accessories Bikes c

~-f-,-,-,---,---r',-:'~,f--,------f-,",",‘i?53i,‘?“,i-,------,-f-,-,---,-—-f-,-,—-, o L it oo

What-If Analysis

What-if analysis is similar to dynamic analytics. Both allow the device user to change data behind the
chart and immediately see the chart updated; both map the data to Ul controls on the screen. However,
while dynamic analytics changes the variables defined in expressions, what-if analysis changes data
retrieved from the datasource.

Configure what-if analysis in the metadata, using what-if columns, which are used in value expressions in
the chart configuration.

Configure what-if columns using <WhatIfColumns>..</WhatIfColumns>tags.
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Example of What-If Analysis Configuration

<Chart Name="WhatIfChart" Title="Net Income From Sales" ChartType="Line" Query="ProductSales">

<Category Format="" Column="Region" DisplayName="Region" />
<Series Format="" Column="Product" DisplayName="Product" />
<Values>
<Value Format="Currency" Expression="((UnitPrice * Quantity) - ((Cost_Of Revenue * Quantity) +

(RD_Cost * Quantity) + (Mkt_Cost * Quantity) + (Admin_Cost * Quantity)))"
ValueSequence="1" DisplayName="Net Income" />
</Values>
<!-- What If Columns -->
<WhatIfColumns>
<Column Name="UnitPrice" DisplayName="Unit Price" VariableType="float" Min="1.0" Max="110.0"
Step="1.0" Decimals="2" />
<Column Name="Cost Of Revenue" DisplayName="Cost Of Revenue" VariableType="integer" Min="1"
Max="40" />
<Column Name="RD Cost" DisplayName="R &amp; D Cost" VariableType="integer" Min="1" Max="18" />
<Column Name="Mkt Cost" DisplayName="Marketing Cost" VariableType="float" Min="1.0" Max="10.0"
Step="1.0" Decimals="2" />
</WhatIfColumns>
</Chart>

What-if analysis works only in full-view mode, rendering a Ul control for each what-if column in the
metadata.

=
To see what-if analysis behavior, select a category and tap the What-If button in the toolbar. Tap
the button again to close the What-If panel. When the What-If panel is open, changing the values in a
what-if column immediately updates the chart for the selected category.
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Chart in full-view mode before invoking the What-If panel:

3:12 PM

Net Income From Sales

Region: Canada, Net Income:

© Baseball Cap-Cotton Cap: $3,699 | [ Tee Shirt-Crew Neck: $11,655 | @ Tee Shirt-Tank Top: $3,523

40K -

w

0

N
]

n

431

S
I

20K -

15K -

10K -

Canada Central Eastern South Western
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=
Tap the What-If button to invoke the What-If panel for the selected category (“Central” region):

3:12 PM

Net Income From Sales

Region: Central, Net Income:

. Baseball Cap-Cotton Cap: $17,088 | [l Tee Shirt-Crew Neck: $37,727 | [ Tee Shirt-Tank Top: 510,188

45K -
40K -
®
35K -
30K -
25K -
20K -
15K -
10K -
5K -
d Canada Central Eastern South Western
Unit Price 38 @ Unit Price 66 @
Cost Of Revenue 14 e ——— Cost Of Revenue 24 oo
R & D Cost 4 e > R&DCost § e
Marketing Cost 3 O Marketing Cost 6 O
Unit Price 38 @
Cost Of Revenue 14 o=
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Changing the values in a what-if column updates the chart accordingly:

3:13 PM

Net Income From Sales

Region: Central, Net Income:

| Baseball Cap-Cotton Cap: $36,131 | [l Tee Shirt-Crew Neck: $37,727 | [ Tee Shirt-Tank Top: 510,188

45K -
40K -
35K -
30K -
25K -
20K -
15K -
10K -
5K -
i Canada Central Eastern South Western
Unit Price 38 @ Unit Price 66 @
Cost Of Revenue 3 7 Cost Of Revenue 24 o=
R & D Cost 2 _ T RA&DCost 8 o
Marketing Cost 1 O Marketing Cost 6 O
Unit Price 38 @
Cost Of Revenue 14 o
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MAAnalyticChartView

Use the MAAnalyticChartView class to create a single-chart view using metadata definitions. Drilldown,
semantic zooming, and what-if analysis are all available in the single-chart view.

The metadata definition is the same as that used to create dashboard view, but only the first chart in the
metadata is used. Dashboard layout configurations defined in the metadata are not applicable.

<MobileAnalytic >

<Dashboard>
<!-- WhatIf Chart Configuration -->
<Chart Name="WhatIfChart" Title="Net Income From Sales" ChartType="Line" Query="ProductSales">
<Category Format="" Column="Region" Description="Region" />
<Series Format="" Column="Product" Description="Product" />
<Values>
<Value Format="Currency" Expression="((UnitPrice * Quantity) - ((Cost_Of_ Revenue *

Quantity) + (RD _Cost * Quantity) + (Mkt Cost * Quantity) + (Admin Cost * Quantity)))"

ValueSequence="1" Description="Net Income" />
</Values>
<!-- What If Columns -->
<WhatIfColumns>
<Column Name="UnitPrice" Description="Unit Price" VariableType="float" Value="0.0"
Min="1.0" Max="110.0" Step="1.0" Decimals="2" />
<Column Name="Cost_Of_ Revenue" Description="Cost Of Revenue" VariableType="integer"
Value="0" Min="1" Max="40" />
<Column Name="RD Cost" Description="R &amp; D Cost" VariableType="integer" Value="0"
Min="1" Max="18" />
<Column Name="Mkt Cost" Description="Marketing Cost" VariableType="float" Value="0.0"
Min="1.0" Max="10.0" Step="1.0" Decimals="2" />
</WhatIfColumns>
</Chart>

</Dashboard>
</MobileAnalytic>

Sales Year: 2004, Sales Amount in US Dollars:

7 Mountain Bikes: $15,500,026 [l Road Bikes: $14,796,839 @ Touring Bikes: $15,427,533

16M -

12M -

10M -

8M -

2001 2002 2003 2004
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Influence Diagram

An influence diagram is a graphical representation of a decision problem, offering a way to
identify and display essential elements, including decisions, uncertainties, and objectives, and
how they influence each other.

An influence diagram comprises one default node, and multiple primary nodes and secondary or
satellite nodes. Primary nodes directly impact the default node. Each primary node may have
multiple associated secondary or satellite nodes. The default mode and all primary nodes are
always visible in the model.

Each node in the model shows the measure name, and the current actual value or percentage
text.

MAKit influence diagrams include three views: snapshot view, full-screen view in normal mode,
and full-screen view in goal-seek mode. It also supports associated charts for some nodes. In
full-screen view in goal-seek mode, you can show the cause and effect relationships between
nodes as they are defined in the expression attribution of the metadata. You can change the
actual value of a node using the keyboard, or by holding and dragging the handle of a node.

Set the cause and effect relationship between the nodes, and associated charts in metadata.

<?xml version="1.0" encoding="utf-8"?>
<Diagram Name="EVA-Value-Driver" Query="EVAQuery">
<Node Name="EVA" Text="EVA" Format="Rounded2" Expression="OperatingProfitl-CostofCaptial"
Default="true"/>
<Node Name="OperatingProfitl" Text="Operating Profit" ParentNode="EVA"
Expression="RONA*NetAssetsl" Format="Rounded0" Charts="chartl,chart2">
<NodeTo Name="EVA"/>
</Node>
<Node Name="CostofCaptial" Text="Cost of Captial" ParentNode="EVA"
Expression="NetAssetsl*WACC" Format="Rounded2" Charts="chartl">
<NodeTo Name="EVA"/>
</Node>
<Node Name="RONA" Text="RONA" ParentNode="OperatingProfitl"
Expression="ProfitMargin*NetAssetTurnover" Format="Percentage" Charts="chart2">
<NodeTo Name="OperatingProfitl"/>
</Node>
<Node Name="NetAssetsl" Text="Net Assets" ParentNode="OperatingProfitl,CostofCaptial"
Format="Rounded0">
<NodeTo Name="OperatingProfitl"/>
<NodeTo Name="CostofCaptial"/>
</Node>
<Node Name="WACC" Text="WACC" ParentNode="CostofCaptial" Format="Percentage">
<NodeTo Name="CostofCaptial"/>
</Node>
<Node Name="ProfitMargin" Text="Profit Margin" ParentNode="RONA"
Expression="OperatingProfit2/Salesl" Format="Percentage">
<NodeTo Name="RONA"/>
</Node>
<Node Name="NetAssetTurnover" Text="Total Net Asset Turnover" ParentNode="RONA"
Expression="Salesl/NetAssets2" Format="Rounded2">
<NodeTo Name="RONA"/>
</Node>
<Node Name="OperatingProfit2" Text="Operating Profit" ParentNode="ProfitMargin"
Expression="EBIT*IncomeTax" Format="Rounded0">
<NodeTo Name="ProfitMargin"/>
</Node>
<Node Name="Salesl" Text="Sales" ParentNode="ProfitMargin,NetAssetTurnover"
Format="Rounded0">
<NodeTo Name="ProfitMargin"/>
<NodeTo Name="NetAssetTurnover"/>

30|Page





</Node>
<Node Name="NetAssets2" Text="Net Assets" ParentNode="NetAssetTurnover"
Expression="Assets-Liabilities" Format="Rounded0">
<NodeTo Name="NetAssetTurnover"/>
</Node>
<Node Name="EBIT" Text="EBIT" ParentNode="OperatingProfit2" Expression="Contribution-
Overhead" Format="Rounded0O">
<NodeTo Name="OperatingProfit2"/>
</Node>
<Node Name="IncomeTax" Text="(1-Rate of Income Tax)" ParentNode="OperatingProfit2"
Format="Rounded2">
<NodeTo Name="OperatingProfit2"/>
</Node>
<Node Name="Assets" Text="Assets" ParentNode="NetAssets2"
Expression="FixedAssets+CurrentAssets" Format="Rounded0">
<NodeTo Name="NetAssets2"/>
</Node>
<Node Name="Liabilities" Text="Interest Free Liabilities" ParentNode="NetAssets2"
Format="Rounded0">
<NodeTo Name="NetAssets2"/>
</Node>
<Node Name="Contribution" Text="Contribution" ParentNode="EBIT" Expression="Sales2-
GoodsSold" Format="Rounded0">
<NodeTo Name="EBIT"/>
</Node>
<Node Name="Overhead" Text="Overhead" ParentNode="EBIT" Format="Rounded0">
<NodeTo Name="EBIT"/>
</Node>
<Node Name="FixedAssets" Text="Fixed Assets" ParentNode="Assets" Format="Rounded0">
<NodeTo Name="Assets"/>
</Node>
<Node Name="CurrentAssets" Text="Current Assets" ParentNode="Assets" Format="Rounded0">
<NodeTo Name="Assets"/>
</Node>
<Node Name="Sales2" Text="Sales" ParentNode="Contribution" Format="RoundedO">
<NodeTo Name="Contribution"/>
</Node>
<Node Name="GoodsSold" Text="Variable Cost of Goods Sold" ParentNode="Contribution"
Format="Rounded0">
<NodeTo Name="Contribution"/>
</Node>
</Diagram>
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Snapshot view:
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Full-screen view in goal-seek mode:

@ Operafing Profi;’
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Predictive Analysis and Threshold Reference

Predictive analysis shows forecasted or projected data points using a dashed-line pattern.

Threshold values highlight values that fall outside of a specified range; for example, you can

assign a reference value, which appears on the y-axis, to highlight some benchmark value.

Predictive analysis and threshold references are supported only in line charts. Configure the

required parameters for predictive analysis and threshold reference with the corresponding

values.
Configure these variables for threshold reference and predictive analysis:

e referenceValue
e upperThreshold
e |owerThreshold

e predictiveStartCategory

// This is for Predictive Analysis and Threshold Reference

else if ([queryName isEqualToString:@"SalesOrder Pred"]) {
SgliteDataSource *sl = [[SgliteDataSource alloc] init];
table.chartData = [sl SalesOrderSummary];

table.referenceValue
table.upperThreshold
table.lowerThreshold

[ [ [NSNumber alloc]initWithDouble:100000]autorelease];
[ [ [NSNumber alloc]initWithDouble:150000]autorelease];
[[ [NSNumber alloc]initWithDouble:50000]autorelease];

table.predictiveStartCategory = @"Eastern";

[sl release];

}

// This is for Predictive Analysis

else if ([queryName isEqualToString:Q@"NumberOfOrders_Pred"]) ({
SgliteDataSource *sl = [[SgliteDataSource alloc] init];
table.chartData = [sl NumberOfOrdersByYear];
[sl release];

table.referenceValue
table.upperThreshold
table.lowerThreshold

[ [ [NSNumber alloc]initWithDouble:80]autorelease];
[ [ [NSNumber alloc]initWithDouble:120]autorelease];
[ [ [NSNumber alloc]initWithDouble:40]autorelease];
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This example shows a line chart with a threshold reference. Threshold references highlight the
benchmark values and the values that comprise the upper and lower thresholds. Benchmark
values use a dotted blue horizontal line, whereas the upper and lower threshold values are
shaded with reference to the y-axis.

Year: 2003, Number Of Orders :

7 Canada: 8 | @ Central: 29 | @ Eastern: 29 [ South: 12 | I} Western: 5

Number Of Orders

03 2004 2005 2006
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In this example, a line chart that shows predictive analysis and a threshold reference, the
predictive line begins at the “Eastern” category, which is also shown in the example metadata:

Region: Canada, Sales Amount :

© Baseball Cap: $13,369 | @ Shorts: $15,267 | [ Sweatshirt: $52,727 | [l Tee Shirt: $39,175 1 Visor: $8,73

200K -

$150,000
150K -

$100,000

Amount

100K -

a

&
“®
\
\
\
\
\
\
\
\
\
\
\
J \
| \
O Y
i \
50K - \
$50,000 ™
\
\
(j S \
\\ \
So \
~ "
S~ =S
» ~ ~ - -
o -
~ ‘\‘
~ k2
-
=9
0 -
Canada Central Eastern South Westerr

Region

36 |Page





MAKIit 2.2 New Features

This section demonstrates the chart types supported by MAKit 2.2. The new chart types are grouped
together to create a sample dashboard. See the Dashboard NewChartTypes.xml metadata file to
learn how to configure different chart types.

New chart types supported in MAKit2.2 include:

e  Scatter chart
e Overlay chart
e Treemap chart

e  Horizontal bullet chart

37|Page





This dashboard layout configuration renders a chart similar to:

No SIM = 11:53 AM

MAKit Code Examples New Chart Types Dashboard

BMI Vs Age =

Age Levels: 36, BMI Values:

© FEMALE Maximum: 26.80 @ FEMALE Minumum: 16.80 @ MALE Maximum: 27.60 @ MALE Minum

30 - A A A A ‘ &
- 3 ® = ° 3 N ° - ° ° p 4 P
25 = & L 4 7
20 - =] =] -]
. o & 8 A n M & o o o
15 - =]
1
36 37 38 39 4 41 12 43 44 45 1€ 47 48 1 5
Employee Salary by Dept and Job Type «” Yearly Report "
Department ID: 100, Total Salary : -
- . 2002
Total Salary: 1292198.19 | @ Contract: 464124
1.5M -
1M -
2004
500K -
100 20( 30( 40 Quarterly Monthly
Sales Performance e
Region Actual g 100 200 300 400 500 600 700 800
| | | | | | ‘ |
0006 Hx
Africa — -
a00.00 [ :
22000 p—— |
Asia —_ .
i
320.00 — |
100.00 : l]
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Examples of New Chart Configuration

<Chart Name="ScatterChart" Title="BMI Vs Age" ChartType="Scatter" Query="bmi">
<Category Format="Rounded0" Column="age" DisplayName="Age Levels" />
<Series Format="" Column="sex" DisplayName="Sex" />
<Values>
<Value Format="Rounded2" Expression="bmi" ValueSequence="1"
DisplayName="BMI Values" />
</Values>
</Chart>

<Chart Name ="BulletChart" Title="Sales Performance" ChartType="HorizontalBullet"
Query="performance">

<Category Format="" Column="region" DisplayName="Region"/>
<Series Format="" Column="sex" DisplayName="Male/Female" />
<Values>
<Value Expression = "actual" ValueSequence = "1" DisplayName="Actual"/>
<Value Expression = "bad" ValueSequence = "2" DisplayName="Bad"/>
<Value Expression = "satisfactory" ValueSequence = "3"
DisplayName="Satisfactory"/>
<Value Expression = "target" ValueSequence = "4" DisplayName="Target"/>
</Values>
</Chart>

<TreeMapGroup Name="TreemapChart" Title="Detailed Sales Report">
<TreeMapLevel Name="By Year" Title="Yearly Report" ChartType="TreeMap"
ChartSequence="1" Query="ResellerForYear">
<Category Format="" Column="SalesYear" DisplayName="Company" />
<Values>
<Value Format="Rounded2" Expression="SalesAmount" ValueSequence="1"
DisplayName="Sales Amount" />
<Value Format="Rounded2" Expression="MfgCost" ValueSequence="2"
DisplayName="Manufacturing Cost" />
</Values>
</TreeMapLevel>

<TreeMapLevel Name="By Quarter" Title="Quarter" ChartType="TreeMap"
ChartSequence="2" Query="ResellerForQtr">
<Category Format="" Column="Quarter" DisplayName="Quarter" />
<Values>
<Value Format="Rounded2" Expression="SalesAmount" ValueSequence="1"
DisplayName="Sales Amount" />
<Value Format="Rounded2" Expression="MfgCost" ValueSequence="2"
DisplayName="Manufacturing Cost" />
</Values>
</TreeMapLevel>

<TreeMapLevel Name="By Month" Title="Month" ChartType="TreeMap"
ChartSequence="3" Query="ResellerForMonth">
<Category Format="" Column="Month" DisplayName="Month" />
<Values>
<Value Format="Rounded2" Expression="SalesAmount" ValueSequence="1"
DisplayName="Sales Amount" />
<Value Format="Rounded2" Expression="MfgCost" ValueSequence="2"
DisplayName="Manufacturing Cost" />
</Values>
</TreeMapLevel>
</TreeMapGroup>

<OverlayGroup Name="OverlayChart" Title="Employee Salary Comparision">
<Category Format="Rounded0" Column="dept id" DisplayName="Department ID" />
<Layer Name="Employee Salary" Title="Employee Salary by Dept and Job Type"
ChartType="Column" ChartSequence="1" Query="EmpSalaryRpt">

<Values>
<Value Format="Rounded2" Expression="salary" ValueSequence="1"
DisplayName="Total Salary" />
</Values>
</Layer>
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<Layer Name="ResellerByYear" Title="Revenue by Year" ChartType="Line
ChartSequence="2" Query="EmpSalary Jobtype">

<Series Format="" Column="status" DisplayName="Job Type" />

<Values>

<Value Format="Rounded2" Expression="salary" ValueSequence="1"

DisplayName="Salary (Job Type)" />

</Values>

</Layer>
</OverlayGroup>

The metadata file also configures the dashboard layouts for either portrait or landscape mode.

<DashboardLayout>
<Landscape>
<Layout Name="ScatterChart" Top="1" Left="1" Width="98" Height="32" />
<Layout Name="OverlayChart" Top="34" Left="1" Width="48" Height="32" />
<Layout Name="TreemapChart" Top="34" Left="50" Width="49" Height="32" />
<Layout Name="BulletChart" Top="67" Left="1" Width="98" Height="35" />
</Landscape>

<Portrait>
<Layout Name="ScatterChart" Top="1" Left="1" Width="98" Height="32" />
<Layout Name="OverlayChart" Top="34" Left="1" Width="48" Height="32" />
<Layout Name="TreemapChart" Top="34" Left="50" Width="49" Height="32" />
<Layout Name="BulletChart" Top="67" Left="1" Width="98" Height="35" />
</Portrait>
</DashboardLayout>

Time-Series Drawing

Use the reloadData method to create an animated time series chart. When reloadData is called,
the chart queries its datasource for a fresh set of data. This code snippet illustrates how
reloadData has been invoked within a timer thread to simulate a time series from 1990 to 2012:

- (IBAction)play: (id) sender
{
if (self.timer)
{
[self.timer invalidate];
self.timer = nil;
self.year = 1990;
}

self.chart.showsSelectedDatalabel = NO;
self.timer = [NSTimer scheduledTimerWithTimeInterval:0.3
target:self
selector:@selector (reloadDataInBackground)
userInfo:nil
repeats:YES];
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(void) reloadDataInBackground
{
NSAutoreleasePool* pool =
@synchronized (self)
{

self.year++;
[self.chart reloadData:NO];

if (self.year >= 2012)

{

[self.timer invalidate];
self.chart.showsSelectedDatalabel = YES;

}

[pool release];

[ [NSAutoreleasePool alloc]

init];

This chart shows a time series drawing of bubble chart:

41 |Page





iPad & 11:37 AM

Bubble Chart Bubble Chart Time Series, low level API

Bubble chart for Year 1990

\ 2000 ‘
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MAK:Iit 2.3 New Features

This section demonstrates the new chart types supported by MAKit 2.3 SAP Mobile Platform. The chart
types are grouped together to create a sample dashboard. See Dashboard NewChartTypes30.xml
to learn how to configure different chart types.

New chart types supported in MAKit include:

e Areachart

e  Vertical bullet chart

Examples of New Chart Configuration

<Chart Name="ColumnChart" Title="Region/Product Sales" ChartType="Area"
Query="SalesOrder">

<Category Format="" Column="Region" DisplayName="Region" />
<Series Format="" Column="Product" DisplayName="Region" />
<Values>

<Value Format="Currency" Expression="SalesAmount" ValueSequence="1"
DisplayName="Sales Amount" CurrencyCode="EUR"/>

</Values>

</Chart>

<Chart Name ="BulletChart" Title="Sales Performance" ChartType="VerticalBullet"
Query="performance">

<Category Format="" Column="region" DisplayName="Region"/>

<Series Format="" Column="sex" DisplayName="Male/Female" />

<Values>

<Value Expression = "actual" ValueSequence = "1" Format="Currency" CurrencyCode
="USD" DisplayName="Actual"/>

<Value Expression = "bad" ValueSequence = "2" DisplayName="Bad" Format="Currency"
CurrencyCode ="USD" />

<Value Expression = "satisfactory" ValueSequence = "3" DisplayName="Satisfactory"
Format="Currency" CurrencyCode ="USD" />

<Value Expression = "target" ValueSequence = "4" DisplayName="Target"
Format="Currency" CurrencyCode ="USD" />

</Values>

</Chart

Examples of Dashboard Layout

<DashboardLayout>
<Landscape>

<Layout Name="BulletChart" Top="1" Left="1" Width="98" Height="48" />
<Layout Name="ColumnChart" Top="50" Left="1" Width="98" Height="48" />

</Landscape>

<Portrait>

<Layout Name="BulletChart" Top="1" Left="1" Width="98" Height="48" />
<Layout Name="ColumnChart" Top="50" Left="1" Width="98" Height="48" />
</Portrait>

</DashboardLayout>

43 |Page





This dashboard layout configuration renders a chart similar to:

iPad 5:18 PM
MAKit Code Examples New Chart Types Dashboard
Sales Performance "
1 Region: Africa, Actual : ‘
| = Female: USS300 | @ Male: USS400 f§
800 - T
600 -
—3
Australia Europe Middle East North America
Region/Product Sales e

‘ Region: Canada, Sales Amount :

© Baseball Cap: €13,369 [ Shorts: €15,267 [ Sweatshirt: €5 @ Tee Shirt: €39,175 | Visor:
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150K
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Introduction

The MAKit Developer Guide: iOS is to help developers quickly understand Mobile Analytics Kit (MAKit)
concepts, and expedite application development. MAKit, which lets users graphically view data and
modify chart values to examine “what-if” scenarios, is distributed as a static library on the iPhone/iPad.
MAKit can be used with the SAP® Mobile Platform Hybrid Web Container.

Other visualization packages typically require you to upload your data to a server. MAKit is datasource-
independent, providing easy-to-use APls that allow application developers to retrieve data from Web
services, SAP Mobile Platform, CSV files, or local SQLite® databases.

A large component of MAKit is its charting abilities. Currently available chart types include column,
stacked column, bar, line, area, pie, table, bubble, scatter, and bullet, as shown below. You can also
form overlay charts by combining some chart types, such as line and column.

Year: 2000, Amount :
7 Asia: $3,768 China: $3,435 | [ Europe: $2,;
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YearI Asia I China I Europe USA

‘ 1998 $1,461 $2,294 $1,253 $318

1999 $2,135 $3,258 $6,379 $1,467

$1,924 $2,274 $1,189 $2,538

2001 $1,013 $4,320 $6,587 $5,565
2002 $107 $669 4,193 51,418
2003 $1,834 $1,631 $1,489 $179
2004 $a42 $3,299 $1,620 $744
2005 $901 $3,186 53,014 54,383

GDP: $14,720,000,000,000
Year: 2009, Revenue value:

2 United States: Population: 311705000 0il Co

© Asia: $12,034 @ China: $2,130
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Another major component of MAKit is the influence diagram.

Region: Europe, Amount :

© 2005:51,798 @ 2006:$691 | B 2007:$3,126 | | 2008: $386 | [

6K -

4K -

Asia China Europe SA

Architecture

This figure shows the MAKit modules. The ul/Presentation module includes the Ul with its views and
controller, and is typically used by most applications. The Analytics module processes on-device
analytics, while the Query Interface module provides a standard way to feed data into MAKit.
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Device Application

MAKit

Ul / Presentation

High-Level
APIs

Analytics

Low-Level
APIs

Query Interface

High-level APIs offer rich features and ease of use, whereas low-level APIs offer more flexibility and
customization options.

See Appendix: APl Reference on page 98.

MAK:It iOS Charting API

When using MAKit for the first time, decide which APl to use, based on function and flexibility
requirements. Charting APls are categorized into two levels:

APl Level Scope Coding Flexibility

High Packaged components (for example, MAvView and Less Low
MAAnalyticChartView)

Low Core components (for example, MAChartView and More High
MADashboardView)

High-level APIs provide predefined functionality that you can customize using metadata. They are
suitable for tabular data that must be represented visually in different formats on the mobile device.
The high-level APIs are also suitable for data retrieved by query mechanisms, such as database servers.

Minimal coding is required for applications using high-level APIs, as complex functionality, including the
following, is already built in:
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Semantic zooming (hierarchical categories)
Drilldown

Filters

Dynamic analytics

What-if analysis

Low-level APIs are basic, independent, and comprehensive, offering highly customizable application
building blocks. The flexibility of low-level APIs comes at a development cost, as more coding is required.
If you do not require complex analytics and navigation, SAP recommends that you use high-level APIs to
save development effort.

High-Level APIs—Packaged Components

High-

level APIs comprise these components:
Metadata file
Datasource — MAQueryDelegate and MAQueryDataTable
View — MAView or MAAnalyticChartView
Delegate — MAviewDelegate Or MAAnalyticChartViewDelegate

Theme — MAChartTheme and MADashboardTheme

MAViewDelegate J MADashboardTheme J

| r U

Metadata File 5/

MAQuervDelegate 5/ MAView

MAQuervDataTable J‘/

A

MAAnalvticChartViewDelegate J MAChartThem J

r U

Vetadata File | mm—)

MAQuervDelegate 5/ MAAnalyticChartView

b

MAQuervDataTable ‘/
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MAView and MAAnalyticChartView are view components, whereas the datasource is made up of the
metadata file, MAQueryDelegate, and MAQueryDataTable. The application can be notified of events via
MAViewDelegate and MAAnalyticChartViewDelegate. Customize colors and fonts using MADashboardTheme
and MAChartTheme.

Query Generation Tool

MAKit includes a Java tool, MAGen, that parses the metadata file and generates the code skeleton of
classes that adopt the MAQueryDelegate and MAQueryDataTable protocols.

To use MAGen:
e Install the latest JRE, if necessary.
e AddMAGen. jar to the class path.

e From a command line, run:

java com.sybase.mobileanalytic.MAGen metadata_path output_path [query_name] [datatable_name]

Argument Description

metadata_path Full path of the metadata file
output_path Output directory
qguery_name (optional) Name of the generated class that adopts the MAQueryDelegate

protocol. The default is MyQuery.

datatable_name (optional) Name of the generated class that adopts the MAQueryDataTable
protocol. The default is MyDataTable. You must specify query name
before you can specify datatable_name.

Here are some examples:

java com.sybase.mobileanalytic.MAGen d:\MAKit\comb.xml d:\MAKit\out\
java com.sybase.mobileanalytic.MAGen d:\MAKit\comb.xml d:\MAKit\out\ MAQuery
java com.sybase.mobileanalytic.MAGen d:\MAKit\comb.xml d:\MAKit\out\ MAQuery MADataTable

Chart View

MAAnalyticChartView is a UIView subclass representing a single chart in MAKit.
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Year Quarter Month

Year: 2002, Quarter: Q3, Month: 8, Sales Amount:

Actual Sales: 14662419.00 |l Mfg Cost: 6397834.00

/\/

a B

MAAnalyticChartView comprises the chart and other Ul components, such as the range selector and
hierarchy buttons.

For added convenience, a corresponding UIViewController—MAAnalyticChartViewController—is also
available.

See “Creating a Simple Chart Using the High-Level APIs” on page 22.

Dashboard View

MAView is a UIView subclass representing the dashboard component in MAKit.
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The dashboard comprises charts, dynamic analytic panels, and toolbars. The bottom toolbar provides
additional functionality, such as refresh and e-mail sharing. The top toolbar displays filtering options.
The layout of charts and panels in the dashboard is defined in the metadata.

For added convenience, a corresponding UIViewController—MAViewController—is also available.

See “Creating a Dashboard Using the High-Level APIs” on page 28.
Low-Level APIs—Core Components

Chart View

MAChartView is a UIView subclass that represents a chart.

MAChartView requires a datasource that adopts the MAChartVviewDataSource protocol, and provides the
information required to draw the chart. The MAChartview can optionally include a delegate that adopts
the MAChartviewDelegate protocol. The delegate receives events, and can be notified of gestures. You
can further customize the look and feel of MAChartview by specifying an object that adopts the
MAChartTheme delegate, to change colors and fonts.

MGk rviewDataSource T ),
MAChartViewDelegate sy . MAChartView

MAChartTheme ‘ \

See “Creating a Simple Chart Using the Low-Level API” on page 33.
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Dashboard View

MADashboardView is a UIview subclass that represents a dashboard.

MADashboardView is similar to MAChartView in that it also requires a datasource and can optionally have a
delegate. The datasource that adopts MADashboardviewDataSource provides the information required to
draw the dashboard. The delegate that adopts the MADashboardviewDelegate protocol receives events
and can be notified of gestures. You can also customize the appearance of the dashboard by specifying

an object that adopts the MADashboardTheme.

MADashboardViewDataSource 5/

MADashboardViewDelegate 5/ MADashboardVie

W

N

MADashboardTheme ‘/

MAK:Iit iOS Influence Diagram API

Influence Diagram APIs—Packaged Components

Influence diagram APIs comprise:

Metadata File/ Spec Objs J

Metadata file/influence diagram specification objects
Datasource — MAQueryDelegate and MAQueryDataTable
View — MAInfluenceDiagramView

Delegate —MAInfluenceDiagramDelegate

Theme — MADiagramTheme

MAlInfluenceDiagramDelegate

MADiagramTheme J

LA

ll

MAInfluenceDiagramView
VAQueryDelegate | Sm—)

N

U

J

VAQuenyDatarable | S—
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MAInfluenceDiagramView is a view component, whereas the datasource is made up of the metadata
file/specification objects, MAQueryDelegate, and MAQueryDataTable. The MAInfluenceDiagramDelegate
notifies applications of events. You can use MADiagramTheme to customize colors, images, and fonts.

See “Creating an Influence Diagram Using High-Level APIs” on page 68.

Using MAKit in an Xcode Project

This section provides detailed steps for importing MAKit libraries into your Xcode project.

Creating an iOS Project in Xcode 4
e Choose File > New > New Project.
e Select the Single View Application project template for your iOS application, and click Next.
e Enter the product name and other project details, and click Next.

e Specify the project’s location in your file system, and click Create.

Adding MAKit to the Project

The MAKIit library is delivered with a bundle file and two folders—includes and 1libs. Copy the
MAKit deliverables folder to your file system. Assuming that the MAKit folder in your file system is
/Users/<username>/MAKit, modify your project’s build settings:

e Inthe navigator area of the Xcode workspace window, click your project file.
e Choose Build Settings and scroll down to Search Paths.
e To Header Search Paths, add /Users/<username>/MAKit/includes.

e To Library Search Paths, add /Users/<username>/MAKit/libs/$ (BUILD STYLE) -
S (PLATFORM_NAME) .

Add these files to your project:
e MessageUl.framework
e QuartzCore.framework
e MAKit.a
e MAKit.bundle
e libsglite3.0.dylib (if you are usinga SQLite database)

Using MAKit Classes

In the files that use MAKit, import Makit.h, the header file that includes all public headers for the
MAKit library.

Next, create charts and diagrams using these instructions:

e “Creating a Simple Chart Using the High-Level APIs” on page 22
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e “Creating a Dashboard Using the High-Level APIs” on page 28
e “Creating a Simple Chart Using the Low-Level APIs” on page 33
e “Creating a Dashboard Using the Low-Level APIs” on page 38

e  “Creating an Influence Diagram Using High-Level APIs” on page 68

Creating a Simple Chart Using the High-Level APIs

This task constructs a simple chart of sales revenue per year for three types of bikes.

Sales Year: 2004, Sales Amount in US Dollars:

& Mountain Bikes: $15,500,026 [ Road Bikes: $14,796,839 | @ Touring Bikes: $15,427,533

Step 1: Metadata
e Add anew XML file into the project.

e Construct the metadata file using the code snippet below.

<MobileAnalytic><Dashboard>
<Chart Name="Sales" Title="Bike Sales Summary" ChartType="Line" Query="SalesSummary">
<Category Format="Rounded®" Column="Year" DisplayName="Sales Year" />
<Series Column="Product" DisplayName="Sales Year" />
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="Sales Amount in US
Dollars" />
</Values>
</Chart></Dashboard>
</MobileAnalytic>

Most metadata examples used in this document are shown in XML format; however, MAKit metadata
can also be in plist format, or coded by NSDictionary. See “Metadata Formats Other Than XML” on page
80. For example, using the above snippet, a developer can add a plist file called BikeSales.plist
into the project, as shown in the figure below. This example can use either BikeSales.plist or
BikeSales.xml as the metadata file. See “Step 4: MAAnalyticChartView” on page 25.
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Key
MetaName
0
MetaName
0
MetaName
MNarme
Title
ChartType
Query
0
MetaMame
Format
Column
DisplayName

MetaName
Column
DisplayName

MetaMame

0
MetaMame
Format
Expression
ValueSequence
DisplayName

Metadata attributes such as Title, Format, and DisplayName affect the labels shown on the chart. Use
different sets of metadata to localize MAKit. The chart is plotted by value (Sales Amount) against
Category (Year). Multiple sets of data are represented using Series (Product). Metadata attributes such
as Query and Column obtain the datasource of the chart. These attributes are closely linked with the

implementation of the query protocols.

See “Expressions” and “Metadata File” on pages 73 and 80 respectively for details about metadata

construction.

Step 2: MAQueryDataTable

Type
String

Ciction...

String

Diction...

String
String
String
String
String

Diction...

String
String
String
String

Ciction...

String
String
String

Diction...

String

Ciction...

String
String
String
String
String

Value
MobileAnalytic
(2 items)
Dashboard

(8 items)
Chart

Sales

Bike Sales Summary
Line
SalesSummary
(4 items)
Category
Rounded
Year

Sales Year

(3 items)
Series

Product

Sales Year

(2 items)
Values

(5 items)
Value
Currency
S5alesAmount
1

Sales Amount in US Dollars

e Add a new Objective-C class, ChartDataTable, into the project.

e Ensure that ChartDataTable adopts the MAQueryDataTable protocol, as illustrated below in

the .h and .mfiles, respectively.

@interface ChartDataTable : NSObject<MAQueryDataTable> {

}

@property(nonatomic,retain) NSArray *tableRows;
@end
@implementation ChartDataTable

- (id)getData: (NSString*)colName atIndex:(int)rowIndex {
if ([colName isEqualToString:@"Year"] || ([colName isEqualToString:@"Product"] || ([colName

isEqualToString:@"SalesAmount"])
{

23





MAKit Developer Guide: i0S 2013

NSDictionary* row = (NSDictionary*)[self.tableRows objectAtIndex:rowIndex];
return [row objectForKey:colName];

¥

retun nil;
}
@end
An object that adopts the MAQueryDatatable protocol represents the tabular datasource of the chart.
Each row of the tabular datasource represents a data item in the chart. In this example, there are 4
categories and 3 series—a total of 12 data rows. The columns are defined in the metadata as Year,
Product, and SalesAmount.

A simple snapshot of the tabular data for the chart is as shown below.

Row Year Product SalesAmount
1 2000 Mountain Bikes $10,029,815
2 2000 Road Bikes $12,174,936
3 2000 Touring Bikes $10,447,665
4 2001 Mountain Bikes $10,893,468

In the row retrieval code snippet for chartDataTable shown above, the array tableRows stores all the rows
of this tabular data. Each row is further represented as a dictionary for fast retrieval of the values by
column name.

Step 3: MAQueryDelegate
e Add a new Objective-C class, ChartQuery into the project .

e Ensure that chartQuery adopts the MAQueryDelegate protocol, as illustrated below in the . h
and .m files, respectively.

@interface ChartQuery: NSObject<MAQueryDelegate> {
b

@implementation ChartQuery

- (id<MAQueryDataTable>)executeQuery: (NSString*)queryName withArgument:(NSDictionary*)args

{
ChartDataTable *table = [[[ChartDataTable alloc] init] autorelease];

if ([queryName isEqualToString:@"SalesSummary"])
{
NSMutableArray *tableRows = [[NSMutableArray alloc] init];
const char *SELECT = "SELECT Year, ProductSubCategory,sum(SalesAmount) "
" FROM CompanySales
" WHERE ProductCategory='Bikes"' "
" GROUP BY Year,ProductSubCategory "
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" ORDER BY Year,ProductSubCategory";

sqlite3_stmt *selectStmt = nil;
sqlite3_prepare_v2(dbConn, SELECT, -1, &selectStmt, NULL);
while (sqlite3_step(selectStmt)==SQLITE_ROW)

{
int year = sqlite3_column_int(selectStmt, 0);
NSString *product = [NSString stringWithUTF8String:(char *) sqlite3_column_text(selectStmt, 1)];
double amount = sqlite3_column_double(selectStmt, 2);
NSMutableDictionary *row = [[NSMutableDictionary alloc] init];
[row setObject:[NSNumber numberWithInt:year] forKey:@"Year"];
[row setObject:product forKey:@"Product"];
[row setObject:[NSNumber numberWithDouble:amount] forKey:@"SalesAmount"];
[tableRows addObject:row];
[row release];
)

sqlite3_reset(selectStmt);
sqlite3_finalize(selectStmt);
table.tableRows = tableRows;
[tableRows release];

¥

return table;

}

@end

An object, chartQuery, which adopts the MAQueryDelegate protocol, corresponds to the metadata
definition. This example illustrates how to use a SQLite database as the query delegate; for readability,

error handling has been omitted from the code snippets.

Query, defined in the metadata, is used as the input parameter of the class that adopts the
MAQueryDelegate protocol. Column and Expression, also defined in the metadata, are used as the input
parameters of the class that adopts the MAQueryDataTable protocol. This is summarized in this table:

Metadata Query
Query="SalesSummary" Protocol MAQueryDelegate
Method executeQuery: withArgument:
Input parameter queryName
Column="Year" Protocol MAQueryDataTable
Column="Product Method getData: atindex:
Expression="SalesAmount"
Input parameter colName

Step 4: MAAnalyticChartView

e Add anew view controller ChartViewController into the project.
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e ImportMAKit.h, the header file that includes all public headers of the MAKit library.
o (Create AnalyticChartView in viewDidLoad.

e Set the theme. Included in the library are two default themes: MAKitTheme_WelterWeight and
MAKitTheme_WelterWeightDark.

e Associate the created datasource MAChartQuery with the view component MAAnalyticChartView.
e Set the chart’s frame and refresh the chart in viewwillAppear.

This code snippet assumes that Automatic Reference Counting (ARC) is not enabled:

#import “MAKit.h”
@interface ChartViewController ()

@property(nonatomic,retain) MAAnalyticChartView* chartView;
@end

@implmentation ChartViewController
@synthesize chartView;

- (void)dealloc
{
self.chartView = nil;
[super dealloc];
}
- (void)viewDidLoad
{
[super viewDidLoad];
MAAnalyticChartView *aChartView = [MAAnalyticChartView alloc] initWithFrame:aFrame];
self.chartView = aChartView;
[aChartView release];
[self.view addSubView:self.chartView];
MAKitTheme_WelterWeight *aTheme = [[MAKitTheme_WelterWeight alloc] init];
self.chartView.theme = aTheme;
[aTheme release];
self.chartView.metaDataPath = [[NSBundle mainBundle] pathForResource:@"BikeSales" ofType:@"xml"];
ChartQuery *dataSource = [[ChartQuery alloc] init];
self.chartView.dataSource = dataSource;
[dataSource release];
}
- (void)viewWillAppear
{
self.chartView.frame = aFrame;
[self.chartView reloadData:YES];
}
@end

Invoke reloadData only after the bounds and frame of the charts have been set, so that all subviews of
the chart can be correctly laid out. You must invoke reloadData at least once after the view is initialized,
and may refresh application data as required.
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The code above assumes you are using an XML metadata file. If you use BikeSales.plist as the
metadata file, you must also change:

self.chartView.metaDataPath = [[NSBundle mainBundle] pathForResource:@"BikeSales" ofType:@"xml"];
to:

self.chartView.metaDict = [NSMutableDictionary dictionaryWithContentsOfFile:
[[NSBundle mainBundle] pathForResource:@"BikeSales" ofType:@"plist"]];

If you use the plist format instead of the XML format, an intermediate NSDictionary is passed to
self.chartview. The intermediate NSDictionary is parsed from BikeSales.plist. This implies that
you can build the NSDictionary as metadata, without adding a metadata file to the project, but the
structure (or schema) of the NSDictionary must be exactly the same as the NSDictionary parsed from the
plist file.

MAAnalyticChartViewController

If a simple UIviewController is required, you may use MAAnalyticChartViewController. The view
controller includes a toolbar, which provides functionalities such as tabular representation, data refresh,
and e-mail sharing in addition to the chart view.

Done Bike Sales Summary

Sales Year: 2004, Sales Amount in US Dollars:

= Mountain Bikes: $15,500,026 [l Road Bikes: $14,796,839 [ Touring Bikes: $15,427,533

aM -

After creating the analytic chart view, use it to initialize the analytic chart view controller:

MAAnalyticChartViewController *viewController = [[MAAnalyticChartViewController alloc]
initWithAnalyticChartView:aChartView] autorelease];
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Creating a Dashboard Using the High-Level APIs

This task constructs a dashboard similar to that shown below. Besides charts, the dashboard may also
include Dynamic Analytic panels.

MAKH CoteExmmpu
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Reglon: Canada, Sales Amount: Depanméet  Salary ! "
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417800.00 -
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Tap the expand button in the upper-right corner of the chart to open it in full-screen mode, which allows
additional operations, such as zooming and drilldown. The top toolbar also lets users show a tabular
representation of the chart, or share the chart via an e-mail message.
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US Crime Data

State: Alabama

Motor_Vehicle_Theilj

1.5K -

500 -

7 Aggravated_Assault [ Burglary Motor_Vehicle_Theft

Do US Crime Data
f O =
State CrimeType Crime Ratio Crime Ratio
Aggravated_Assault 247 .80 247.80
Alabama Burglary 953.80 953.80
Alabama Motor_Vehicle_Theft 288.30 288.30
Alabama Murder 8.20 8.20
Alabama Robbery 141.40 141.40
Alaska Aggravated_Assault 465.10 465.10
Alaska Burglary 622.50 622.50
Alaska Motor_Vehicle_Theft 391.00 391.00
Alaska Murder 2.20 2.20
Alaska Robbery 80.90 80.90
Arizona Aggravated_Assault 327.40 327.40
Arizona Burglary 948.40 948.40
Arizona Motor_Vehicle_Theft 924.40 924.40
Arizona Murder 7.50 7.50

Step 1: Metadata
e Add anew XML file into the project.

e Construct the metadata file using the code snippet below.
<MobileAnalytic>

<Dashboard>
<Chart Name="ColumnChart" Title="Region/Product Sales" ChartType="Column" Query="SalesOrder">
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<Category Column="Region" DisplayName="Region" />
<Series Column="Product" DisplayName="Region" />
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="Sales Amount" />
</Values>
</Chart>

<Chart Name="BarChart" Title="Salary By Dept/Gender" ChartType="Bar" Query="DeptSalary">
<Category Column="Department" DisplayName="Department" />
<Series Column="Sex" DisplayName="Gender" />
<Values>
<Value Format="Rounded2" Expression="Salary" ValueSequence="1" DisplayName="Salary" />
</Values>

</Chart>

<Chart Name="LineChart" Title="Number Of Sales Orders" ChartType="Line" Query="NumberOfOrders">
<Category Column="Year" DisplayName="Year" />
<Series Column="Region" DisplayName="Region" />
<Values>
<Value Format="Rounded®" Expression="OrderCount" ValueSequence="1" DisplayName="Number Of Orders"
/>
</Values>
</Chart>

<Chart Name="PieChart" Title="Printer Sales" ChartType="Pie" Query="PrinterSales">
<Category Column="SalesRep" DisplayName="Sales Rep" />
<Series Column="Product" DisplayName="Type" />
<Values>
<Value Format="Currency" Expression="Sales" ValueSequence="1" DisplayName="Sales Amount " />
</Values>
</Chart>

<Chart Name="BubbleChart" Title="US Crime Data" ChartType="Bubble" Query="CrimeData">
<Category Column="State" DisplayName="State" />
<Series Column="CrimeType" DisplayName="CrimeType" />
<Values>
<Value Format="Rounded2" Expression="Ratio" ValueSequence="1" DisplayName="Crime Ratio" />
<Value Format="Rounded2" Expression="Ratio" ValueSequence="2" DisplayName="Crime Ratio" />
</Values>
</Chart>

</Dashboard>
<DashboardLayout>
<Landscape>
<Layout Name="ColumnChart" Top="1" Left="1" Width="49" Height="32" />
<Layout Name="BarChart" Top="1" Left="51" Width="48" Height="32" />
<Layout Name="LineChart" Top="34" Left="1" Width="49" Height="32" />
<Layout Name="PieChart" Top="34" Left="51" Width="48" Height="32" />
<Layout Name="BubbleChart" Top="67" Left="1" Width="98" Height="32" />
</Landscape>
<Portrait>
<Layout Name="ColumnChart" Top="1" Left="1" Width="49" Height="32" />
<Layout Name="BarChart" Top="1" Left="51" Width="48" Height="32" />
<Layout Name="LineChart" Top="34" Left="1" Width="49" Height="32" />
<Layout Name="PieChart" Top="34" Left="51" Width="48" Height="32" />
<Layout Name="BubbleChart" Top="67" Left="1" Width="98" Height="32" />
</Portrait>
</DashboardLayout>
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</MobileAnalytic>

The metadata also contains the dashboard layout configuration. There are layouts for portrait and
landscape orientations. There are two scales for the dashboard: percentage and points.

Scrollable Dashboard

The default scale of the dashboard layout is percentage, which is not scrollable. If you require a
scrollable dashboard, specify the dashboard scale in points. Also use points to specify the ContentWidth
and ContentHeight in both landscape and portrait modes, and the top, left, width, and height layout
properties.

The values of ContentWidth and ContentHeight determine dashboard scrolling.

For example:

<DashboardLayout Scale = "Points" >
<Landscape ContentWidth = "1300" ContentHeight = "1200">
<Layout Name="ZoomingChart" Top="10" Left="10" Width="1000" Height="300" />
<Layout Name="Drilldown" Top="315" Left="10" Width="1000" Height="700" />
<Layout Name="DA" Top="920" Left="10" Width="1000" Height="200" />
</Landscape>
<Portrait ContentWidth = "800" ContentHeight = "1100">
<Layout Name="ZoomingChart" Top="10" Left="10" Width="750" Height="300"/>
<Layout Name="Drilldown" Top="315" Left="10" Width="750" Height="600" />
<Layout Name="DA" Top="920" Left="10" Width="750" Height="200" />
</Portrait>
</DashboardLayout>

Step 2: Query
e Add a new Objective-C class, DashboardQuery, into the project.

e Ensure that DashboardQuery adopts the MAQueryDelegate protocol:

- (id<MAQueryDataTable>)executeQuery: (NSString*)queryName withArgument:(NSDictionary*)args

{
if ([queryName isEqualToString:@"SalesOrder"]) {

}
else if ([queryName isEqualToString:@"DeptSalary"]) {

}
else if ([queryName isEqualToString:@"NumberOfOrders"]) {

}

else if ([queryName isEqualToString:@"PrinterSales"]) {

}

else if ([queryName isEqualToString:@"CrimeData"]) {
}
}

Each chart in a dashboard retrieves data using one or more queries. Each query has a unique name for
retrieval of the corresponding data set. The class that adopts the MAQueryDelegate protocol must handle
all queries in the dashboard.

Step 3: MAView
e Add a new view controller, DashboardViewController, into the project.

e Import MAKit.h, the header file, which includes all public headers of the MAKit library.
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e (Create MAView in viewDidLoad.
e Assigh a UIViewController to MAView.

e Set the theme. Included in the library are two default themes: MAKitTheme_WelterWeight and
MAKitTheme_WelterWeightDark.

e Associate the created datasource MADashboardQuery with the view component MAView.

e Set the chart’s frame and refresh the view in viewWillAppear.
This code snippet assumes that Automatic Reference Counting (ARC) is not enabled:
#import “MAKit.h”
[maView refresh];
#import “MAKit.h”
@interface DashboardViewController ()
@property(nonatomic,retain) MAView* maView;

@end

@implmentation DashboardViewController
@synthesize maView;

(void)dealloc

self. maView = nil;
[super dealloc];

(void)viewDidLoad
[super viewDidLoad];

MAView *aMaView = [[MAView alloc] initWithFrame:aFrame];
self.maView = aMaView;

[aMaView release];

[self.view addSubView:self.chartView];

self.maView.controller = self;

MAKitTheme_WelterWeight *aTheme = [[MAKitTheme_WelterWeight alloc] init];
self.maView.theme = aTheme;
[aTheme release];

self.maView.metaDataPath = [[NSBundle mainBundle] pathForResource:@"DashboardMetadata" ofType:@"xml"];
DashboardQuery *dataSource = [[DashboardQuery alloc] init];

self.maView.dataSource = dataSource;

[dataSource release];

- (void)viewWillAppear

{

self.maView.frame = aFrame;
[self.maView refresh];
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@end

After you have set the metadata and datasource as MAvView's properties, invoke refresh to load the data.
You must refresh at least once after the view is initialized, and you may refresh the application data
again as required, such as when the data on the back-end server has been updated.

MAViewController

If no special handling is required for the view controller of MAview, directly create the dashboard using
MAViewController

#import “MAKit.h”

MAViewController *maViewController = [[[MAViewController alloc] init] autorelease];
MAKitTheme_WelterWeight *aTheme = [[MAKitTheme_WelterWeight alloc] init];
maView.theme = aTheme;

[aTheme release];

maViewController.metaDataPath = [[NSBundle mainBundle] pathForResource:@"MAMeta" ofType:@"xml"];
DashboardQuery *dataSource = [[DashboardQuery alloc] init];

maViewController.dataSource = dataSource;

[dataSource release];

[maViewController refresh];

Creating a Simple Chart Using the Low-Level APIs

This task creates a simple chart that shows product category against sales revenue. There are four
categories—Accessories, Bikes, Clothing, and Components—and two series, representing two years of
data.

Company Sales Data
0 10M 20M 30M 40M 50M
4290052.5
Accessories

4107610.5

40992312

Bikes

45724396
13584524

7859807.5 :]

13452856 [

™ 2003 W 2004

Step 1: ChartViewController

Create classes that adopt the MAChartViewDataSource and MAChartViewDelegate protocols. Often, the two
protocols are implemented within a subclass of UIviewController.

Clothing

Components

e Add a new view controller, ChartviewController, into the project.

e Ensure that ChartVviewController adopts the MAChartViewDataSource and MAChartViewDelegate
protocols:
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@interface ChartViewController : UIViewController <MAChartViewDataSource, MAChartViewDelegate>
{
}

Step 2: MAChartViewDataSource

Implement the required methods of the MAChartviewDataSource protocol in ChartViewController. The
following code snippets implement the methods in a simplistic way for illustration purposes only: in
general, the data comes from a dynamic back-end server, and is not static. The data returned should
also include localization. The code snippets assume that Automatic Reference Counting (ARC) is not
enabled.

e Construct the data in init:

@interface ChartViewController
@property(nonatomic,retain) NSArray *categoryArray;
@property(nonatomic,retain) NSArray *seriesArray;
@property(nonatomic,retain) NSDictionary *valueDict;
@end

@implementation ChartViewController
@synthesize categoryArray;
@synthesize seriesArray;
@synthesize valueDict;

- (id)init

{

self.categoryArray = [NSArray arrayWithObjects:@"Accessories", @"Bikes", @"Clothing",
@"Components", nil];

self.seriesArray = [NSArray arrayWithObjects:[NSNumber numberWithInt:2003], [NSNumber
numberWithInt:2004], nil];

NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];
self.valueDictionary = dict;
[dict release]

for (NSUInteger categoryIndex=0; categoryIndex<[self.categoryArray count]; categoryIndex++)
{
for (NSUInteger seriesIndex =0; seriesIndex <[self. seriesArray count]; seriesIndex ++)
{
NSUInteger indexes[] = {categoryIndex, seriesIndex};
NSIndex* indexPath = [NSIndexPath indexPathWithIndexes:indexes length:2];
double value = arc4random % 10000;
[self.valueDictionary setObject:[NSNumber numberWithDouble:value] forKey:indexPath];

}

e Give the chart a title, for example, “Company Sales Data”:

- (NSString*)titleForChartView: (MAChartView *)chartView
{
return @"Company Sales Data";

}

e Return the chart type as a bar chart, to correspond to the screenshot above:
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- (NSUInteger)chartView:(MAChartView *)chartView chartTypeForChartLayer:(NSUInteger)layerIndex

{

return MAChartTypeBar;

¥

e Return the categories stored in the category array:

- (NSUInteger)chartView: (MAChartView *)chartView
numberOfCategoriesInLevel: (NSUInteger)categorylLevelIndex {
return [self.categoryArray count];

- (id)chartView: (MAChartView *)chartView categoryAtIndex:(NSUInteger)categoryIndex
inCategoryLevel: (NSUInteger)categorylLevelIndex

{
return [self.categoryArray objectAtIndex:categoryIndex]

}

For numeric data, return an object of either NSString or NSNumber. The datatype affects the
sorting, which in turn affects the order in which data appears in the chart.

The input parameter categoryLevelIndex is used in complex charts, such as semantic zooming
charts, in which categories are hierarchical.

See “Semantic Zooming” on page 44.

e Return the series stored in the series array:

- (NSUInteger)numberOfSeriesInChartView: (MAChartView *)chartView

{

return [self.seriesArray count];

- (id)chartView: (MAChartView *)chartView seriesAtIndex:(NSUInteger)seriesIndex

{

return [self. seriesArray objectAtIndex: seriesIndex]

}

e Return the values stored in the value array:

- (id)chartView: (MAChartView *)chartView valueAtDimension:(NSUInteger)valueDimensionIndex
forCategory: (NSUInteger)categoryIndex inCategorylLevel:(NSUInteger)categorylLevelIndex
andSeries: (NSUInteger)seriesIndex

{
NSUInteger indexes[] = {categoryIndex, seriesIndex};
NSIndex* indexPath = [NSIndexPath indexPathWithIndexes:indexes length:2];
return [self.valueDictionary objectForKey:indexPath];

}

The value represents the sales revenue. The input parameter valueDimensionIndex applies to
charts that have multiple value dimensions, such as bubble charts.
Step 3: MAChartViewDelegate

All methods in MAChartviewDelegate are optional, and you can use them to be notified of chart
operations such as category selection and double-tapping to perform additional operations.

In this example, the delegate synchronizes selections between the bar chart and the datagrid chart, both
of which represent the same set of data. When the second category, Bike, is selected in the bar chart,
the same category should also be selected in the datagrid chart.
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Company Sales Data
0 10M 20M 30M 40M 50M
| | | | |
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4107610.5
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Clothing
7859807.5
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Accessories = 4290052.5 4107610.5

40992312 45724396

Clothing 13584524  7859807.5

Components 35310012 13452856

This code snippet shows how to implement this example:

- (void)chartView: (MAChartView *)chartView didSelectCategory:(NSUInteger)categoryIndex

{
if (chartView.tag == 1) {
[self.dataGrid selectCategoryAtIndex:categoryIndex];
[self.dataGrid setNeedsDisplay];

}

else {
[self.chart selectCategoryAtIndex:categoryIndex];
[self.chart setNeedsDisplay];

Step 4: MAChartView
e Create the Chart view in the viewDdidLoad method of the subclass of uIviewController.

o Set the theme. Included in the library are two default themes: MAKitTheme_WelterWeigh and
MAKitTheme_WelterWeightDark.

e Associate the class ChartViewController, which adopts the MAChartViewDataSource and
MAChartViewDelegate protocols, with the view component MAChartview.

e Set the chart’s frame and refresh the chart in viewwillAppear.

After the delegate and datasource have been set as MAChartView properties, invoke refresh to load the
data. Refresh at least once after the view is initialized, and again as required.
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- (void)viewDidLoad

{

[super viewDidLoad];

MAChartView *aChart = [[MAChartView alloc] initWithFrame:CGRectZero];

self.chart = aChart;
[aChart release];

MAKitTheme_|

self.chart

[aTheme release];

WelterWeight *aTheme = [[MAKitTheme_WelterWeight alloc] init];
.theme = aTheme;

autoresizingMask = UIViewAutoresizingFlexibleWidth | UIViewAutoresizingFlexibleHeight;

self.chart.tag = 1;
self.chart.identifier =@"chart";
self.chart.contentMode = UIViewContentModeRedraw;
self.chart.
self.chart.dataSource = self;
self.chart.delegate = self;
[self.view addSubview:self.chart];
}
- (void)viewWillAppear: (BOOL)animated
{
self.chart.frame = self.view.bounds;
[self.chart refresh];
}

37





MAKit Developer Guide: iOS 2013

Creating a Dashboard Using the Low-Level APIs

This task creates a simple dashboard for two charts.

Beverage Consumption History in ABC Group

_Jan_

T Pepsi: 5 [ Coca-Cola: 52 | [ Target: 123

| ™ Pepsi: 82 W Coca-Cola:72 W Target: 24

Step 1: CustomDashboardViewController

Create classes that adopt the MADashboardViewDataSource and MADashboardViewDelegate protocols.
These two protocols are often implemented within a subclass of UIviewController.

e Add a new view controller CustomDashboardviewController into the project.
e Ensure that CustomDashboardViewController adopts the MADashboardviewDataSource and
MADashboardViewDelegate protocols:

@interface CustomDashboardViewController : UIViewController <MADashboardViewDataSource,
MADashboardViewDelegate>

{
}

Step 2: MADashboardViewDataSource

Implement the required methods of the MADashboardviewDataSource  protocol in
CustomerDashboardviewController. The following code snippets implement the methods in a simplistic
way for illustration purposes only, and assume that Automatic Reference Counting (ARC) is not enabled.

e Construct the data in init:

@interface CustomDashboardViewController () <MADashboardViewDataSource, MADashboardViewDelegate>
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@property(nonatomic,retain) MADashboardView *dashboardView;
@property(nonatomic,retain) id<MAChartTheme,MADashboardTheme> theme;
@property(nonatomic,retain) NSArray *charts;

@end

@implementation CustomDashboardViewController
@synthesize dashboardView;

@synthesize theme;

@synthesize charts;

- (id)init
{

/* Create theme */

MAKitTheme_WelterWeight *welterWeightTheme = [[MAKitTheme_WelterWeight alloc] init];
self.theme = welterWeightTheme;

[welterWeightTheme release];

/* Create dashboard items */
NSMutableArray *array = [[NSMutableArray alloc] initWithCapacity:2];

MAChartView *chartl = [[MAChartView alloc] initWithFrame:CGRectZero];
.. // Customize chart and set data source and delegate

[chartl refresh];

[array addObject:chartl];

[chartl release];

MAChartView *chart2 = [[MAChartView alloc] initWithFrame:CGRectZero];
.. // Customize chart and set data source and delegate[chart2 refresh];
[array addObject:chart2];

[chart2 release];

self.charts = array;
[array release];

}

e Return charts as dashboard item contents:

- (UIView *)dashboardView: (MADashboardView *)dashboardView contentForItemAtIndexPath:(NSIndexPath
*)indexPath;

{
NSUInteger idx = [indexPath indexAtPosition:@];
return [self.charts objectAtIndex:idx];

}

e Return the dashboard item count:

- (NSInteger)numberOfItemsInDashboardView: (MADashboardView *)dashboardView

{

return [self.charts count];

Step 3: MADashboardViewDelegate

The following code snippets show how to implement the methods of the MADashboardviewDataDelegate
protocol in CustomerDashboardViewController.

e Return the dashboard theme:
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- (id<MADashboardTheme>)themeForDashboardView: (MADashboardView *)dashboardView

{

return self.theme;
)
e Return the frame of each dashboard item:

- (CGRect)dashboardView: (MADashboardView *)dashboardView frameForItemAtIndexPath:(NSIndexPath
*)indexPath withContentSize:(CGSize)contentSize

{

CGFloat padding = 5.0f;

CGFloat width = contentSize.width - padding * 2;

CGFloat height = roundf((contentSize.height - padding * 3)/2);

NSUInteger idx = [indexPath indexAtPosition:@];

return CGRectMake(padding, padding + idx * (height + padding), width, height);
}

Step 4: MADashboardView

e Create the Dashboard view in the viewdidLoad method of the subclass of UIViewController.

e Associate the class CustombDashboardViewController, which adopts the
MADashboardViewDataSource and MADashboardViewDelegate protocols, with the view component

MADashboardView.

e Invoke reloadData of MADashboardview.

- (void)viewDidLoad

{

[super viewDidLoad];

/* Create dashboard */
MADashboardView* dashboard = [[MADashboardView alloc] initWithFrame:self.view.bounds];
dashboard.contentMode = UIViewContentModeRedraw;
dashboard.autoresizingMask = UIViewAutoresizingFlexiblelLeftMargin
| UIViewAutoresizingFlexibleRightMargin
| UIViewAutoresizingFlexibleTopMargin
| UIViewAutoresizingFlexibleBottomMargin
| UIViewAutoresizingFlexibleWidth
| UIViewAutoresizingFlexibleHeight;
dashboard.delegate = self;
dashboard.dataSource = self;
[dashboard reloadData];

[self.view addSubview:dashboard];

self.dashboardView = dashboard;
[dashboard release];
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Complex Charts
Rich Format Table
The rich format table (RFTable) can contain text, chart, and variance columns.
KPIName Past Trend Actual Target Variance Target
Gost $1.456,750 < $2,348,780 . ($892,030)
Cost1 $2,456,750 < $3,348,780 ($892,030)
Cost10 ’\/f/\\] $32,416,750 > $23,488,780
Costi1 /\/\/\/W $324,167.,500 > $234,887,800
Cost12 /\/\/\/\/ $132,416750 < $223,488,780 ($91,072,030)
Cost13 —’\/\/\/‘ $324,161.,750 > $234.882,780
Costi4 N/\/\/\-U $132,416,750 < $523,488,780 ($391,072,030)
Costis r\/_/_/\f $82,416,750 > $53,488,780
Cost16 /\/\/\/P $232416,750 < $523,488,780 ($291,072,030)
Cost17 /\/\/\-b $43,241.650 < $72.348.780 ($29,107,130)
Cost18 /\’\/\/q $62,416,750 > $33,488,780
Cost19 $92,416,750 > $73,488,780
Cost2 $4,456,750 > $4,348,780
Cost20 \j\/\/\/\f $72,416,750 > $43.488,780
Metadata

For variance column types, a color expression is required. For chart column types, the chart definition
must also be present in the metadata.

<DataGrid Name="RFTable" Title="Table Chart" Query="TableQuery">
<Columns>
<Column Type="Data" Value="kpi_name" Header="KPI Name" IsHeaderColumn="1"/>
<Column Type="Chart" Value="char data" ChartName=" " Header="Past Trend" ColumnSequence="1"/>
<Column Type="Data" Value="actual" Format="Currency" Header="Actual" ColumnSequence="2"/>
<Column Type="Data" Value="op" ColumnSequence="3" />
<Column Type="Data" Value="target" Format="Currency" Header="Target" ColumnSequence="4"/>
<Column Type="Variance" Value="actual-target" Color="if(actual > target, 'green', 'red')"
Format="Currency" Header="Variance Target" ColumnSequence="5"/>
</Columns>

<Charts>
<Chart Name=" " Title="Month Trend" ChartType="Line">
<Category Column="Month" DisplayName="Month" />
<Values>
<Value Format="Rounded2" Expression="Amount" ValueSequence="1" DisplayName="Trend Value" />
</Values>
</Chart>
</Charts>
</DataGrid>

Query

To use charts as columns of the RFTable, the class that adopts the MAQueryDataTable protocol must
return chart data as a data table, which also adopts the MAQueryDataTable protocol.
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- (id)getData: (NSString*)colName atIndex:(int)rowIndex

{
if ([colName isEqualToString:@"char_data"])
{
MyQueryDataTable *chartData = [MyQueryDataTable alloc] init] autorelease];
Return chartData;
b
)
Overlay Charts

You can combine different chart types to form an overlay chart. In this example, a column chart is
overlaid with a line chart. You can also enable dual axis in overlay charts by using dualAxisEnabled API.

‘ Year: 1996, Maximum Price:

0 default: $27 | @ default: $22

160 -

1896 1997 1998 1999 2000 2001 2002 2003 2004 2005 2006 2007 2008 2009 2010 2011

Metadata
The metadata for this example includes two query and value expression sections:

<OverlayGroup Name="OverlayChart" Title="Crude O0il Prices">
<Category Column="Year" DisplayName="Year" />
<Layer Name="MaxPriceForYear" Title="Maximum Price for the Year" ChartType="Column" ChartSequence="1"
Query="0ilPrice">
<Values>
<Value Format="Currency" Expression="MaxPrice" ValueSequence="1" DisplayName="Maximum Price" />
</Values>
</Layer>
<Layer Name="AvgPriceForYear" Title="Average Price for the Year" ChartType="Line" ChartSequence="2"
Query="0ilPrice">
<Values>
<Value Format="Currency" Expression="AvgPrice" ValueSequence="1" DisplayName="Average Price" />
</Values>
</Layer>
</OverlayGroup>
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Query

Layers in an overlay chart should share a common category definition, so the data tables returned from
different layer queries share the same category column. In this example, the first-layer query should
return a table with columns that correspond to Year and MaxPrice. The second-layer query should
return a table with columns that correspond to Year and AvgPrice.

Treemap

A treemap chart presents hierarchical data using nested rectangles. Each branch of the hierarchical tree
is represented as a rectangle, which is then tiled with smaller rectangles representing subbranches. In
addition to the area of the rectangle, the color also represents another dimension.

Quarterly Monthl

Metadata

<TreeMapGroup Name="TreemapChart" Title="Treemap Chart">
<TreeMapLevel Name="Yearly" Title="Yearly" ChartType="TreeMap" ChartSequence="1" Query="yearQuery">
<Category Format="" Column="Year" Description="Year" />
<Values>
<Value Format="Rounded®" Expression="Amount" ValueSequence="1" Description="Amount" />
<Value Expression="Amount" ValueSequence="2" Description="Amount" />
</Values>
</TreeMaplLevel>

<TreeMapLevel Name="Quarterly" Title="Quarterly" ChartType="TreeMap" ChartSequence="2"
Query="quarterQuery">
<Category Format="" Column="Quarter" Description="Quarter" />
<Values>
<Value Format="Rounded@" Expression="Amount" ValueSequence="1" Description="Amount" />
<Value Expression="Amount" ValueSequence="2" Description="Amount" />
</Values>
</TreeMapLevel>

<TreeMapLevel Name="Monthly" Title="Monthly" ChartType="TreeMap" ChartSequence="3"

Query="monthQuery">
<Category Format="" Column="Month" Description="Month" />
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<Values>
<Value Format="Rounded@" Expression="Amount" ValueSequence="1" Description="Amount" />
<Value Expression="Amount" ValueSequence="2" Description="Amount" />
</Values>
</TreeMaplLevel>
</TreeMapGroup>

Query

In this example, the treemap has three levels, which correspond to three queries. Levels of a treemap
chart have the same hierarchical relationship, and thus the same query requirements, as a semantic
zooming chart.

See “Semantic Zooming” on page 44.

Each query level includes two value expressions: the first represents the area and the second represents
the color.

Advanced Chart Features

Advanced chart features are available through the use of high-level APIs. See “Creating a Dashboard
Using the High-Level APIs” on page 28 to understand the relationship between metadata and data
retrieval via the query protocols.

Semantic Zooming

Semantic zooming is useful for aggregating data. A commonly used scenario is to aggregate data by year,
quarter, and month. Another scenario is to aggregate data by region, country, state, and city. The chart
below uses three category hierarchies—Year, Quarter, and Month.

Done Sales By Year
#H ¢ ™
Year Quarter Month

Year: 2004, Quarter: Q1, Month: 1, Sales Amount: ‘

T Actual Sales: 7094108.50 | @ Mfg Cost: 2870886.75
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Metadata

<Chart Name="ZoomingChart" Title="Sales By Year" ChartType="Line" >

<Category DisplayName="Sales ByYear-Quarter-Month" />

<Series Column="AmountType" DisplayName="Sales Region" />

<Values>
<Value Format="Rounded2" Expression="Amount" ValueSequence="1" DisplayName="Sales Amount" />

</Values>

<ZoomingLevels>
<ZoominglLevel Query="ResellerYear" CategoryColumn="Year" Title="Year" />
<ZoominglLevel Query="ResellerQtr" CategoryColumn="Quarter" Title="Quarter" />
<ZoominglLevel Query="ResellerRegion" CategoryColumn="Month" Title="Month" />

</ZoominglLevels></Chart>

Query

The zooming levels have a hierarchical relationship: items in the second level are subordinate to items in
the first level (for example, quarters of a calendar or fiscal year). The data table returned by querying
the two zooming levels must reflect this relationship. In this example, the first-level query should return
a table with two columns—“Year” and “Amount.” The second-level query should return a table with
three columns—“Year,” “Quarter,” and “Amount.”

Drilldown

Drilldown is useful for data filtering, whereby different details of chart data are shown at different chart
levels. For each drilldown level, you can use a different chart type to present the data. The filter action is
triggered by a double tap. You can also combine the drilldown feature with semantic zooming charts.

This chart defines three drilldown levels. The top level displays the sales revenue grouped by regions.

Done Reseller Sales Summary

Sales Region  Sales Amount in US Dollars 10M 20M 30M 40M 50M 60M
| \ \ | |

$5,531,144 -]

$10,977,163
Europe

$10,855,859

$26,589,696

$56,469,132 :
North America |

$22.662,153

$48,392,837

$15,881,877 : |
Pacific |

$8,044,825

$12,948,150

o Accessories [l Bikes W Clothing W Components

45





MAKit Developer Guide: iOS 2013

Double-tapping a country drills down to the second level, in which sales revenue is grouped by the
countries of the selected region.

Reseller Sales Summary Reseller Sales By Country

Europe H ¢ =
Country Sales Amount in US Dollars 0 oM aM M 8M 10M i2M 14M
$2,113,396 | I
$4,593,259

France
$4,365,383

$12,078,586

$1,543,655

$1,990,490

Germany

$4,636,825

$1,874,093

$4,393,414

United Kingdom
$4,049,685

$9,874,286

7 Accessories [ Bikes [ Clothing @ Components

Double-tapping a region drills down to the third level, in which sales revenue is grouped by product
categories for the selected country and region.

Product Sub Category ~ Sales Amount in US Dollars 500K m 1.5M M 2.6M M 3.6M M 4.5M
Bib-Shorts $366,665 ‘ I | | ‘ ‘ I ‘ I
Bike Racks $942,771

Bottles and Cages $28,779

Bottom Brackets $63,251

Brakes $105.760

Caps $61,440

Chains $17,085

Cleaners $46,032

Cranksets $341.898

Derailleurs $119,374

Forks $64,902

Gloves $462,917

Handlebars $134,808

Headsets $39,979
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Metadata

Drilldown charts comprise multiple elementary charts, each with its own query.
<DrillDownGroup Name="Reseller" Title="Reseller Drilldown Charts">
<Chart Name="ResellerSales" Title="Reseller Sales Summary "
Query="ResellerSummary" >
<Category Column="Region" DisplayName="Sales Region" />
<Series Column="ProductCategory" DisplayName="ProductCategory" />
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="Sales Amount in
US Dollars" />
</Values>
</Chart>

ChartType="Bar" ChartSequence="1"

<Chart Name="SalesByCountry" Title="Reseller Sales By Country" ChartType="Bar" ChartSequence="2"
Query="ResellerByCountry" >
<Category Column="Country" DisplayName="Country" />
<Series Column="ProductCategory" DisplayName="Product Category" />
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="Sales Amount in
US Dollars" />
</Values>
</Chart>
<Chart Name="SalesByCategory" Title="Sales By Product Category
Query="ResellerByCategory">
<Category Column="ProductSubCategory" DisplayName="Product Sub Category" />
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="Sales Amount in
US Dollars" /> </Values>
</Chart>
</DrillDownGroup>

ChartType="Bar" ChartSequence="3"

Query

Queries in a drilldown chart may have parameters. The query for the top-level chart, ResellerSummary,
requires no arguments.

The query for the second-level chart, ResellerByCountry, requires two arguments that correspond to the
category and series definitions in the top-level chart. This is because the top-level chart allows drilling
down by either category or series. The user can double-tap a region to drill down by category, or can
drill down by both category and series, by first selecting a product in the legend bar at the bottom of the
chart, then double-tapping a region.

The last-level query also inherits the query arguments of the second-level query as the context of a
drilldown level is the data scope of its parent level. Thus, the third-level query, ResellerByCategory,
requires three arguments—region, product, and country.

Use MAGen to automatically generate a skeleton of the query datasource that includes all the proper
arguments for each query.

- (id<MAQueryDataTable>)executeQuery: (NSString*)queryName withArgument:(NSDictionary*)args

{

if ([queryName isEqualToString:@"ResellerSummary™])

{
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}
else if ([queryName isEqualToString:@"ResellerByCountry"])
{
NSString *region = [args objectForKey@"Region"];
NSString *product = [args objectForKey@"ProductCategory"];
}
else if ([queryName isEqualToString:@"ResellerByCategory"])
{
NSString *region = [args objectForKey@"Region"];
NSString *product = [args objectForKey@"ProductCategory"];
NSString *product = [args objectForKey@"Country"];
}

Dynamic Analytics

Dynamic analytics (DA) allows the user to dynamically change the value of a global variable and see that
change reflected instantly in the chart. You can use dynamic analytic controls in both the dashboard
view and the single chart view. Dynamic analytics is applicable to all charts, except semantic zooming
charts.

Dynamic Analytic Panel

Region/Product Sales Number Of Sales Orders

Region: Canada, Sales Amount: Year: 2003, Number Of Orders:

© Baseball Cap: $13,369 | [ Shorts: $15,26| o Canada: 8 B Central: 29 | [ Easter)|

Sales Dynamic Analytic Panel

Sales Promotion 7 OFF
Sales Promotion in Western G

Department Salary Salary Dynamci Analytic Panel
Department  Salary 0 400K 800K 1.2M Pay Raise Departr sales @

\ |
335679.00
Pay Raise % 00 @

Marketing

362571.75

400871.50
R&D

RQ139R AQ
¢ =
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Done Region/Product Sales

Region: Canada, Sales Amount:

* Baseball Cap: $17,380 | [ Shorts: $19,847 | [l Sweatshirt: $68,545 [ Tee Shirt: $50,928 Visor: $11,357

300K -

150K - 1

50K -

Canada Central Eastern South Western

Metadata

In dynamic analytics, the chart value is computed from an expression that includes one or more dynamic
analytic variables.

See “Expressions” and “Metadata File” on pages 73 and 80 respectively for details about constructing
dynamic analytic variables.

In the dashboard view, you can group related dynamic analytic variables in the same Dynamic Analytic
panel.

<Dashboard>

<Variables>
<Variable Name="$¢salesdrive" DisplayName="Sales Promotion ?" VariableType="boolean" Value="0" />
<Variable Name="$region" DisplayName="Sales Promotion in " VariableType="enum" Selection="0">
<Choices>
<Choice Display="Eastern" Value="Eastern" />
<Choice Display="Western" Value="Western" />
<Choice Display="Central" Value="Central" />
<Choice Display="South" Value="South" />
<Choice Display="Canada" Value="Canada" />
</Choices>
</Variable>
</Variables>

<Chart Name="ProductSales" Title="Region/Product Sales" ChartType="Column" Query="SalesOrder">
<Category Column="Region" DisplayName="Region" />
<Series Column="Product" DisplayName="Product" />
<Values>
<Value Format="Currency" Expression="if($salesdrive==1,SalesAmount+(SalesAmount *
0.30),if(Region==%region, SalesAmount+(SalesAmount * ©.80),SalesAmount))" ValueSequence="1"
DisplayName="Sales Amount" />
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</Values>
</Chart>
<DAPanel Name="SalesDA" Title="Sales Dynamic Analytic Panel">
<VariableName Name="$salesdrive" Sequence="1" />
<VariableName Name="$region" Sequence="2" />
</DAPanel>
</Dashboard>

Query

Dynamic analytics is automatically performed by the system; no special handling is required for the
Query datasource. The class that adopts the MAQueryDataTable protocol is unaware of the dynamic
analytic variables Ssalesdrive and Sregion; it returns only data that corresponds to the SalesAmount
column.

- (id)getData: (NSString*)colName atIndex:(int)rowIndex

{
if ([colName isEqualToString:@"SalesAmount™])

{

-

What-If Analysis

What-if analysis allows the user to dynamically change input data and see those changes instantly
updated in the chart. What-if analysis is applicable to all charts, except semantic zooming charts.

Done Net Income From Sales

Region: Canada, Net Income:

© Baseball Cap-Cotton Cap: $3,699 | [l Tee Shirt-Crew Neck: $11,655 | @ Tee Shirt-Tank Top: $3,523

50K -

40K -

30K -

20K -

10K -

Canada Central Eastern So Wastern
Unit Price 38 @ Unit Price 66 @
Cost Of Revenue 14 e > (Cost Of Revenue 24 eo——
R & D Cost 4 e > R&D Cost 8 o
Marketing Cost 3 @ Marketing Cost 5 @
Metadata

In what-if analysis, the chart value is computed from an expression, which is made up of one or more
what-if column names.
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<Chart Name="WhatIfChart" Title="Net Income From Sales" ChartType="Line" Query="ProductSales">
<Category Column="Region" DisplayName="Region" />
<Series Column="Product" DisplayName="Product" />

<Values>
<Value Format="Currency" Expression="(( * Quantity) - (( * Quantity) +
(RD_Cost * Quantity) + ( * Quantity) + (Admin_Cost * Quantity)))" ValueSequence="1"
DisplayName="Net Income" />
</Values>
<WhatIfColumns>
<Column Name=" " DisplayName="Unit Price" VariableType="float" Value="0.0" Min="1.0"
Max="110.0" Step="1.0" Decimals="2" />
<Column Name=" " DisplayName="Cost Of Revenue" VariableType="integer" Value="0" Min="1"
Max="40" />
<Column Name="RD_Cost" DisplayName="R &amp; D Cost" VariableType="integer" Value="@" Min="1" Max="18"
/>
<Column Name=" " DisplayName="Marketing Cost" VariableType="float" Value="0.0" Min="1.0"
Max="10.0" Step="1.0" Decimals="2" />
</WhatIfColumns>
</Chart>
Query

What-if analysis is performed by the system; no special handling is required for the Query datasource.
The class that adopts the MAQueryDataTable protocol need not be concerned about the Value expression
parsing, and returns data based only on the six column names defined, of which four can be adjusted for
what-if analysis.

- (id)getData: (NSString*)colName atIndex:(int)rowIndex

{
if ([colName isEqualToString:@" "T) {

}
else if ([colName isEqualToString:@" ") {

}
else if ([colName isEqualToString:@"RD_Cost"]) {

¥
else if ([colName isEqualToString:@" "1 {

}

else if ([colName isEqualToString:@"Admin_Cost"]) {

}
else if ([colName isEqualToString:@"Quantity"]) {

}

Filter

Use query arguments to filter chart data. Filters are global in nature and affect all charts associated with
that filter. Filters allow users to focus only on the data of interest; data that does not fulfill the specified
criteria is not included in chart results. Two types of filters are available. A range filter allows the
specification of an integer range. A pick list filter allows selection of discrete sets of data criteria.

In the following example, the charts can be filtered by region. The first dashboard shows the charts with
data of three regions.
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Products | Region: 3 | Sales Reason

Reseller Sales By Product 5

Product Category: Accessories, Sales Amount in Local Currency:

* Europe: $5,531,144 | [ North America: $18,552,273 | @ Pacific: $12,641,135

Online Sales Drive 3

Sales Reason: Manufacturer, Sales Amount in Local Currency:

T Europe: $1,207,251 | [ North America: $2,767,663 |l Pacific: $2,023,208

Manufacturer Other Quality Television Advertiserr

¢ ™

The second dashboard shows the results after filtering, which now includes data from only two regions,
North America and Pacific.

Products | Region: 2 | Sales Reason

Reseller Sales By Product "

‘ Product Category: Accessories, Sales Amount in Local Currency:

North America: $18,552,273 B Pacific: $12,641,135

Bikes Clothing Components

Online Sales Drive 5

Sales Reason: Manufacturer, Sales Amount in Local Currency:

North America: $2,767,663 B Pacific: $2,023,208

8M

ig_ﬂﬂﬁl

Manufacturer Other Quality Television Advertiserr

¢ ™

Metadata

A sample metadata with filter is shown below. The SourceQuery for the filter must be defined as a Query
by at least one Chart node in the dashboard. Filters can be shared by multiple charts, and as such, the
SourceQuery need not be the same as that of the Query of the chart that uses it.

<Dashboard>
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<Filters>
<Filter Name=" " Sequence="1" SourceQuery="ResellerQry" FilterType="picklist"
Column="ProductCategory" />
<Filter Name=" " Sequence="2" SourceQuery="ResellerQry" FilterType="picklist"
Column="Region" />
</Filters>

<Chart Name="ResellerSales" Title="Reseller Sales By Product"” ChartType="Line" Query="ResellerQry">
<Category Column="ProductCategory" DisplayName="Product Category" />
<Series Column="Region" DisplayName="Sales Region"/>
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="Sales Amount in
Local Currency" />
</Values>
<Filters>
<FilterName Name=" />
<FilterName Name=" />
</Filters>
</Chart>
</Dashboard>

Query

After the filters are applied in the dashboard, they are passed to MAQueryDelegate as query parameters.
The query parameters are specified in a dictionary, where the key is the name of the Filter element
defined in the metadata, and the values are an array of the selected range/data. The code below shows
the handling of the filter as query parameters.

The class that adopts the MAQueryDelegate protocol can use the argument dictionary to obtain the filter
query parameters.

- (1d<MAQueryDataTable>)executeQuery: (NSString*)queryName withArgument:(NSDictionary*)args
{

NSArray *products = [args objectForKey:@" "1;

NSArray *regions = [args objectForKey:@" "1;

}

The class that adopts the MAQueryDataTable protocol need not be concerned about the filter parameters,
and returns only data based on columns defined in the metadata.

- (id)getData: (NSString*)colName atIndex:(int)rowIndex

{
if ([colName isEqualToString:@"ProductCategory"]) {

¥
else if ([colName isEqualToString:@"Region"]) {

}
else if ([colName isEqualToString:@"SalesAmount"]) {

}
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Predictive Modeling
Predictive modeling, which is available only for line charts, shows forecasted or projected data points
using a dashed-line pattern.

The MAQueryTable protocol includes a property called predictiveStartCategory. Set the predictive
starting category value to this property. For example, create a class, MyQueryTable, which conforms to
the MAQueryTable protocol. Synthesize the property in the class:

@synthesize predictiveStartCategory;
In the query class, set the property to the predictive starting category value:
myTable.predictiveStartCategory = [NSNumber numberWithInt:2000];

myTable is an instance of the MyQueryTable class. 2000 is the predictive starting category. The chart
shows the data points from 2000 in a dashed pattern:

8 ¢ =

Year: 1988, Resell value :

T s$79

Reference Value and Threshold Values

You can assign a reference value to highlight some benchmark value. The reference value appears on
the chart on the y-axis.

Threshold values highlight values that fall outside of a specified range.
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The MAQueryTable protocol includes referencevValue, upperThreshold, and lowerThreshold properties.
Using the same example of the MyQueryTable class, which conforms to the MAQueryTable protocol,
synthesize the properties in the class:

@synthesize referenceValue;

@synthesize upperThreshold;
@synthesize lowerThreshold;

In the query class, set the properties to desired values:

myTable.referenceValue = [[[NSNumber alloc]initWithDouble:350]autorelease];
myTable.upperThreshold [[[NSNumber alloc]initWithDouble:450]autorelease];
myTable.lowerThreshold [[[NSNumber alloc]initWithDouble:120]autorelease];

myTable is an instance of the MyQueryTable class.

The default color for a reference line is violet, and for threshold regions, gray; however, you can
customize these colors using MAChartTheme class properties: referenceValueColor, upperThresholdColor,
and lowerThresholdColor.

Year: 1988, Resell value :

= 172.00

Multiselection

The multiselection feature is triggered by a long press (or “touch and hold”) gesture. After an initial long
press, the user can drag to select a rectangular region. When finished selecting, clicking the action
button performs the custom action for the selection. Another click cancels the selection.
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Year Quarter Month
Month I North | South
o | <
g 12 518 $38
5 |- 1 $36 $26
S
«
2 520 56
3 $24 544
GJ 4 540 $22
5 $50 530

" $20 542

12 $34 $22

To receive and process a multiselection event notification, implement the following methods, either in
MAChartViewDelegate or MAAnalyticChartViewDelegate:

MAChartViewDelegate MAAnalyticChartViewDelegate

(BOOL)willSelectltems:(MAChartView *)chartView (BOOL)willSelectltems:(MAAnalyticChartView
*)chartView;

(void)chartView:(MAChartView *)chartView (void)chartView:(MAAnalyticChartView *)chartView

didSelectltems:(MAChartSelection*)selection didSelectltems:(MAChartSelection*)selection;

This code snippet shows how the methods are implemented in a class that adopts the
MAAnalyticChartView delegate:

- (BOOL)willSelectItems:(MAAnalyticChartView *)chartView
{

return YES;

}

- (void)chartView: (MAAnalyticChartView *)view didSelectItems:(MAChartSelection*)selection
{
if (view == self.chartView)
{
NSMutableString *msg = [[NSMutableString alloc] init];
[msg appendFormat:@"%d categories - Indexes: ", [selection.selectedCategoryIndexes count]];
for (NSNumber *n in selection.selectedCategoryIndexes)
{
[msg appendFormat:@"%d ", [n unsignedIntValue]];
¥
[msg appendFormat:@"\n %d items - Indexes: ", [selection.selectedDataItemIndexes count]];
for (NSNumber *n in selection.selectedDataIltemIndexes)
{
[msg appendFormat:@"%d ", [n unsignedIntValue]];

}
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UIAlertView *alert = [[UIAlertView alloc] initWithTitle:@"Selected Items" message:msg
delegate:nil cancelButtonTitle:@"OK"
otherButtonTitles: nil];
[alert show];
[alert release];
[msg release];

}
For this code snippet, the custom action is to display an alert showing the indexes of the selection:

3 categories - Ind
6 items - Indexes
41

(61

With the category and data item indexes, you can get other extra information about the selection using
the following APIs, available in MAChartVview and MAAnalyticChartview, which both adopt the MADataModel
protocol:

e (id)categoryAtindex:(NSUInteger)categorylndex;

e (id)valueAtDimension:(NSUInteger)valueDimensionindex
ofDataltem:(NSUInteger)dataltemIndex;

For column charts, the entire column must be within the selection rectangle to be considered. In the
example below, only a single category (the middle one) is selected.
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Zooming Chart - Reveune

Month: 1, Quarter: 1, Year: 2000, Revenue :

O North: $10 O South: $20

50 -

[ =

2000 2001

Selected ltems

1 categories - Indexes: 2
2 items - Indexes: 4 5

The user can filter the series before performing the selection. The chart below shows the results of a
user selecting a single category, and a single data item in that category that belongs to the South region.

58





MAKit Developer Guide: i0S

2013

Zooming Chart - Reveune

Month: 2, Quarter: 1, Year: 2000, Revenue : ‘

3 North: $18 & South: $38
50 -
‘ B

40 -

30 -

2000

2001

Selected ltems

1 categories - Index
1 item:
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Chart Display Customization

Using the theme class that adopts the protocol MAChartTheme, device users can customize aspects of
their chart display, such as colors and fonts. Using APIs and subclassing, users can further customize the
look and feel.

Chart Layout

You can configure components of a chart shown to be shown or hidden. This functionality applies to
both MAChartview and MAAnalyticChartView.

| 1 Revenue by Region ‘
2 =

Year: 2005, Amount :

" Asia: 51,522 | @ China: $2,300 | [ Europe: $1,312 | [l USA: 54,909

BK |-

T
3 O ,
g / .
< 3
4K |- § \
-
Kl @ /
B
I § A
/ .
0
‘ 61980 1982 1984 1986 1988 1990 1992 1994 1996 1998 2000 2002 2004 2006 2008 2c-wd
i [5 Year ]
Py oam
iy e ~ sl _— =
. = = J
1980 2010

8 aDP

© Turkey [ Indonesia [ Canada [ Spain [ South Korea [ Mexico [ Italy [ France = United Kingdom [l Brazil = Russia B G

Component Chart Type Property Default
1 Title All isTitleHidden Shown
2 Selected data label All except bar chart showsSelectedDatalabel Shown
3  Horizontal axis title Cartesian chart types, showsHorizontalAxisTitle Hidden

such as line, column,
and bubble
4 Horizontal axis Cartesian chart types, showsHorizontalAxis Shown
such as line, column,
and bubble
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5 Vertical axis title Cartesian chart types, showsVerticalAxisTitle Hidden
such as line, column,
and bubble

6 Vertical axis Cartesian chart types, showsVerticalAxis Shown
such as line, column,
and bubble

7 Content range selector Line charts, column contentRangeSelectorBehaviour Auto
charts, and bar charts

8 Legend Bar charts, pie charts, isLegendHidden Shown
and bubble charts

Custom Drawing

You can perform custom drawing by creating a custom theme class that adopts the MAchartTheme
protocol. Alternatively, you can override minor details by inheriting from the theme classes
MAKitTheme_WelterWeight and MAKitTheme_WelterWeightDark.

The following example shows how to draw triangular shapes using the column chart:
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Region: Europe, Amount :

© 2005:%$1,798 | @ 2006: $691 | @8 2007:%$3,126 | 2008: 5386

10K -

8K -

6K -

K -

2K -

-

0 — =

Asia China

Europe USA

Region: Europe, Amount :

7 2005:$3,331 | I 2006: $2,374 | | 2007: $2,144 | 2008: $3,956

10K -
8K -
6K -
0
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\
| | '
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wsi |N : ; ;
' 1 T ‘%D
0 v ;
Asia China Europe USA

First, create a subclass of MAshape that enables you to perform custom contextual drawing. Override the
method drawInContext and make use of the properties of the input parameter, adopting the
MAShapeModel protocol to control the location and dimensions of the custom shape according to the
values of the chart’s datasource.

@interface TriangleShape : NSObject<MAShape>

@implementation TriangleShape

- (void)drawInContext:(CGContextRef)context model:(MAShapeModel*)cbModel
{
CGContextSaveGState(context);
CGContextMoveToPoint(context, cbModel.bounds.origin.x, cbModel.bounds.origin.y);
CGContextAddLineToPoint(context, roundf(cbModel.bounds.origin.x + cbModel.bounds.size.width/2),
cbModel.bounds.origin.y + cbModel.bounds.size.height);
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CGContextAddLineToPoint(context, roundf(cbModel.bounds.origin.x + cbModel.bounds.size.width),
cbModel.bounds.origin.y);

CGContextSetFillColorWithColor(context, [cbModel.fillColor CGColor]);
CGContextFillPath(context);
CGContextRestoreGState(context);

@end

Create a subclass of MAKitTheme_WelterWeight and override the getChartSeriesPainterByChartType
method. Assign the custom shape to the original series painter of the column chart.

@interface CustomTheme : MAKitTheme_WelterWeight

- (id<MAChartSeriesPainter>)getChartSeriesPainterByChartType: (NSUInteger)chartType

{
id<MAChartSeriesPainter> seriesPainter = [super getChartSeriesPainterByChartType:chartType];
if (chartType == MAChartTypeColumn)

{
TriangleShape *shape = [[TriangleShape alloc] init];
seriesPainter.shape = shape;
[shape release];

}

return seriesPainter;

Time Series Drawing

Use the reloadbata method to create an animated time-series chart. When reloadbata is called, the
chart queries its datasource for a fresh set of data. This code snippet illustrates how reloadData is
invoked within a timer thread to simulate a time series from 1990 to 2012:

- (IBAction)play:(id)sender

{
if (self.timer)
{
[self.timer invalidate];
self.timer = nil;
self.year = 1990;
}
self.chart.showsSelectedDatalLabel = NO;
self.timer = [NSTimer scheduledTimerWithTimeInterval:0.3
target:self
selector:@selector(reloadDataInBackground)
userInfo:nil
repeats:YES];
b

- (void)reloadDataInBackground

{
NSAutoreleasePool* pool = [[NSAutoreleasePool alloc] init];
@synchronized(self)

{

self.year++;
[self.chart reloadData:NO];

if (self.year >= 2012)
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[self.timer invalidate];
self.chart.showsSelectedDatalabel = YES;

}

[pool release];

Generic Ul Functionalities

MAKit also includes some generic Ul functionalities that can be used for all views, instead of being
limited to charts. These extend the Ul and views available in UIKit, and can be used in an application to
enhance user interaction.

MAMailSharingController

MAMailSharingController adds annotation capabilities to the mail-sharing functionality. The API allows
any UIview to be sent as an image via an e-mail message. Before sharing, the user can add annotations
such as text, lines, and circles to highlight certain aspects of the image.

Cancel Share by Email Send

F!&!L ,

Pepsr 65 lCoca Cola: 157 W T¢ BT

Highest Sales

Al

s QLRI

Q
SN

This code snippet shows how to use MAMailSharingController:

-(IBAction)onEmailChart: (id)sender

{

if ([MFMailComposeViewController canSendMail])

{
MAMailSharingController *sharingCtrl = [[MAMailSharingController alloc] init];
sharingCtrl.subject = self.chartView.title;
[sharingCtrl pushSharingControllerWithViewController:self andDelegate:self forView:self.chartView];
[sharingCtrl release];

}
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else
{
// If email hasn't been configured, display a message (localization recommended)
UIAlertView *alert = [[UIAlertView alloc] initWithTitle:@"Mail not configured" message:@"Please
add a mail account in Settings"
delegate:nil cancelButtonTitle:@"OK"
otherButtonTitles: nil];
[alert show];
[alert release];

Runtime Error Handling

MAKit includes a runtime error-handling mechanism that enables an application to implement custom
runtime error handlers. To address runtime errors from MAKit, the application must implement an error
handler that conforms to the MAErrorHandlingDelegate protocol, and pass the error handler object to
MAKit.

MAKit classes, including MAViewController and MAView, expose an errorHandler property. The application
must pass its own error handler to the errorHandler property of either of these classes.

MAErrorHandlingDelegate protocol is defined as:

@protocol MAErrorHandlingDelegate <NSObject>

/**
@brief The MAKit Error Handler delegate. MAKit will call the delegate when runtime error is
detected.

@param error the error object that contains error information
*/

-(void)handleError: (MAError*)error;

@end

This protocol defines one method—handleError, in which the application implements the custom error
handler. When a runtime error occurs in MAKit, handleError is called and an error object (MAError) is
passed as the argument:

@interface MAError : NSObject {

/*! The error code
*/
@property MAErrorCode errorCode;

/*! The error level
*/

@property MAErrorLevel errorlLevel;

/*! Detailed error information. Details can be accessed with predefined keys
*/

@property(nonatomic, retain) NSDictionary *errorDetails;

/*! Create an MAError object
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*/

+(MAError*)errroWithCode: (uint)code andLevel: (uint)level andDetails:(NSDictionary*)details;

@end

MAError contains:

e errorCode — the predefined error number.

e errorLevel —Error or Warning.

e errorDetails — a dictionary containing details about this error. Different errors contain different

details.

Error Code Description

MAError_MetadataPathNotSpecified

Metadata file path is not specified

MAError_MetadataFileNotFound

Metadata data file is not found with the given path

MAError_MetadatalnvalidXMLFormat

Metadata is not in a valid XML format

MAError_MetaDataMissingNode

Required metadata node does not exist

MAError_MetaDataMissingAttr

Required metadata node attribute does not exist

MAError_MetadataAttrWrongValue

Metadata node attribute value is invalid

MAError_MetadataOutOfSequence

Metadata nodes are out of sequence

MAError_MetadataUnrecognizeditem

Metadata node is unrecognized

MAError_MetadataObjUndefined

One metadata node refers to an undefined node

MAError_DataMissingColumn

Required column is missing in the input data table

MAError_DataTableEmpty

Input data table is empty

MAError_LowMemory

Low memory warning

MAError_ExpressionEvalation

Expression evaluation failed

MAError_Other

Other unknown errors

When the application’s error handler receives any of these errors, it can refer to the errorDetails
property of the error object for more details. For example, MAError_MetadatalnvalidXMLFormat
details include the line number and column number where the error occurred (the detail keys are

MAErrorKey_MetadataLlineNumber and MAErrorKey MetadataColumnNumber).

The details for

MAError_MetadataAttrWrongValue include the metadata node name, attribute type, and attribute
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value (the detail keys are MAErrorKey MetadataNodeName, MAErrorKey_MetadataAttrName, and
MAErrorKey_MetadataAttrValue).

Error Detail Key Description
MAErrorKey_MetadataFileName The metadata file name
MAErrorKey_MetadatalLineNumber The line number of the error in the metadata XML
MAErrorKey_MetadataColumnNumber The column number of the error in the metadata XML
MAErrorKey_MetadataNodeName The node name in the metadata that triggers the error
MAErrorKey_MetadataAttrName The attribute name in the metadata that triggers the error
MAErrorKey_MetadataAttrValue The attribute value in the metadata that triggers the error
MAErrorKey_MetadataSequence The sequence number of metadata node
MAErrorKey_DataColumnName The name of the column in the input data table
MAErrorKey_DataRowNumber The row number in the input data table
MAErrorKey_DataQueryName The query name
MAErrorKey_Expression The expression
MAErrorKey_ChartName The chart name
MAErrorKey_ChartName Other general information
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Creating an Influence Diagram Using High-Level APIs

This task constructs an influence diagram similar to:

Step 1: Metadata
e Add anew XML file into the project.

e Construct the metadata file using:

<?xml version="1.0" encoding="utf-8"?>
<Diagram Name="EVA-Value-Driver" Query="EVAQuery">
<Node Name="EVA" Text="EVA" Expression="OperatingProfitl-CostofCaptial” Default="true"
Charts="chartl,chart2" Format="Rounded2"/>
<Node Name="OperatingProfitl" Text="Operating Profit" ParentNode="EVA" Expression="RONA*NetAssetsl"
Charts="chart3,chart4" Format="Rounded2">
<NodeTo Name="EVA"/>
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</Node>
<Node Name="CostofCaptial" Text="Cost of Captial" ParentNode="EVA" Expression="NetAssetsl*WACC"
Format="Rounded2">
<NodeTo Name="EVA"/>
</Node>
<Node Name="RONA" Text="RONA" ParentNode="OperatingProfitl" Expression="ProfitMargin*NetAssetTurnover"
Format="Percentage">
<NodeTo Name="OperatingProfitl"/>
</Node>
<Node Name="NetAssetsl" Text="Net Assets" ParentNode="OperatingProfitl,CostofCaptial”
Format="Rounded2">
<NodeTo Name="OperatingProfitl"/>
<NodeTo Name="CostofCaptial"/>
</Node>
<Node Name="WACC" Text="WACC" ParentNode="CostofCaptial" Format="Percentage">
<NodeTo Name="CostofCaptial"/>
</Node>
<Node Name="ProfitMargin" Text="Profit Margin" ParentNode="RONA" Expression="OperatingProfit2/Sales1"
Format="Percentage" Charts="chartl,chart2">
<NodeTo Name="RONA"/>
</Node>
<Node Name="NetAssetTurnover" Text="Total Net Asset Turnover" ParentNode="RONA"
Expression="Salesl/NetAssets2" Charts="chartl,chart2" Format="Rounded2">
<NodeTo Name="RONA"/>
</Node>
<Node Name="OperatingProfit2" Text="Operating Profit" ParentNode="ProfitMargin" Expression="EBIT*(1-
IncomeTax)" Format="Rounded2">
<NodeTo Name="ProfitMargin"/>
</Node>
<Node Name="Salesl" Text="Sales" ParentNode="ProfitMargin,NetAssetTurnover" Format="Rounded2">
<NodeTo Name="ProfitMargin"/>
<NodeTo Name="NetAssetTurnover"/>
</Node>
<Node Name="NetAssets2" Text="Net Assets" ParentNode="NetAssetTurnover" Expression="Assets-
Liabilities" Format="Rounded2">
<NodeTo Name="NetAssetTurnover"/>
</Node>
<Node Name="EBIT" Text="EBIT" ParentNode="OperatingProfit2" Expression="Contribution-Overhead"
Format="Rounded2">
<NodeTo Name="OperatingProfit2"/>
</Node>
<Node Name="IncomeTax" Text="(1-Rate of Income Tax)" ParentNode="OperatingProfit2" Format="Rounded2">
<NodeTo Name="OperatingProfit2"/>
</Node>
<Node Name="Assets" Text="Assets" ParentNode="NetAssets2" Expression="FixedAssets+CurrentAssets"
Format="Rounded2">
<NodeTo Name="NetAssets2"/>
</Node>
<Node Name="Liabilities" Text="Interest Free Liabilities" ParentNode="NetAssets2" Format="Rounded2">
<NodeTo Name="NetAssets2"/>
</Node>
<Node Name="Contribution" Text="Contribution" ParentNode="EBIT" Expression="Sales2-GoodsSold"
Format="Rounded2">
<NodeTo Name="EBIT"/>
</Node>
<Node Name="Overhead" Text="Overhead" ParentNode="EBIT">
<NodeTo Name="EBIT"/>
</Node>
<Node Name="FixedAssets" Text="Fixed Assets" ParentNode="Assets" Format="Rounded2">
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<NodeTo Name="Assets"/>

</Node>

<Node Name="CurrentAssets" Text="Current Assets" ParentNode="Assets" Format="Rounded2">
<NodeTo Name="Assets"/>

</Node>

<Node Name="Sales2" Text="Sales" ParentNode="Contribution” Format="Rounded2">
<NodeTo Name="Contribution"/>

</Node>

<Node Name="GoodsSold" Text="Variable Cost of Goods Sold" ParentNode="Contribution" Format="Rounded2">
<NodeTo Name="Contribution"/>

</Node>

</Diagram>

You can also use this code snippet to construct the metadata specification objects:

MAInfluenceDiagramSpec *spec = [[MAInfluenceDiagramSpec alloc] init];
spec.name = @"EVA-Value-Driver";
spec.query = @"EVAQuery";

MAInfluenceDiagramNode *node = [[MAInfluenceDiagramNode alloc] init];
node.name = @"EVA";

node.text = @"EVA";

node.expression = @"OperatingProfitl-CostofCaptial”;

node.charts = @"chartl,chart2";

node.root = YES;

node.format = @"Rounded2";

[spec.nodes addObject:node];

[node release];

node = [[MAInfluenceDiagramNode alloc] init];
node.name = @"OperatingProfitl”;

node.text = @"Operating Profit";
node.parentNode = @"EVA";

node.expression = @"RONA*NetAssetsl";
node.charts = @"chart3,chart4”;

node.format = @"Rounded2";
MAInfluenceDiagramNodeTo *nodeTo = [[MAInfluenceDiagramNodeTo alloc] init];
nodeTo.name = @"EVA";

[node.nodeTos addObject:nodeTo];

[nodeTo release];

[spec.nodes addObject:node];

[node release];

node = [[MAInfluenceDiagramNode alloc] init];
node.name = @"CostofCaptial";

node.text = @"Cost of Captial";
node.parentNode = @"EVA";

node.format = @"Rounded2";

nodeTo = [[MAInfluenceDiagramNodeTo alloc] init];
nodeTo.name = @"EVA";

[node.nodeTos addObject:nodeTo];

[nodeTo release];

[spec.nodes addObject:node];

[node release];

node = [[MAInfluenceDiagramNode alloc] init];
node.name = @"RONA";

node.text = @"RONA";

node.parentNode = @"OperatingProfitl";
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node.format = @"Percentage";

nodeTo = [[MAInfluenceDiagramNodeTo alloc] init];
nodeTo.name = @"OperatingProfitl";

[node.nodeTos addObject:nodeTo];

[nodeTo release];

[spec.nodes addObject:node];

[node release];

node = [[MAInfluenceDiagramNode alloc] init];
node.name = @"NetAssetsl";

node.text = @"Net Assets";

node.parentNode = @"OperatingProfitl,CostofCaptial”;
node.format = @"Rounded2";

nodeTo = [[MAInfluenceDiagramNodeTo alloc] init];
nodeTo.name = @"OperatingProfitl";

[node.nodeTos addObject:nodeTo];

[nodeTo release];

nodeTo = [[MAInfluenceDiagramNodeTo alloc] init];
nodeTo.name = @"CostofCaptial";

[node.nodeTos addObject:nodeTo];

[nodeTo release];

[spec.nodes addObject:node];

[node release];

Step 2: Query

e Add a new Objective-C class, InfluenceDiagramQuery, into the project.

e Ensure that InfluenceDiagramQuery adopts the MAQueryDelegate protocol:

- (id<MAQueryDataTable>)executeQuery: (NSString*)queryName withArgument: (NSDictionary*)args

{
MyDataTable* myTable = [[[MyDataTable alloc] init] autorelease];
[MALog trace:@"query name%@",queryName,nil];
if([queryName isEqualToString:@"EVAQuery"])
{
myTable.dataTable = [self GetEVAInfluenceDiagramQueryData];
¥
return myTable;
}

- (NSArray*)GetEVAInfluenceDiagramQueryData

{
NSMutableArray* table = [[[NSMutableArray alloc] init] autorelease];

NSMutableDictionary* row = [[NSMutableDictionary alloc] init];

[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row

setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:

[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber

numberWithDouble:

numberWithDouble
numberWithDouble
numberWithDouble
numberWithDouble

numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:

numberWithDouble

42.24] forKey:@"EVA"];

:120] forKey:@"OperatingProfit1"];
:77.76] forKey:@"CostofCaptial"];
:0.15] forKey:@"RONA"];

:800] forKey:@"NetAssetsl"];
0.097] forKey:@"WACC"];

0.12] forKey:@"ProfitMargin"];
1.25] forKey:@"NetAssetTurnover"];
120] forKey:@"OperationProfit2"];
1000] forKey:@"Salesl"];

800] forKey:@"NetAssets2"];

200] forKey:@"EBIT"];

:0.4] forKey:@"IncomeTax"];
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[row
[row
[row
[row
[row
[row
[row
[row

setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:

[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber

[table addObject:row];

[row

row =
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row
[row

release];

numberwWithDouble:
numberwWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:

[[NSMutableDictionary alloc] init];

setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:
setObject:

[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber
[NSNumber

[table addObject:row];

[row

retur

release];

n table;

numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:
numberWithDouble:

Step 3: MAInfluenceDiagramView

1000] forKey:@"Assets"];

200] forKey:@"Liabilities"];
600] forKey:@"Contribution"];
400] forKey:@"Overhead"];

600] forKey:@"FixedAssets"];
400] forKey:@"CurrentAssets"];
1000] forKey:@"Sales2"];

400] forKey:@"GoodsSold"];

46.464] forKey:@"EVA"];

132] forKey:@"OperatingProfitl"];
85.536] forKey:@"CostofCaptial"];
0.165] forKey:@"RONA"];

880] forKey:@"NetAssetsl"];
0.097] forKey:@"WACC"];

0.132] forKey:@"ProfitMargin"];
1.25] forKey:@"NetAssetTurnover"];
132] forKey:@"OperationProfit2"];
1100] forKey:@"Salesl1"];

880] forKey:@"NetAssets2"];

220] forKey:@"EBIT"];

0.44] forKey:@"IncomeTax"];

1100] forKey:@"Assets"];

220] forKey:@"Liabilities"];

660] forKey:@"Contribution"];
440] forKey:@"Overhead"];

660] forKey:@"FixedAssets"];

440] forKey:@"CurrentAssets"];
1100] forKey:@"Sales2"];

440] forKey:@"GoodsSold"];

e Add a new view controller, InfluenceDiagramController, into the project.

e Import MAKit.h, the header file that includes all public headers of the MAKit library.

e (Create MAInfluenceDiagramView in viewDidLoad.

o Set the theme. A default theme—MAKitDiagramTheme_Vallina—is included in the library.

e Associate the created datasource, MAInfluenceDiagramQuery, with the view component
MAInfluenceDiagramView.

e Set the influence diagram’s frame and refresh the view in viewWillAppear.

This code snippet assumes that Automatic Reference Counting (ARC) is not enabled:

#import “MAKit.h”

@interface InfluenceDiagramController ()
@property(nonatomic,retain) MAInfuenceDiagramView* influenceDiagramView;
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@end

@implmentation InfluenceDiagramController
@synthesize influenceDiagramView;

(void)dealloc

self.influenceDiagramView = nil;
[super dealloc];

(void)viewDidLoad
[super viewDidLoad];

MAInfluenceDiagramView *aInlfuenceDiagramView = [[MAInfluenceDiagramView alloc] initWithFrame:aFrame,
ViewMode :MAInflLuenceDiagramGoalSeeR];

self.influenceDiagramView = aInlfuenceDiagramView;

[aInlfuenceDiagramView release];

[self.view addSubView:self.influenceDiagramView];

MAKitDiagramTheme_Vallina *aTheme = [[MAKitDiagramTheme_Vallina alloc] init];
self.influenceDiagramView.theme = aTheme;
[aTheme release];

self.influenceDiagramView.metaDataPath = [[NSBundle mainBundle]
pathForResource:@"InfluencediagramMetadata"” ofType:@"xml"];

/* without using the metadata file, you can also use the metadata with the influnence diagram spec object
created above
self.influenceDiagramView.metaDataSpec = spec;
[spec release];
*/
InfluenceDiagramQuery *dataSource = [[InfluenceDiagramQuery alloc] init];
self.influenceDiagramView.dataSource = dataSource;
[dataSource release];
self.influenceDiagramView.delegate = self;

}

- (void)viewWillAppear

{
self.influenceDiagramView.frame = aFrame;
[self.influenceDiagramView reloadData];

}

@end

After you have set the metadata and datasource as MAInfluenceDiagramView's properties, invoke
reloadData to load the data. You must refresh at least once after the view is initialized, and may refresh
application data again as required, such as when the data on the back-end server has been updated.

Expressions

Expressions compute chart data, or perform goal-seeking analysis in an influence diagram.
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A chart has three axes (x, y, and z), which are called, respectively, category, series, and values. For values,
you can specify an expression that lets you select the data that should appear, and how it should look.
For category and series, you can specify only a column name. In early versions of MAKit, both category
and series could also be expressions that allowed for aggregation on the device; currently, category and
series should already be in aggregate form.

In an influence diagram, you can specify a node name in an expression.

This is the syntax for an expression:

expr = operand (operator operand)?

operand = column_name | node_name | function_name(arg [,arg[,arg.]]) | constant
operator = ( + | / | - | * ) | logical operator

logical_operator: (< | > | <= | >= | != | ==

arg = column_name | node_name | constant | expr

constant = string | numerical_value

e Always enclose string constants in single quotes; using double quotes in the same capacity
generates an error.

e Column names and node names are case-sensitive; however, function names are case-
insensitive.

e Certain operators, such as > and <, must use HTML syntax (for example, &It; &gt;) when entered
manually in the metafile.

Examples of Expressions

ValueExpr = Coll+Col2*Col3+2.2 ( ColX == e.g. column name from a database table )

ValueExpr = ‘Foo’ + Coll ( will convert whatever is in Coll to string and concatenate )
ValueExpr = sqrt(Col2) ( Square root of each value on each row )
NodeExpr = Nodel+Node2*Node3+2.2 (NodeX == e.g. node name from a influence model)

When combining operands of different types, implicit conversion is performed only in some very special
cases.

This example is invalid because “a” and “hello” are of different datatypes, which may potentially create
a column of mixed types:

ValueExpr = if(a==1,a,’hello’)

This is the correct way to write the expression:

ValueExpr = if(a=1,string(a),’hello’)
Implicit conversions are performed only when columns or constants are concatenated.

There is a special function for specifying dates as constants:

ValueExpr = if( SomeColOfDateType > date(2010,9,1), a, b )
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However, if you specify a date as a string according to the mask YYYY-MM-DD, it is converted to a date
object (for example, "2009-09-01"). SAP recommends that you use the date() method as described here.

You can nest if-statements; however, too many nesting levels may be difficult to read:

ValueExpr = if( a>b, if( a>c, a, c), b )
ValueExpr = if (a >b, if (a>c, a, if(a>d, e, f), g ), h ) // you get the picture

Expression Types
In a chart, the only valid values for category and Series are column names; this is further emphasized in

the metafile, where the attribute for category and Series that maps to the values is called Column,
whereas the attribute for values is Expression.

Each chart uses this syntax:

<Category Column=>* ../>
<Serie Column="* .. />
<Values><Value Expression="” ../></Values>

For example, an application has a table you want to include in a column chart. You must map the values
from the table to the chart. To do this, use XML as described above.

The values you want to show in a chart are shown below—three columns of different height.

Project_Group Members
Alpha 20
Beta 30
Gamma 55

To show these values in the chart, you must specify the category, in this case, “Project Group.” The
category becomes the x-axis. The series is set to empty (“”) and the value in the y-axis is “Members.”

The XML snippet looks like this:

<Category Column=”Project_Group” ../>
<Series Column-‘“” ../>
<Values>
<Value Expression="”Members” .. />
</Values>

There is no value expression per se—the column name is used as a value expression. To specify a real
expression, for example, to add 10% more members, use Expression="Members*1.10”.

Note: There are a number of runtime functions you can use in expressions; these functions are
described later in this document.
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Internally, expressions work with columns, so using “Members*1.10” means that every row in the table
gets 10% more members. If you have two columns—Column1 and Column2—and you write “Columnl +
Column2”, the two columns are added together row by row.

This example takes each row from the Age column and adds 10% to each value, creating a new value
array that has the same number of rows:

ValueExpr= Age*1.1
This example calculates the sales revenue of a company:
ValueExpr=Amout*(UnitPrice-UnitCost)

Under normal circumstances, developers do not interact directly with the parser and lexer. Instead, they
specify the three expressions in a middle layer. This is a short summary of the internal processing:

-{void)testParsedndEvalFunction

7 {

[MALog setTracelewel:Z];

NSMutableDicticnary *columns = [[NSMutableDictionary alloc] initWithCapacity:o];

[columns setObject:[NSArray arrayWithObjects:[NSNumber numberiithFloat: 1s
[MSNumber numberWithFleat: 1s
[MSNumber numberWithFloat: 1, nil] forKey:@"a"];

MAParse® parser = [[MAParse alloc] init];
MAExpression* parsedExpression = [[parser parse:@"avg(a)”] retain];

parsedExpression.columnDicticnary = columns;

MAExprEval* ewval = [[MAExprEval alloc] init];

id result = [[eval evaluate:parsedExpression] retain];

[eval release];

NsLog( @"evaluated to: ¥1f", [[result cbjectAtIndex:2] floatValue] };

[result release];

[parsedExpression release];

[parser release];

[columns release];

[MaLog setTracelevel:a];
"}

In the columns dictionary, the key is the column name “a”, which has an array associated with the row
values in NSArray. MAParse parses the expression and creates an object—MAExpression—which contains
the information for evaluating the expression. By using different column value dictionaries, expressions
can be reused.
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In an influence diagram, each node can also specify a similar concept of expression; the difference is

that the expression in an influence diagram is made up of node names instead of column names.

The XML snippet looks like this:

<Node Name="OperatingProfit” Expression="RONA*NetAsset”>

</Node>

Runtime Functions

You can use runtime functions in expressions; however, make sure you use the correct type of function

on the correct datatype. For example, do not use Abs (Name) if Name is a column containing strings.

Note: Column names and node names are case-sensitive, but function names are not.

Numeric Functions
//

// argument is a constant/column/node

//
Function Name Description
Abs (column|node) Abs(-1) -> 1

Ceiling(column|node)

Ceiling(1.01)->2.0

Cos(column|node)

Cos(1)->0.9998477

Exp(column|node)

Log( Exp(2) ) == 2

Fact(column|node)

51->120, be careful with overflow.

Floor(column|node)

10.1 -> 10.0

Int(column|node)

12.2 -> 12, use round for rounding values.

Log(column|node)

Log(Exp(1))=1

LogTen(column|node)

LogTen(10*10)==

Mod(column|node, dividend)

10%5 == @, 3%2 == 1

Neg(column|node)

Neg(-1)->1,Neg(1)->-1

Note: Neg differs from Abs. Use Neg when a
negative value is needed, since unary minus is not
supported. For example, 2*-1 is not allowed;
instead write 2*Neg(1).

Round(column|node,decimals)

Rounds off a value to decimals. The second argument
‘decimals’ can only be a constant and cannot be a
column name.

Sign(column|node)

Sign(1.0)->1,Sign(-121)->-1
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Sin(column|node)

Sin(1)->0.01745241

Sqrt(column|node)

Sqrt(3)->1.7320508..

Tan(column|node)

Tan(1)->0.01745506

Truncate(column|node)

12.32123->12.

DateTime Functions

Note: You can use DateTime functions only in chart expressions.

//

// date time functions only work on columns(vectors) of type date, in general it is

// not possible to use them on constant values since there is no date type recognized

// in the parser.

// e.g. not allowed: Day( "2010-05-10" ) allowed: Day( MyDateCol )

// (you can however use the date function for date constants, see below)

Function Name

Description

Date(y,m,d[,hh,m,s] | column)

This versatile function can create a constant by
using constant values for year, month, and so on,
or converting a datetime column to date datatype.
For example, date(2010,9,1) creates a constant date
that can be used in expressions, and
date(mydatecol) removes hh:mm:ss from the datetime
in the column. This may be when comparing datetimes
when the time of day does not matter.

Day(column) Returns the day number 1-31/30/28.
DayNumber (column) 1=Sunday, 2=Monday,...

Hour (column) Returns hour of day.
Minute(column) Returns minute of hour.
Month(column) Returns month of date.

RelativeDate(column, days)

Adds days to date, days== constant value, cannot be
a column name.

RelativeTime(column, seconds)

Adds seconds to date timestamp== constant value,
cannot be a column name.

Second(column) Returns seconds, column is assumed to contain date
objects.
Year(column) Returns year of date; column is assumed to contain

date objects.

String Functions

Note: You can use string functions only in chart expressions.
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//

// functions operate on columns if not stated otherwise

//

Function Name

Description

Left(column, numberOfChars)

left(‘abcdef’,3)->’abc’, left(Columnl,1)

LeftTrim(column) ¢ abc ¢ -> ‘abc °
Len(column) Returns number of characters.
Lower(column) ‘MYSTRING’ -> ’mystring’

Match(column, string)

Returns 1 for match, © for no match.

Mid(column, start [, length ])

mid( ‘abcdef’,3,2)->’cd’

Pos(column, string [, startPos ])

pos(‘abcdef’,’c’)->3

Replace(column, startPos, numberOfChars, string)

“1234” -> “1XX4”. startPos =1,..

Right(column, numberOfChars)

right(‘abcdef’,3)->"def’

RightTrim(column) ¢ abc ¢ -> ¢ abc*
String(column) Converts the column to strings.
Trim(column) ¢ hello ¢ -> ‘hello’

Upper(column) ‘mystring’ -> ‘MYSTRING’
WordCap(column) ‘bob alice eve’ -> ‘Bob Alice Eve’

Miscellaneous Functions

Function Name

Description

if(condition,expril,expr2)

If f‘condition’ is nonzero,
zero, expr2 is evaluated.

exprl is evaluated; if

and(expril,expr2[,..])

This can, for example, be used in an if statement
in this way: if(and(expril,expr2),resl,res2).

or(expri,expr2[,..])

As above.

not (exprl==expr2)

Unary not(exprl==expr2) is the

exprl!=expr2.

Ssame as
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Metadata File

The metadata file, or metafile, is a configuration file for MAKit that contains information about where to
place charts and influence diagrams, and about the interdependencies between charts and influence
diagrams. The metafile also connects charts and influence diagrams to queries.

Note: All node names and attribute names have a capitalized first letter.

Metadata Formats Other Than XML

Most metadata examples given in this document are written with XML format. Alternatively, you can
use a plist file as metadata.

You can transform an XML metadata file to a plist metadata file by applying these rules:

o For each XML element, there must be a corresponding dictionary entry in the plist definition.
The key of the first entry in the dictionary is “MetaName,” and the value of the first entry is the
name of the XML element.

e For each XML attribute, there must be a corresponding string entry in the plist definition. The
key of the string entry is the attribute name, and the value is the attribute value.

e The parent-children and sibling relationships among XML elements/attributes must be the same
as those among entries in the corresponding plist definition.

e If there are sibling dictionary entries in the plist definition, the keys for the sibling dictionaries
must be incrementally indexed.

This is an XML format metadata file:

<MobileAnalytic><Dashboard>
<Chart Name="Sales" Title="Bike Sales Summary" ChartType="Line" Query="SalesSummary">
<Category Format="Rounded®" Column="Year" DisplayName="Sales Year" />
<Series Column="Product" DisplayName="Sales Year" />
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="Sales Amount in US
Dollars" />
</Values>
</Chart></Dashboard>
</MobileAnalytic>
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While this figure shows the equivalent plist definition:

Key Type Value
MetaName String MobileAnalytic
0 Diction... (2 items)
MetaMame String Dashboard
0 Diction... (8 items)
MetaName String Chart
Name String Sales
Title String Bike Sales Summary
ChartType String Line
Query String SalesSummary
0 Dictian... (4 items)
MetaName String Category
Format String Roundedd
Column String Year
DisplayName String Sales Year
1 Diction... (3 items)
MetaName String Series
Column String Product
DisplayName String Sales Year
2 Diction... (2 items)
MetaName String Values
0 Diction... (5 items)
MetaName String Value
Format String Currency
Expression String SalesAmount
ValueSequence String 1
DisplayName String Sales Amount in US Dollars

To use a plist file as metadata, parse the plist file to an intermediate metadata NSDictionary, for
example:

NSDictionary *metaDictionary = [NSMutableDictionary dictionaryWithContentsOfFile:
[[NSBundle mainBundle] pathForResource:@"example" ofType:@"plist"]];

Next, pass the dictionary to a MAKit view controller or MAKit view:
controller.metaDict = metaDictionary;

or:

chartView.metaDict = metaDictionary;

The metadata NSDictionary is not required to be parsed from a plist file; alternatively, you can create
the NSDictionary from scratch without a plist file.

Chart Metadata File

This figure shows the root as well as the two branches in the XML file. The first branch, bashboard,
contains the metadata related to the charts, for example, which query to use with which chart. The
second branch, bashboardLayout, contains information about where to place charts on the device screen
in relation to each other. Both sections are required structures.
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: "")ﬂnl

=@ MobileRnalytic

el ¥mIns i xsi

& xsi:noNamespaceSchemalLocation
D Dashboard

----- D DashboardLayout

Dashboard

This figure shows an expanded Dashboard. The Variables section contains all variables used for dynamic
analytics. If the same variable is used in several value expressions, making any changes to that variable
affects all charts that use that variable. The DAPanel section contains a list of variables that appear
together on the device using controls appropriate to the variable type.

B3 Dashboard
.......... & #comment
{3 Variables
-2 Filters

g Chart

13 DrillDownGroup |
g2 DataGrid

H--) DERPanel

g ) DAPanel

=3 DashboardLayout
- Landscape

) Portrait

E
E
E
E
E
E
E
E

For example, if you include variable Spercentdiscount in this expression:
<Value Expression=”Amount* (1.0-$percentdiscount/100)” .. >

Any changes to Spercentdiscount also automatically changes the Amount.

Variables
The variable section contains a name, an optional DisplayName, a variable type and, depending on the
type, an optional value.

= Variables
& Fcomment
-3 Variable
& Name
« Displayiane |
& VariableType
& Value

R T R 1ot N

Here is another example of variable usage (for clarity, some XML has been omitted):

<Dashboard>

<Variables

<Variable Name="$prob” VariableType="integer” Min="0” Max="100” Value="50" DisplayName="Count items
with probability over” />
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<Chart Table="pipeline" Type="Column" Title="Pipeline Summary" >
<Values><Value Expression="if(Probability&lt;$prob, Amount, @)" ValueSequence="1">

The chart node shows the amount of sales opportunities in each stage. The chart uses a variable
($Sprob), which allows the user to show opportunities that have a probability larger than a threshold
only. The chart allows the user to adjust this threshold, by means of a slider control.

A variable has a collection of attributes:

Name — the identity of a variable. The variable name must start with S, be defined, and be unique
in a chart.

VariableType —the value type of the variable. Variable types can be: integer, float, boolean,
date, enum. variableType is a required attribute.

Min —the minimal value of the variable; applicable to integer and date variables.
Max — the maximum value of the variable; applicable to float, integer, and date variables.

Value —the default value of the variable, before the user makes any changes. Every variable
except enum must have a default value. enum has an attribute called Selection, which is a list
of values that can be selected from.

Boolean variable values — these values indicate “true”: true, True, TRUE, yes, Yes, YES, 1. These
values indicate “false”: false, False, FALSE, no, No, NO, 0.

Date variable values must be specified with a date statement using the form “date(yyyy, mm,
dd)”; for example, “date(2000,12,30)".

DisplayName — a text string that describes the variable. This string appears along with the control.
Every variable must have a DisplayName.

33 Variable

& Name

« isplayNans]|
& VariableType
& Selection

= Choices

=3 Cholce
+--3 Cholce
+--3 Cholce
-2 Choice
-2 Choice
-2 Choice

The Display attribute contains a text string that is shown to the user, and value is the value used in the

value expression.

<Variable Name="$shown_region” Type="enum” Selection="0" DisplayName="Show data in region”>
<Choices>

<Choice Value="North America”/>
<Choice Value="APC”/>

<Choice Value="Europe”/>
<Choice Value="Africa/”>
<Choice Value="South America”/>
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</Choices>
</Variable>

An enum variable allows the user to pick one string value from a collection of strings, which are stored in
the Choices section. Each choice has value attribute and a Display attribute. If the Display attribute is
defined, it is used; otherwise, the value is used directly.

There can be an arbitrary number of variables. Each variable type has its own set of attributes:

B E} Variables
- #comment
O Variable

e

.......... & DisplayName
.......... & VariableType

.......... & Di splayName
---------- & VariableType

.......... e Dj_sp]_ayName
---------- & VariableType

.......... & Di splayName
---------- & VariableType
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Filters

Declare filters globally for the dashboard, to create subsets of data sets.

El---Z) Dashboard

.......... & #comment

F---) Variables

B J Filters

- #comment

=3 Filter

i il Name

-l Sourceluery
-l FilterType

P e Column
........ D Filter
B b Chart

Filter SourceQuery retrieves the filter choices and returns, for example, a list of years from which the
device user can select a subset. The charts are then refreshed, based on the filter. There are two
FilterType controls: range, which lets the user specify a range of data; and picklist, which shows a list
box from which he or she can select individual choices.

In each chart, FilterName tracks the filter to apply. You can apply multiple filters to a Query.

53 Chart

.......... - ChartType
.......... & Query

.......... & #fcomment
-0 Category

][ﬁ Serie
[][ﬁ Values

-5
=

.......... L. Sequence
-------- ) FilterName

— T -

Chart

The chart node contains the description of a chart. If there is only one chart node, it is treated as if
there was no Dashboard.
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=3 Chart
& Name
& Title
& ChartType
& Query
-3 Category
& Format
& Column
& DisplayName
-3 Series
& Format
& Column
& DisplayName
-3 Values
- Value]
& Format
& Expression
& ValuesSequence
& DisplayName
=3 Filters

The chart node contains a Name, an optional Title for the chart, and a ChartType, for example, bar. The
name identifies the chart node from the other charts in a dashboard. The name must be unique; if it is
not, the dashboard layout may affect only the first chart that uses that name; all other charts use the
default layout.

Supported chart types include: bar, column, line, area, pie, stacked column, bubble, scatter, datagrid,
vertical bullet and horizontal bullet.

Query is a named query, for example, “RevenueByYear,” that resides in the application and is called by
MAKit to retrieve chart data. The application uses Query to retrieve data from the appropriate
datasource.

There are a number of nodes under chart.

Category
-3 Category
& Format
& Column
& DisplaylName

The category column contains the category; typically the x-axis in an xy-chart. The Format attribute lets
you modify the data format; for example, Format="WeekDay” converts the date to a weekday name in
the chart. Column is the actual unique name of the column to use, when Format =”Currency”, you
can also optionally use CurrencyCode attribute to specify the currency code for this node.
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Supported Format Strings

Name Type Req Description
Month NSDate For example, “January”
ShortMonth NSDate For example, “Jan”
WeekDay NSDate / For example, “Monday”
Numeric values
1-7
ShortWeekDay NSDate For example, “Mon”
ShortDate NSDate Depends on locale
LongDate NSDate Depends on locale
Currency Numeric Depends on locale, for example, $10.20
Percent Numeric Displays as percent, for example, 10 -> 10%
Rounded{n}(n=0,1,2,..9} Numeric Rounds number to n decimals
Series
=8 Series
- Column

ekl DisplayName

Series specifies the z-axis. However, since the charts are two-dimensional, series are drawn next to each
other. An example is a table that shows the number of employees year for year (category) where gender
is the series, and the number of employees is the value.

Values

& Expression
& ValueSeguence
- DisplayName

The value expression shows the values in the chart. Values can optionally use an expression instead of a
column name, for example, Expression=“Amount*1.1” Label=“Added 10% to price”.

Typically, a chart uses only one value expression; however, certain chart types, such as bubble charts,
may use more than one value expression. Use the values collection to group such variables. The
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ValueSequence number is important for charts that have multiple values—it maps additional values to
special charts that have additional requirements for input data.

This is an XML snippet for a bubble chart that has two values; the first indicates the y-value, and the
second indicates the bubble size:

<Chart Query="pipeline" ChartType="Bubble">

<Values>
<Value Expression="Amount" ValueSequence="1" .. />
<Value Expression="UnitPrice " ValueSequence="2" .. />
</Values>
</Chart>

This is an XML snippet for a bullet chart that has four values:

<Chart ChartType="HorizontalBullet" Query="resellerByYear">
<Category Column="Year" DisplayName ="Year" />
<Series Column="ResellerName" DisplayName ="Reseller Name" />
<Values>
<Value Expression="ActualAmount" ValueSequence="1" DisplayName="Actual" />
<Value Expression="BadAmount " ValueSequence="2" DisplayName ="Bad" />
<Value Expression="SatisfactoryAmount" ValueSequence="3" DisplayName ="Satisfactory" />
<Value Expression="TargetAmount" ValueSequence="4" DisplayName ="Target" />
</Values>
</Chart>

The value sequence indicates these values on the bullet chart.

Value Sequence Value
1 Actual value
2 Value below which is considered bad
3 Value below which is considered satisfactory
4 Target value
Bad Satisfactory Good Actial Target
0 500 1K 1.5K l 2K 2.5K
Semantic Zooming

Semantic zooming allows the chart to display data in several zooming levels, for example, by year,
qguarter, and month. The user may view data at any predefined level. Chart metadata must include a
definition for each zooming level.
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28 chart

) Name

g Title

- ChartType
@ Category

@ series

~@ Values

fora B |

- Title

-3 ZoomingLevels
EE) ZoomingLevel

: e i CategoryColumn
-2 ZoomingLevel
w3 ZoomingLevel

Each zooming level definition includes:

e Query —the query name for retrieving data of this level.

e Title — optional title for this level.

e CategoryColumn — category column for this level.

Unlike charts without zoom functionality, semantic zooming charts have different query and category
columns in each level. Therefore, remove the Query attribute for the chart node and the Column

attribute for the category node.

What-If Analysis

What-if analysis allows the user to dynamically change input data and see instant corresponding
updates in the chart. To enable this feature, the user must define what-if columns in the chart.

5@ Chart

-2 Category
B3 Values

&6 Value

.......... & Format

S E}WhatIfColumns
263 Column

)

-3 Column

---------- & Expression
---------- & ValueSequence
---------- & Description

ROIDuPonthnalysis
ROI DuPont Analysis
Column
duPontDataguery

Rounded

((Revenue - Costs) / Assets) * 100
1

ROTI

Costs
float
0.0
Costs
0.0
1000
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The metadata of this chart is:

<Chart Name="ROIDuPontAnalysis" Title= "ROI Analysis" ChartType="Column" Query="ROIQuery" >
<Category Format="" Column="Year" DisplayName ="Year" />
<Values>
<Value Format="Rounded" Expression="((Revenue - Costs) / Assets) * 100" ValueSequence="1" DisplayName
="ROI" />

</Values>
<WhatIfColumns>
<Column Name="Costs" VariableType="float" DisplayName ="Costs" Min="0.0" Max = "1000"/>
<Column Name="Revenue" VariableType="integer" DisplayName ="Revenue" Min="0.0" Max = "1500"/>
</WhatIfColumns>
</Chart>

The Values expression is "((Revenue - Costs) / Assets) * 100", which means that the calculation involves
three columns from the input table: Revenue, Costs, and Assets. The user can select any of these
columns for what-if analysis.

For each what-if column, provide these attributes:

e Name —the column name.

e VariableType —the datatype of that column. Different datatypes are presented as different
controls in the Ul. MAKit supports float and integer types.

e DisplayName — a text description of the variable. The device user sees this text in the UL.
e Min—the minimum value of the data range.

e Max —the maximum value of the data range.

DAPanel

DAPanel contains VariableName nodes, which let you create a panel with sliders and other controls
(depending on the variable type). For example, you can add a slider for indicating the Min and Max
integer values. Remember, changes to the variables affect all charts that use the variable, since variables
are global for the metafile. You can use the optional title to group DA variables in logical groups.
Sequence determines the order in which variables are shown in the panel.

-2 DAPanel
& Name
& Title
-2 VariableName
& Hame Stestbool
& Sequence
-2 VariableName
& Hame Stestfloat
& variable 2

DrillDownGroup

Use DrillDownGroup to create a link between charts, for example, when something like a category is
picked in the first chart, and it affects the contents of the next chart. The selected category is passed as
a parameter to the query of the next chart.

The Name of the drilldown group is used for the layout, which is then applied to all charts in the group.
This rule applies to all collections (groups).
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A drilldown group contains multiple chart nodes. Each chart node defines the chart of a drilldown level.

=3 DrillDownGroup
& Name
& Title
—--3 Chart
& Name
& Title
& ChartType
& ChartSeguence
& Query
- CAEEG0Ey]
+#--0) Series
=2 Values
+--2 Chart
=3 Chart

RFTable

The rich format table (RFTable) shows Chart, Data (text), and Variance in a table form. The Chart is a line
chart that shows the data trend (upward or downward), Data shows values, and Variance shows any
difference between target and actual values. Users can double-tap an RFTable to open it in full-screen

mode.
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The metadata of this chart is:

B3 DataGrid
el Name EFTable
- Title Table Chart
@ Query TableQuery
B3 Columns
-3 Column
-l Value kpi_na.me
& Header EPT Name
-l TsHeaderColumn 1
B2 Column
- Type Chart
- Value char data
- @ ChartName Trendline
- & Header Past Trend
- ColumnSequence 1
Rl 0 ] umn
#--32 Column
B2 Column
B~ Column
B2 Column
#--32 Column
B2 Column
#--32 Column
B2 Column
=B Charts
B Chart
- Trendline
Month Trend
Line

<DataGrid Name="RFTable" Title="Table Chart" Query="TableQuery">

<Columns>
<Column
<Column
ColumnSequence="1"/>
<Column

Type="Data" Value="kpi_name" Header="KPI Name" IsHeaderColumn="1"/>
Type="Chart" Value="char_data" ChartName="Trendline" Header="Past Trend"

Type="Data" Value="actual" Format="Currency" Header="Actual" ColumnSequence="2"/>
Type="Data" Value="op" ColumnSequence="3" />

<Column Type="Data" Value="target" Format="Currency" Header="Target" ColumnSequence="4"/>

<Column Type="Variance" Value="actual-target" Color="if(actual > target, 'green', 'red')"
Format="Currency" Header="Variance Target" ColumnSequence="5"/>

<Column Type="Data" Value="col@" Header="col@" ColumnSequence="6"/>

<Column

<Column Type="Data"
<Column Type="Data"
<Column Type="Data"
<Column Type="Data"

Value="coll"
Value="col2"
Value="col3"
Value="col4"

Header="coll"
Header="col2"
Header="col3"
Header="col4"

ColumnSequence="7"/>
ColumnSequence="8"/>
ColumnSequence="9"/>

ColumnSequence="10"/>
</Columns>
<Charts>
<Chart Name="Trendline" Title="Month Trend" ChartType="Line">
<Category Column="Month" Description="Month" />
<Values>
<Value Format="Rounded2" Expression="Amount" ValueSequence="1" Description="Trend
Value" />
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</Values>
</Chart>
</Charts>
</DataGrid>

DashboardLayout

DashboardLayout determines where to place charts on the device screen. The iOS device is either in
landscape mode or portrait mode, and this affects the layout of the charts, depending on how the user
holds the device.

=2 DashboardLayout

-~ & ContentWidth
- @ ContentHeight

.......... ‘, He1g‘ht

=2 Portrait

- ContentWidth
- ContentHeight
E| ........ b Layout
bl Name
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Landscape and Portrait Layout

- @ Landscape )
-~ ContentWidth
& ContentHeight
E--@ Layout
[— Name
-~ Top
- Left
-# Width
\ - Helght
= [.f} Fortrailt
- ContentWidth

- Width
FA— Hej_ght

There are two scales for the dashboard: percentage and points. The default scale is percentage, which
does not support scrolling. Specify layout dimensions in percentage form (0-100).

Landscape and Portrait both contain Layout nodes, which contain information about positioning Ul

elements from the Dashboard subtree. Name indicates the Ul element (for example, Chart) to position.

Top, Left, Width, and Height are percentage values that indicate the position and size of the chart.
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Influence Diagram Metadata File

& xml
SRR=]
& Name
& Cuery
=) Hode
& Hame
& Text
& Expression
Default
& Charta
& Format
=i Hode
& Hame
& Text

& FParentNode
& Ezprezsion

& Charts
& Format
=] NodeTo
& Name
H--|) Node
+--- ) Hede
+ I Node

Diagram

Diagram contains the description of an influence diagram; Name is the identifier of an influence diagram
in the application. Query is a named query, for example, “EVAQuery,” that resides in the application and
is called by MAKit to retrieve influence diagram data. The application uses Query to retrieve data from

the appropriate datasource.

version="1.0" encoding="utf-8"
EVA-Value-Driver
EVAaQuery

h=

1T

= =

Vo

OperatingProfitl-CoatofCaptial

true
chartl, chart2
Rounded?2

OperatingProfitl
Operating Profit
EVA
RONA*NetAssetsl
chart3, chartd
RoundedZ

1=

VA

Name Description Mandatory/Optional
Name Name of node M
Query Name of query that retrieves data M

Node

Node contains the description of an influence diagram metric node. The Name attribute is the identifier of
a metric node in an influence diagram. The Text attribute gives the measure text that appears on the
node. The ParentNode attribute specifies the parent nodes of a metric node. In an influence diagram,
one node may have multiple parent nodes. The Expression attribute allows you to specify an expression
to perform goal-seeking analysis. The Format attribute lets you modify the data format; for example,

Format=""Percent” converts the value to a percentage form.
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Supported Format Strings

Name Type Req Description
Month NSDate For example, “January”
ShortMonth NSDate For example, “Jan”
WeekDay NSDate / For example, “Monday”
Numeric values
1-7
ShortWeekDay NSDate For example, “Mon”
ShortDate NSDate Depends on locale
LongDate NSDate Depends on locale
Currency Numeric Depends on locale, for example, $10.20
Percent Numeric Displays as percent, for example, 10 -> 10%
Rounded{n}(n=0,1,2,..9} Numeric Rounds number to n decimals

The Default attribute specifies whether a node is the root node. The chart attribute allows you to
provide a list of chart names that are specified in a MAKit chart metadata file, so that you can associate
the behavior of double-tapping a node in an influence diagram with the MAKit chart that appears.

Name Description Mandatory/Optional
Name Name of node M
Text Measure text of node M
ParentNode Name of the parent node of a node (0]
Expression Expression of node 0]
Format Format of node o
Default Whether a node is root node or not 0
Charts A list of chart names associated with a | O
node
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NodeTo

NodeTo contains the description of a metric node pointing to which nodes; one node can point to
multiple nodes.

Name Description Mandatory/Optional

Name Name of the node that a node pointsto | M

The metadata of this influence diagram is:

<?xml version="1.0" encoding="utf-8"?>
<Diagram Name="EVA-Value-Driver" Query="EVAQuery">
<Node Name="EVA" Text="EVA" Expression="OperatingProfitl-CostofCaptial” Default="true"
Charts="chartl,chart2" Format="Rounded2"/>
<Node Name="OperatingProfitl" Text="Operating Profit" ParentNode="EVA" Expression="RONA*NetAssetsl"
Charts="chart3,chart4" Format="Rounded2">
<NodeTo Name="EVA"/>
</Node>
<Node Name="CostofCaptial" Text="Cost of Captial" ParentNode="EVA" Expression="NetAssetsl*WACC"
Format="Rounded2">
<NodeTo Name="EVA"/>
</Node>
<Node Name="RONA" Text="RONA" ParentNode="OperatingProfitl" Expression="ProfitMargin*NetAssetTurnover"
Format="Percentage">
<NodeTo Name="OperatingProfitl"/>
</Node>
<Node Name="NetAssetsl" Text="Net Assets" ParentNode="OperatingProfitl,CostofCaptial”
Format="Rounded2">
<NodeTo Name="OperatingProfitl"/>
<NodeTo Name="CostofCaptial"/>
</Node>
<Node Name="WACC" Text="WACC" ParentNode="CostofCaptial" Format="Percentage">
<NodeTo Name="CostofCaptial"/>
</Node>
<Node Name="ProfitMargin" Text="Profit Margin" ParentNode="RONA" Expression="OperatingProfit2/Sales1"
Format="Percentage" Charts="chartl,chart2">
<NodeTo Name="RONA"/>
</Node>

</Diagram>

Best Practices

Performance
e Improve performance by sorting data before feeding it to a chart.

e Performance may be affected by overusing expressions.

Usability

e Limit the number of series for column charts, line charts, and horizontal bar charts to 16; no
limitation for the number of series for pie charts.

97





MAKit Developer Guide: iOS 2013

e Limit the number of categories for column charts, line charts, and horizontal bar charts to 2000.

e Limit the number of categories for bubble charts to 300.

Troubleshooting/Tips

Data Does Not Appear in the Chart

The Application log generally includes one or more error messages indicating what has gone wrong. A
typical case is when the wrong formatter is specified for a datatype; for example, a numeric value of
2008 uses the formatter Format="ShortDate”.

Note: The MAKit debug library includes many assert statements, which may also help in troubleshooting.

Logging

MAKit includes built-in logging functionality that is, by default, off (0). However, you can turn this on by
importing the header MALog.h, which has a static method called setTraceLevel that accepts an integer with
the value 0 (default; displays only error messages), 1 (trace), 2 (verbose), or 3 (performance). Setting the
trace level to 2 logs all activity that occurs in MAKit, and may be helpful when you are trying to track
down issues. However, a trace level setting of 2 somewhat degrades performance.

Localization/Formatting

MAKit formatting behaves according to the region (locale) set for the device. For example, if the region
is set to Germany on the device, any currency numbers are, by default, written with the € sign.
Numbers using the format specifier “Currency” follow the pattern of the specifier. You can create a
custom formatter to override the normal formatter.

Special Characters in Metadata File

In a metafile, you must encode characters with special meaning. For example, “&” is sometimes used
as a prefix for special characters. To include an & sign in Title="SAP & Son”, use the appropriate
encoding (Title=“SAP &amp; Son”); otherwise, you receive an error (XMLParseErrorDomain = 68) from
the XML parser. See http://www.degraeve.com/reference/specialcharacters.php for a complete list of
special characters.

Sample Application

You can find the full implementation of the code snippets in this document in MAKitCodeExamples,
which is a sample application included with MAKit.

Appendix: API Reference

Classes
class MAAccordionMenu

Class of MAAccordionMenu.
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class MAAccordionMenultem

Class of MAAccordionMenultem.
class MAAnRalyticChartView

A chart view with analytic capabilities, having its datasource defined by a metadata file.
class MAAnalyticChartViewController

A view controller for analytic chart view.
protocol <MAAnalyticChartViewDelegate>

Protocol of analytic chart view delegate.
protocol <MAAnimatorDelegate>

Protocol of animators.
protocol <MACartesianChartPainter>

Protocol of cartesian chart painter.
protocol <MAChartBasePainter>

Protocol of chart base painter.
protocol <MAChartDataModel>

Protocol of chart data model.
protocol <MAChartLayerModel>

Protocol of chart layer model.
class MAChartSelection

Class representing items selected in a chart.
protocol <MAChartSeriesPainter>

Protocol of chart series painter. This protocol defines methods and properties that must
be implemented by a chart series painter. A chart series painter is responsible for
painting the content of a chart series layer, such as columns, lines and bars, and so on.

protocol <MAChartTheme>

Protocol of chart theme.
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class

protocol

protocol

class

protocol

class

protocol

protocol

class

protocol

class

class

MAChartView

Class of a chart view with contents constructed from a chart datasource. A chart view
shows a chart. It is similar to the UlTableView, which displays a table. A chart view
object must have an object that acts as a datasource and optionally, an object that acts
as a delegate. The datasource provides information that the chart view needs to
construct the view. The delegate performs tasks such as managing selections.

<MAChartViewDataSource>

Protocol of chart view datasource.

<MAChartViewDelegate>

Protocol of chart view delegate.

MADashboardltemView

Class of a dashboard item presented in a dashboard.

<MADashboardTheme>

Protocol that defines the dashboard theme.

MADashboardView

Class of a dashboard with its contents constructed from a dashboard datasource.

<MADashboardViewDataSource>

Protocol of dashboard datasource delegate.

<MADashboardViewDelegate>

Protocol of dashboard view delegate.

MADiagramSpec

Class of diagram specifications.

<MADiagramTheme>

Protocol of diagram theme.

MADiagramTheme_Vallina

Class of MAKit influence diagram theme: Vallina.

MAError

Class of error information.
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protocol <MAErrorHandlingDelegate>

The MAKit error handler delegate.

protocol <MAlInfluenceDiagramDelegate>

Protocol of influence diagram delegate.

class MAInfluenceDiagramNode

Class of influence diagram node.

class MAInfluenceDiagramNodeTo

Class of influence diagram node to.

class MAInfluenceDiagramSpec

Class of influence diagram specifications.

class MAInfluenceDiagramView

Influence diagram view class.

class MAKIitTheme_WelterWeight

Class of MAKit theme: WelterWeight.

class MAKIitTheme_WelterWeightDark

Class of MAKIt theme: WelterWeight Dark.

class MALog

Class for logging.

class MAMailSharingController

Class to share an image of a view via an e-mail message.

class MAMetaDictionaryFactory

Class to construct metadata from property file.

protocol <MAMetricNodeViewDelegate>

Protocol of delegate for metric node view.

protocol <MAQueryDataTable>

Protocol that retrieves data for chart rendering.
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protocol <MAQueryDelegate>

Protocol of query used to retrieve chart data.

protocol <MAShape>

Protocol of chart basic shape.

class MAShapeModel

Class of model for shape.

class MATabularCategoryChartBasePainter

Base painter for drawing categories in a tabular format in the left area.

protocol <MAValueBubbleLegendViewDelegate>

Protocol of delegate for value bubble legend view.

class MAView

View class that contains main functions of MAKit.

class MAViewController

View controller class that contains main functions of MAKit.

protocol <MAViewDelegate>

Protocol of delegate for MAView class.

class MAXValueCartesianChartBasePainter

Base painter for charts with values as the x-axis, and categories as the y-axis.

MAAccordionMenu

Class of MAAccordionMenu.
An accordion menu is a vertically stacked list of items. Each item can be expanded to reveal the associated content, or

collapsed to hide the details.

Public Member Functions
(d)  -init

(id) - initWithFrame:
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(void) -addMenultem:

Member Function Documentation

- (void) addMenultem: (MAAccordionMenultem *)  menultem
Adds menu item to the menu.
- (id) init
Initializes control returns initialized object
- (id) initWithFrame: (CGRect) frame
Initializes control with the given frame.
Parameters:
frame Frame (position and size) of the control.
Returns:
Initialized object.
MAAccordionMenultem
Class of MAAccordionMenultem.
The menu items to be placed inside an accordion menu.
Public Member Functions
(void) - addSubMenultem:
(void) - setTouchUplInsideDelegate:theAction:
(void) - setTouchDownlinsideDelegate:theAction:
Properties
NSMutableArray * subMenultems

MAAccordionMenultem * parent

BOOL header
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Member Function Documentation

- (void) addSubMenultem: (MAAccordionMenultem *)  menultem

Adds submenu item to the menu item.
Parameters:
menultem Submenu item.

- (void) setTouchDownlInsideDelegate: (id) target

theAction: (SEL) action

Sets delegate for the touchdown inside event.
Parameters:

target Target object.

action Target method.

- (void) setTouchUplInsideDelegate: (id) target

theAction: (SEL) action

Sets delegate for the touch-up inside event.
Parameters:
target Target object.

action Target method.

Property Documentation

- (BOOL) header [read, write, assign]

Is the menu item header.

- (MAAccordionMenultem*) parent [read, write, retain]

Parent menu item.
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- (NSMutableArray*) subMenultems [read, write, retain]

Submenu items in the menu.

MAAnalyticChartView

A chart view with analytic capabilities, having its datasource defined by a metadata file.

Inherits <MAChartViewDelegate>, <MAChartViewDataSource>, and <MAChartDataModel>.

Public Member Functions

(void)
(void)
(void)
(void)
(void)
(BOOL)
(void)
(void)

(CGPoint)

Properties

NSString *

NSMutableDictionary *

id< MAQueryDelegate >

id< MAAnalyticChartViewDelegate >

id< MAChartTheme,
MADashboardTheme >

id< MAErrorHandlingDelegate >
NSString *

MARangeSelectorBehavior

- reloadData:

- reloadDataSync:

- setNeedsDisplay:
-drillUpToLevel:

- changeHierarchyLevel:
- toggleWhatlfPanel

- toggleTable

- sharedByEmail:

- pointForDataAtIindex:

metaDataPath
metaDict
dataSource

delegate

theme
errorHandler
identifier

contentRangeSelectorBehavior
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MAHierarchialCategoryLabelDisplay hierarchicalCategoryLabelDisplay

BOOL isThumbnailMode

BOOL isTitleHidden

BOOL isLegendHidden

BOOL showsHorizontal AxisTitle
BOOL showsVerticalAxisTitle
BOOL showsHorizontal Axis
BOOL showsVerticalAxis

BOOL showsSeriesLabels
BOOL showsSelectedDatal abel
BOOL showsGridLabel

BOOL showsXAxisAtTop
UlEdgelnsets chartViewEdgelnsets
CGFloat rowHeight

CGFloat rowSpacing

BOOL horizontalZoomEnabled
BOOL verticalZoomEnabled
NSUinteger chartType

NSUinteger drillDownPathLevelCount
NSUInteger currentLevellnDrillDownPath
NSArray * drillDownPathTitles
NSUInteger categoryHierarchyCount
NSUInteger currentLevellnCategoryHierarchy
NSArray * categoryHierarchyTitles
BOOL hasWhatlfScenario

BOOL isDataGridChart
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Member Function Documentation

- (void) changeHierarchylLevel: (NSUinteger) level

Changes hierarchy level in chart (zoom in/zoom out).
Call this method to change hierarchy level, if applicable. If level is invalid, there will be no changes.
Parameters:

level The number specifying the hierarchy level.

- (void) drillUpToLevel: (NSUInteger) level

Drills up to the specified level in chart.
Call this method to drill up one level (return to the previous level) in the drilldown path, if applicable.
Parameters:

level The number specifying the level to drill up to.

- (CGPoint) pointForDataAtindex: (NSUInteger) dataltemIndex

Returns the point in the chart view coordinate system for a data identified by its data item index.
Parameters:
dataltemIndex An index corresponding to a data item.

- (void) reloadData: (BOOL) animated

Asynchronously reloads data of the chart view.

Call this method to reload data from the datasource in an asynchronous thread and reconstruct the chart view, including
subviews and sublayers.

- (void) reloadDataSync: (BOOL) animated

Synchronously reloads data of the chart view.

Call this method to reload data from the datasource and reconstruct the chart view, including subviews and sublayers.

- (void) setNeedsDisplay: (BOOL) animated

Redraws the chart view.

Call this method to redraw the chart view.
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Parameters:
animated If Yes, animates the view as redrawn; otherwise, does not.

- (void) sharedByEmail: (UlViewController *)  controller

Show e-mail panel with the chart picture.
Parameters:
controller The current view controller.

- (BOOL) toggleWhatlfPanel

Toggles what-if panel between show and hidden states, if applicable.
No panel is shown if there is no what-if scenario defined in the metadata file.

Returns:

A Boolean value indicating the visibility of the what-if panel after the toggle is done.

Property Documentation

- (NSUInteger) categoryHierarchyCount [read, assign]

Count of category hierarchies (for example, semantic zooming, treemap category grouping) of the chart view in the current
drilldown level; if no semantic zooming defined, returns 1.

- (NSArray*) categoryHierarchyTitles [read, assign]

Category titles for all cateogry hierarchy levels of the current chart view. An array of string instances.

- (NSUInteger) chartType [read, assign]

Chart type of the chart view.

- (UIEdgelnsets) chartViewEdgelnsets [read, write, assign]

Edge insets (padding) around chart view.

- (MARangeSelectorBehavior) contentRangeSelectorBehavior [read, write, assign]

A value that determines whether the analytic chart view supports content range selection.
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The default is MARangeSelectorBehaviourAuto.

- (NSUInteger) currentLevellnCategoryHierarchy [read, assign]

Current level index in the category hierarchy of the chart view. Bottom level (most detailed level) == 0.

- (NSUInteger) currentLevellnDrillDownPath [read, assign]

Current level index in the drilldown path. Top level == 0.

- (id<MAQueryDelegate>) dataSource [read, write, retain]

The object that acts as the datasource of the receiving analytic chart view.

- (id<MAAnalyticChartViewDelegate>) delegate [read, write, assign]

The object that acts as the delegate of the receiving analytic chart view.

- (NSUInteger) drillDownPathLevelCount [read, assign]

Total level counts in the drilldown path, including the top level chart. If no drilldown defined, returns 1.

- (NSArray*) drillDownPathTitles [read, assign]

Drilldown path titles of the current chart view. An array of string instances.

- (id<MAErrorHandlingDelegate>) errorHandler [read, write, retain]

The object that acts as the error handler of the receiving analytic chart view.

- (BOOL) hasWhatlfScenario [read, assign]

Returns a Boolean value that determines whether chart view includes a what-if scenario.

- (MAHierarchialCategoryLabelDisplay) hierarchicalCategorylLabelDisplay [read, write, assign]

A value that determines the display of labels for multiple category levels.

Default is MAHierarchialCategoryLabelDisplayTopLevel.

- (BOOL) horizontalZoomEnabled [read, write, assign]
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A Boolean value that determines whether horizontal zoom is enabled.

Default is YES.

- (NSsString*) identifier [read, write, copy]

A string serves as the identifier to the chart view, if necessary.

- (BOOL) isDataGridChart [read, assign]

Returns a Boolean value that determines whether chart is a datagrid type.

- (BOOL) isLegendHidden [read, write, assign]

A Boolean value that determines whether chart legend view is hidden.

The default value depends on the chart type. The legend is shown only if it is applicable for the specified chart type and
there are multiple series.

- (BOOL) isThumbnailMode [read, write, assign]

A Boolean value that determines whether chart view is in thumbnail mode.

The default is NO.

- (BOOL) isTitleHidden [read, write, assign]

A Boolean value that determines whether chart view title is hidden.

The default is NO.

- (NSString*) metaDataPath [read, write, copy]

Metadata file path.

- (NSMutableDictionary*) metaDict [read, write, retain]

A dictionary of metadata definition.

- (CGFloat) rowHeight [read, write, assign]

A value that determines the height of each row in bar/horizontal bullet chart.
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- (CGFloat) rowSpacing [read, write, assign]

A value that determines the spacing of each row in bar/horizontal bullet chart.

- (BOOL) showsGridLabel [read, write, assign]

A Boolean value that controls whether the grid line labels should be shown.

The default value is YES. The axis is shown only if it is applicable for the specified chart type. A layout event is triggered
after setting this property.

- (BOOL) showsHorizontalAxis [read, write, assign]

A Boolean value that controls whether the horizontal axis with labels and tick marks should be shown.

The default value is YES. The axis is only shown if it is applicable for the specified chart type. A layout event is triggered
after setting this property.

- (BOOL) showsHorizontalAxisTitle [read, write, assign]

A Boolean value that controls whether the horizontal axis title should be shown.

The default value is NO. The axis title is shown only if it is applicable for the specified chart type, and the datasource
implements the related title retrieval method. A layout event is triggered after setting this property.

- (BOOL) showsSelectedDataLabel [read, write, assign]

A Boolean value that controls whether the label of the selected data should be shown.

The default value is YES. The data label is shown only if it is applicable for the specified chart type. A layout event is
triggered after setting this property.

- (BOOL) showsSeriesLabels [read, write, assign]

A Boolean value that controls whether the series labels should be shown.

The default value is YES. Series labels are applicable only to pie charts. A layout event is triggered after setting this property.

- (BOOL) showsVerticalAxis [read, write, assign]

A Boolean value that controls whether to show the vertical axis with labels and tick marks.

The default value is YES. The axis is shown only if it is applicable for the specified chart type. A layout event is triggered
after setting this property.

111





MAKit Developer Guide: iOS 2013

- (BOOL) showsVerticalAxisTitle [read, write, assign]

A Boolean value that controls whether to show the vertical axis title.

The default value is NO. The axis title is shown only if it is applicable for the specified chart type, and the datasource
implements the related title retrieval method. A layout event is triggered after setting this property.

- (BOOL) showsXAxisAtTop [read, write, assign]

A Boolean value that controls whether to display the x-axis at top or bottom, for certain types of charts.

The default value is YES. The x-axis appears at top of the chart.

- (id<MAChartTheme, MADashboardTheme>) theme [read, write, retain]

The object that provides the theme of the receiving analytic chart view.

- (BOOL) verticalZoomEnabled [read, write, assign]

A Boolean value that determines whether vertical zoom is enabled.

Default is NO.

MAAnalyticChartViewController

A view controller for analytic chart view.

Inherits <MAAnalyticChartViewDelegate>.

Public Member Functions

(id) - initWithAnalyticChartView:
(IBAction) - reloadData
(IBAction) - openDataTable
(IBAction) - openWhatlfPanel
(IBAction) - shareByMail

Properties
MAAnalyticChartView * chartView
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UlToolbar * toolbar

id< MAErrorHandlingDelegate > errorHandler

Member Function Documentation

- (id) initWithAnalyticChartView: (MAAnalyticChartView *)  chartView

Initializes an analytic chart view controller to manage an analytic chart view.
Parameters:
chartView The analytic chart view that the controller is to manage.

Returns:

An initialized controller object, or nil if the object cannot be created.

Property Documentation

- (MAAnalyticChartView*) chartView [read, write, retain]

Returns the analytic chart view managed by the controller object.

- (id<MAErrorHandlingDelegate>) errorHandler [read, write, retain]

The object that acts as the error handler of the receiving analytic chart view.

- (UIToolbar*) toolbar [read, write, retain]

Returns the toolbar managed by the controller object.

MAAnalyticChartViewDelegate

Protocol of analytic chart view delegate.

Inherited by MAAnalyticChartViewController.

Public Member Functions

(void) - didRefreshInChartView:

(void) - didChangeDrillDownLevellnChartView:toLevel:fromCategory:
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(void) - didClickEmbeddedChart:
(BOOL) -willSelectltems:
(void) - chartView:didSelectltems:
Member Function Documentation
- (void) chartView: (MAAnalyticChartView *)  chartView
didSelectltems: (MAChartSelection *) selection
[optional]
Informs the receiver that multiple items have been selected.
Parameters:
chartView An object representing the chart view requesting this information.
selection An object representing the selected items.
- (void) didChangeDrillDownLevellnChartView: (MAAnalyticChartView *)  chartView
toLevel: (NSUInteger) level
fromCategory: (NSUInteger) category
[optional]
Notifies the delegate that the the drilldown level has been changed (drilldown/drillup) in the chart view.
Parameters:
chartView The analytic chart view object informing the delegate of this event.
level A number indicating the new drilling level.
category The category index of the previous drilling level.
- (void) didClickEmbeddedChart: (MAChartViewController *)  miniChartController [optional]

Notifies the delegate to show embedded chart in the MAChartViewController.
Parameters:
miniChartController Contains the selected embedded chart.

- (void) didRefreshInChartView: (MAAnalyticChartView *)  chartView [optional]
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Notifies the delegate that the chart view has been refreshed.
Parameters:
chartView The analytic chart view object informing the delegate of this event.

- (BOOL) willSelectltems: (MAAnalyticChartView *)  chartView [optional]

Queries the receiver whether multiple items selection should be enabled.
Parameters:
chartView An object representing the chart view requesting this information.

Returns:

YES to enable mutiple items selection; NO otherwise.

MAAnimatorDelegate

Protocol of animators.

This protocol defines methods and properties to be implemented by an animator. An animator is responsible for returning a
CAAnimation, which is applied onto the Ul elements inside MAKit. It provides users with a way to customize the animation
effect. Users may implement this protocol to create their own animations.

Public Member Functions

(CAAnimation *) - getAnimationWithLayer:andDuration:

Member Function Documentation

- (CAAnimation*) getAnimationWithLayer: (CALayer *)  layer
andDuration: (float) duration
[required]

Returns the animation.

Parameters:
layer Layer to which animation is applicable.
duration Animation duration.

Returns:

A CAAnimation for the specified layer.
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MACartesianChartPainter

Protocol of Cartesian chart painter.
This protocol defines additional methods and properties to be implemented by a Cartesian chart type base painter.

Inherited by MAXValueCartesianChartBasePainter.

Public Member Functions

(BOOL) - hasHorizontal AxisTitle
(UlFont *) - horizontalAxisLabelFont
(UIColor *) - horizontalAxisLabelColor
(NSString *) - horizontal AxisTitle
(BOOL) - hasVerticalAxisTitle
(UlFont *) - verticalAxisLabelFont
(UlColor *) - verticalAxisLabelColor
(NSString *) - vertical AxisTitle
Properties

MACartesianRenderModel * cartesianRenderModel

Member Function Documentation

- (BOOL) hasHorizontal AxisTitle

A Boolean value that determines whether the Cartesian chart has a horizontal axis title.

- (BOOL) hasVerticalAxisTitle

A Boolean value that determines whether the Cartesian chart has a vertical axis title.

- (UIColor*) horizontal AxisLabelColor

The color of the horizontal axis label.

- (UIFont*) horizontalAxisLabelFont
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The font of the horizontal axis label.

- (NSString*) horizontal AxisTitle

The text of the horizontal axis title.

- (UIColor*) verticalAxisLabelColor

The color of the vertical axis label.

- (UIFont*) verticalAxisLabelFont

The font of the vertical axis label.

- (NSString*) vertical AxisTitle

The text of the vertical axis title.

Property Documentation

- (MACartesianRenderModel*) cartesianRenderModel [read, write, required, retain]

The Cartesian render model.

MAChartBasePainter

Protocol of chart base painter.

This protocol defines methods and properties implemented by a chart base painter. A chart base painter is responsible for
painting the chart’s basic infrastructures, such as background, axes, and labels.

Inherited by MATabularCategoryChartBasePainter, and MAXValueCartesianChartBasePainter.

Public Member Functions

(CGPaint) - plotAreaBaselLayerAnchorPoint

(CGPoint) - plotAreaBaselLayerPositionWithPlotAreaBounds:
(BOOL) - enableLeftArea

(BOOL) - enableRightArea

(BOOL) - enableTopArea
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(BOOL) - enableBottomArea

(BOOL) - enableTopLeftArea

(BOOL) - enableTopRightArea

(BOOL) - enableBottomLeftArea

(BOOL) - enableBottomRightArea

(BOOL) - enableLegend

(CGFloat) - leftAreaWidth

(CGFloat) - leftAreaWidthWithChartAreaBoundSize:
(CGFloat) - rightAreaWidth

(CGFloat) - topAreaHeight

(CGFloat) - bottomAreaHeight

(UlView *) - leftAreaViewForCategoryAtindex:

(UlView *) - topLeftAreaView

(void) - drawLeftArealnContext:withBounds:
(void) - drawRightArealnContext:withBounds:
(void) - drawTopArealnContext:withBounds:
(void) - drawBottomArealnContext:withBounds:
(void) - drawTopLeftArealnContext:withBounds:
(void) - drawTopRightArealnContext:withBounds:
(void) - drawBottomLeftArealnContext:withBounds:
(void) - drawBottomRightArealnContext:withBounds:
(void) - drawPlotArealnContext:withBounds:
(CGFloat) - leftSpacing

(CGFloat) - rightSpacing

(CGFloat) - topSpacing

(CGFloat) - bottomSpacing

(void) - setupAccessoryView:

(void) - layoutAccessoryView:
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(void) - willRefresh

(CGSize) - defaultPlotAreaContentSizeWithPlotAreaBoundSize:
(CGSize) - maxPlotAreaContentSizeWithPlotAreaBoundSize:
(CGSize) - minPlotAreaContentSizeWithPlotAreaBoundSize:
(CGRect) - contentSizeAndOffsetWithPlotAreaBoundSize:showingCategoryRange:
(void) - didUpdatePlotAreaContentSize:

(void) - didUpdatePlotAreaContentOffset:

(void) - didUpdateSelectedCategory

(BOOL) - requiresHorizontalRangeSelector

(BOOL) - requiresVerticalRangeSelector

(BOOL) - showsScrollindicators

(BOOL) - allowTouchScrolling

(void) - plotAreaScrollViewDidLoad:

(void) - plotAreaContentViewDidLoad:

(void) - topAreaScrollViewDidLoad:

(void) - bottomAreaScrollViewDidLoad:

(void) - leftAreaScrollViewDidLoad:

(void) - rightAreaScrollViewDidLoad:

(void) - topAreaContentViewDidLoad:

(void) - bottomAreaContentViewDidLoad:

(void) - leftAreaContentViewDidLoad:

(void) - rightAreaContentViewDidLoad:

(void) - topLeftAreaContentViewDidLoad:

(void) - topRightAreaContentViewDidLoad:

(void) - bottomLeftAreaContentViewDidLoad:

(void) - bottomRightAreaContentViewDidLoad:

(CGRect) - itemsRectForPlotContentRect:

(MAChartSelection *) - getltemsInPlotContentRect:
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(void) - handlePlotAreaSingleTapGesture:
(BOOL) - handlePlotAreaDoubleTapGesture:
(void) - highlightCategory

Properties
MAChartView * chart

Member Function Documentation

- (BOOL) allowTouchScrolling [optional]

Tells the receiver whether touch scrolling is allowed in chart content view.
If the method is not implemented, assume it returns NO.

Returns:

A Boolean value.

- (void) bottomAreaContentViewDidLoad: (UlView *)  view [optional]

Tells the receiver when the bottom area content view is loaded. This method is most commonly used to perform additional
initialization steps on the bottom area view, for example, to modify gesture recognizers, and create drawing layers.

Parameters:
view A UlView representing the bottom area content view.

- (CGFloat) bottomAreaHeight [optional]

Method to define the bottom area height of the chart, if the bottom area is enabled.

Returns:

Height of the area; default 0.

- (void) bottomAreaScrollViewDidLoad: (UiScrollView *)  view [optional]

Tells the receiver when the bottom area scroll view is loaded. This method is most commonly used to perform additional
initialization steps on the bottom area scroll view, for example, to modify gesture recognizers, and create drawing layers.

Parameters:

view A UlScrollView representing the parent view of the bottom area content view.
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- (void) bottomLeftAreaContentViewDidLoad: (Ulview *)  view [optional]

Tells the receiver when the bottom left area content view is loaded. This method is most commonly used to perform
additional initialization steps on the bottom left area view, for example, to modify gesture recognizers, and create drawing
layers.

Parameters:
view A UlView representing the bottom left area content view.

- (void) bottomRightAreaContentViewDidLoad: (UlView *)  view [optional]

Tells the receiver when the bottom right area content view is loaded. This method is most commonly used to perform
additional initialization steps on the bottom right area view, for example, to modify gesture recognizers, and create drawing
layers.

Parameters:
view A UlView representing the bottom right area content view.

- (CGFloat) bottomSpacing [optional]

Method to define the spacing to the bottom of the chart.

Returns:

Width of the spacing; default 0.

- (CGRect) contentSizeAndOffsetWithPlotAreaBoundSize: (CGSize) boundSize
showingCategoryRange: (NSUlinteger) categoryRange
[optional]

Returns the plot area content size and content offset based on the given bound size, given that the specified category range
is to be visible.

Parameters:
boundSize Bound size of the plot area.
categoryRange Category indexes range to be shown within the plot area bounds size.

Returns:

Content size and offset of the plot area. If not implemented, the default behavior is that the content size is the same as the
plot bound size, with zero offset.
- (CGSize) defaultPlotAreaContentSizeWithPlotAreaBoundSize: (CGSize) boundSize [optionall]

Returns the default plot area content size based on the given bound size.
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Parameters:

boundSize Bound size of the plot area.

Returns:

Content size of the plot area.

- (void) didUpdatePlotAreaContentOffset: (CGPoint) contentOffset [optional]

Tells the receiver when plot area content offset has been updated.
Parameters:
contentOffset Content offset of the plot area.

- (void) didUpdatePlotAreaContentSize: (CGSize) contentSize

Tells the receiver when plot area content size has been updated.
Use to update the rendering model if needed.
Parameters:

contentSize Content size of the plot area.

- (void) didUpdateSelectedCategory [optional]

Tells the receiver when selected category has been updated.

- (void) drawBottomArealnContext: (CGContextRef)  context

withBounds: (CGRect) bounds

[optional]

[optional]

Method to draw contents in the bottom area, if the bottom area is enabled.
Parameters:
context A core graphics context reference.

bounds Bounds of the drawing area.

- (void) drawBottomLeftArealnContext: (CGContextRef) context

withBounds: (CGRect) bounds
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[optional]

Method to draw contents in the bottom left area, if the bottom left area is enabled.
Parameters:
context A core graphics context reference.

bounds Bounds of the drawing area.

- (void) drawBottomRightArealnContext: (CGContextRef)  context
withBounds: (CGRect) bounds
[optional]

Method to draw contents in the bottom right area, if the bottom right area is enabled.
Parameters:
context A core graphics context reference.

bounds Bounds of the drawing area.

- (void) drawLeftArealnContext: (CGContextRef)  context
withBounds: (CGRect) bounds
[optional]

Method to draw contents in the left area, if the left area is enabled.
Parameters:
context A core graphics context reference.

bounds Bounds of the drawing area.

- (void) drawPlotArealnContext: (CGContextRef)  context
withBounds: (CGRect) bounds
[optional]

Method to draw contents in the plot area.
Parameters:

context A core graphics context reference.
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bounds Bounds of the drawing area.

- (void) drawRightArealnContext: (CGContextRef)  context
withBounds: (CGRect) bounds
[optional]

Method to draw contents in the right area, if the right area is enabled.
Parameters:
context A core graphics context reference.

bounds Bounds of the drawing area.

- (void) drawTopArealnContext: (CGContextRef)  context
withBounds: (CGRect) bounds
[optional]

Method to draw contents in the top area, if the top area is enabled.
Parameters:
context A core graphics context reference.

bounds Bounds of the drawing area.

- (void) drawTopLeftArealnContext: (CGContextRef)  context
withBounds: (CGRect) bounds
[optional]

Method to draw contents in the top left area, if the top left area is enabled.
Parameters:
context A core graphics context reference.

bounds Bounds of the drawing area.

- (void) drawTopRightArealnContext: (CGContextRef)  context
withBounds: (CGRect) bounds
[optional]

Method to draw contents in the top right area, if the top right area is enabled.
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Parameters:
context A core graphics context reference.
bounds Bounds of the drawing area.

- (BOOL) enableBottomArea [optional]

Asks if bottom area of the chart is enabled.

Returns:

A Boolean value; default NO.

- (BOOL) enableBottomLeftArea [optional]

Asks if bottom left area of the chart is enabled.

Returns:

A Boolean value; default NO.

- (BOOL) enableBottomRightArea [optional]

Asks if bottom right area of the chart is enabled.

Returns:

A Boolean value; default NO.

- (BOOL) enableLeftArea [optional]

Asks if left area of the chart is enabled.

Returns:

A Boolean value; default NO.

- (BOOL) enableLegend [optional]

Asks if legend is enabled.

Returns:

A Boolean value; default NO.

- (BOOL) enableRightArea [optional]

Asks if right area of the chart is enabled.

Returns:
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A Boolean value; default NO.
- (BOOL) enableTopArea [optional]
Asks if top area of the chart is enabled.
Returns:
A Boolean value; default NO.
- (BOOL) enableTopLeftArea [optional]
Asks if top left area of the chart is enabled.
Returns:
A Boolean value; default NO.
- (BOOL) enableTopRightArea [optional]
Asks if top right area of the chart is enabled.
Returns:
A Boolean value; default NO.
- (MAChartSelection*) getltemsinPlotContentRect: (CGRect) rect [optional]
Tells the receiver to return the data items within the rectangular region.
Parameters:
rect A CGRect in plot content view coordinates.
Returns:
A chart selection indicating the data items.
- (BOOL) handlePlotAreaDoubleTapGesture: (UlGestureRecognizer *)  gestureRecognizer [optional]
Tells the receiver to handle the double-tap gesture.
Parameters:
gestureRecognizer An instance of a subclass of UlTapGestureRecognizer.
Returns:
YES if the gesture is successfully handled.
- (void) handlePlotAreaSingleTapGesture: (UlGestureRecognizer *)  gestureRecognizer [optional]
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Tells the receiver to handle the single-tap gesture.
Parameters:
gestureRecognizer An instance of a subclass of UlTapGestureRecognizer.

- (void) highlightCategory [optional]

Highlights category.

- (CGRect) itemsRectForPlotContentRect: (CGRect) rect [optional]

Tells the receiver to return the rectangle occupied by the data items given the rectangle of the plot content view.
Parameters:
rect A CGRect in plot content view coordinates.

Returns:

A CGRect occupied by the data items.

- (void) layoutAccessoryView: (UlView *)  accessoryView [optional]

Method for the receiver to lay out the contents in the accessory view.
Parameters:
accessoryView The accessory view.

- (void) leftAreaContentViewDidLoad: (UlView *)  view [optional]

Tells the receiver when the left area content view is loaded. This method is most commonly used to perform additional
initialization steps on the left area view, for example, to modify gesture recognizers, and create drawing layers.

Parameters:
view A UlView representing the left area content view.

- (void) leftAreaScrollViewDidLoad: (Uiscrollview *)  view [optional]

Tells the receiver when the left area scroll view is loaded. This method is most commonly used to perform additional
initialization steps on the left area scroll view, for example, modify gesture recognizers, and create drawing layers.

Parameters:
view A UlScrollView representing the parent view of the left area content view.

- (UIView*) leftAreaViewForCategoryAtindex: (NSUInteger) categorylndex [optional]
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Returns the view to be drawn at the left area at the specified category index.
Parameters:
categorylndex Category index.

- (CGFloat) leftAreawidth [optional]

Method to define the left area width of the chart, if the left area is enabled.

Returns:

Width of the area; default 0.

- (CGFloat) leftAreaWidthWithChartAreaBoundSize: (CGSize) boundSize [optional]

Method to define the left area width of the chart, if the left area is enabled.
Parameters:

boundSize Bounds size of the chart area, which includes the plot area, as well as top, bottom, left, and right
areas. It does not include the value bubble, range selector, legend, and title regions.

Returns:

Width of the area; default O.

- (CGFloat) leftSpacing [optional]

Method to define the spacing to the left of the chart.

Returns:

Width of the spacing; default 0.

- (CGSize) maxPlotAreaContentSizeWithPlotAreaBoundSize: (CGSize) boundSize [optional]

Returns the maximum plot area content size based on the given bound size.
Parameters:
boundSize Bound size of the plot area.

Returns:

Content size of the plot area. If not implemented, the default behavior is that the content size is the same as the plot bound
size.

- (CGSize) minPlotAreaContentSizeWithPlotAreaBoundSize: (CGSize) boundSize [optional]

Returns the minimum plot area content size, based on the given bound size.

128





MAKit Developer Guide: iOS 2013

Parameters:
boundSize Bound size of the plot area.

Returns:

Content size of the plot area. If not implemented, the default behavior is that the content size is the same as the plot bound
size.

- (CGPoint) plotAreaBaselLayerAnchorPoint [optional]

Anchor point of plot area layer.

- (CGPoint) plotAreaBaselLayerPositionWithPlotAreaBounds: (CGRect) bounds [optional]

Returns the origin of plot area layer given the bounds.
Parameters:
bounds Plot area bounds.

Returns:

The point indicating the origin of a layer.

- (void) plotAreaContentViewDidLoad: (Ulview *)  view [optional]

Tells the receiver when the plot area content view is loaded. This method is most commonly used to perform additional
initialization steps on the plot area view, for example, modify gesture recognizers, and create drawing layers.

Parameters:
view A UlView representing the plot area view.

- (void) plotAreaScrollViewDidLoad: (UlScrollView *)  view [optional]

Tells the receiver whether there is individual unique animation for each series.
If the method is not implemented, assume it returns NO.

Returns:

A Boolean value indicating series animation.

Tells the receiver when the plot area scroll view is loaded. This method is most commonly used to perform additional
initialization steps on the plot area scroll view, for example, modify gesture recognizers, and create drawing layers.

Parameters:

view A UlScrollView representing the parent view of the plot area content view.
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- (BOOL) requiresHorizontalRangeSelector [optional]

Tells the receiver whether the horizontal content scope picker is needed.
If the method is not implemented, assume it returns NO.

Returns:

A Boolean value indicating if the horizontal scope picker is needed.

- (BOOL) requiresVerticalRangeSelector [optional]

Tells the receiver whether the vertical content scope picker is needed.
If the method is not implemented, assume it returns NO.

Returns:

A Boolean value indicating if the vertical scope picker is needed.

- (void) rightAreaContentViewDidLoad: (UlView *)  view [optional]

Tells the receiver when the right area content view is loaded. This method is most commonly used to perform additional
initialization steps on the right area view, for example, modify gesture recognizers, and create drawing layers.

Parameters:
view A UlView representing the right area content view.

- (void) rightAreaScrollViewDidLoad: (UlscrollView *)  view [optional]

Tells the receiver when the right area scroll view is loaded. This method is most commonly used to perform additional
initialization steps on the right area scroll view, for example, modify gesture recognizers, and create drawing layers.

Parameters:
view A UlScrollView representing the parent view of the right area content view.

- (CGFloat) rightAreaWidth [optional]

Method to define the right area width of the chart, if the right area is enabled.

Returns:

Width of the area; default 0.

- (CGFloat) rightSpacing [optional]

Method to define the spacing after the right of the chart.
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Returns:

Width of the spacing; default O.

- (void) setupAccessoryView: (UlView *)  accessoryView [optional]

Method for the receiver to set up the contents in the accessory view.
Parameters:
accessoryView The accessory view.

- (BOOL) showsScrollindicators [optional]

Tells the receiver whether to show scroll indicators.
If the method is not implemented, assume it returns NO.

Returns:

A Boolean value indicating whether to show scroll indicators.

- (void) topAreaContentViewDidLoad: (UlView *)  view [optional]

Tells the receiver when the top area content view is loaded. This method is most commonly used to perform additional
initialization steps on the top area view, for example, modify gesture recognizers, and create drawing layers.

Parameters:
view A UlView representing the top area content view.

- (CGFloat) topAreaHeight [optional]

Method to define the top area height of the chart, if the top area is enabled.

Returns:

Height of the area; default 0.

- (void) topAreaScrollViewDidLoad: (UiScrollView *)  view [optional]

Tells the receiver when the top area scroll view is loaded. This method is most commonly used to perform additional
initialization steps on the top area scroll view, for example, modify gesture recognizers, and create drawing layers.

Parameters:
view A UlScrollView representing the parent view of the top area content view.

- (void) topLeftAreaContentViewDidLoad: (UlView *)  view [optional]
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Tells the receiver when the top left area content view is loaded. This method is most commonly used to perform additional
initialization steps on the top left area view, for example, modify gesture recognizers, and create drawing layers.

Parameters:
view A UlView representing the top left area content view.

- (UIView*) topLeftAreaView [optional]

Returns the view to be drawn at the top left area.

- (void) topRightAreaContentViewDidLoad: (UlView *)  view [optional]

Tells the receiver when the top right area content view is loaded. This method is most commonly used to perform additional
initialization steps on the top right area view, for example, modify gesture recognizers, and create drawing layers.

Parameters:
view A UlView representing the top right area content view.

- (CGFloat) topSpacing [optional]

Method to define the spacing to the top of the chart.

Returns:

Width of the spacing; default 0.

- (void) willRefresh [optional]

Tells the receiver when chart content is about to refresh.

Update the painter properties if needed.

Property Documentation

- (MAChartView*) chart [read, write, required, assign]

A chart reference.

MAChartDataModel

Protocol of chart data model.

Inherited by MAAnalyticChartView, and MAChartView.

132





MAKit Developer Guide: iOS

2013

Public Member Functions

(NSUlInteger)
(NSUlInteger)
(NSUinteger)
(id)

(id)
(NSString *)
(NSString *)
(BOOL)
(NSUinteger)
(NSUinteger)
(NSUlInteger)
(NSUlInteger)
(NSUlInteger)
(id)
(NSString *)
(NSString *)
(NSFormatter *)
(NSUinteger)
(id)

(id)
(NSString *)
(NSFormatter *)
(NSString *)
(NSString *)
(float)

(float)

- categoryLevelCount

- categoryCount

- categoryCountinLevel:

- categoryAtindex:

- categoryAtindex:inCategoryLevel:

- categoryTitle

- categoryTitleForCategoryLevel:

- isCategorylInterpretedAsValue

- indexOfFirstSubCategoryForCategory:inCategoryLevel:

- indexOfLastSubCategoryForCategory:inCategoryLevel:

- indexOfFirstLevelZeroSubCategoryForCategory:inCategoryLevel:
- indexOfLastLevelZeroSubCategoryForCategory:inCategoryLevel:
- seriesCount

- seriesAtindex:

- seriesTitle

- seriesTitleForCategoryLevel:

- seriesFormatter

- numberOfValueDimensions

- valueOfCategory:andSeries:

- valueAtDimension:ofCategory:inCategoryLevel:andSeries:

- formattedStringFromValueAtDimension:ofCategory:inCategoryLevel:andSeries:
- formatterForValueAtDimension:

- valueTitleAtDimension:

- valueTitleAtDimension:inCategoryLevellndex:

- maxValueOfLayer:andValueDimension:

- minValueOfLayer:andValueDimension:
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(float)

(float)
(NSUinteger)
(NSUlInteger)
(NSUlInteger)
(NSUInteger)
(id)

(NSArray *)

(NSDictionary *)

(void)
(void)

(void)

(void)

(void)

(void)
(BOOL)
(BOOL)
(BOOL)
(BOOL)
(NSUinteger)
(NSUinteger)
(void)

(void)

(void)
(BOOL)
(NSUInteger)
(NSinteger)

(void)

- maxSumValueOfLayer:andValueDimension:

- minSumValueOfLayer:andValueDimension:

- dataltemCount
- dataltemCountForSeries:
- categoryIlndexOfDataltem:

- seriesindexOfDataltem:

- valueAtDimension:ofDataltem:

- dataltemsAtCategory:

- getChartExtraProperties

- selectCategoryAtindex:

- deselectCategoryAtindex:
- selectSeriesAtindex:

- deselectSeriesAtindex:

- selectDataltemAtindex:ofGlobalSeriesIndex:

- deselectDataltemAtindex:ofGlobalSeriesindex:

- isCategorySelectedAtindex:

- isSeriesSelectedAtGloballndexForAllChartLayers:
- isDataltemSelectedAtindex:ofGlobalSeriesindex:

- isDataltemInFocusAtindex:ofGlobalSeriesIndex:

- numberOfSelectedCategories
- numberOfSelectedSeries

- clearAllCategorySelections

- clearAllSeriesSelections

- clearAllSelections

- isinFocusAtCategoryIndex:ofGlobalSeriesIindex:

- highlightCategoryIndex
- indexOfFirstSelectedSeries

- setHighlightCategoryIndex:
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(UIColor *) - contentColorForSeries:
(UIColor *) - borderColorForSeries:
(void) - setContentColor:forSeries:
(void) - setBorderColor:forSeries:
(UlColor *) - contentColorForCategory:andSeries:
(UIColor *) - borderColorForCategory:andSeries:
(void) - setContentColor:forCategory:andSeries:
(void) - setBorderColor:forCategory:andSeries:
(void) - resetAllColors
(void) - sortValues:byOrder:
(void) - sortValues:
(void) - sortSeries:

Properties

NSFormatter * categoryFormatter

Member Function Documentation
- (UIColor *) borderColorForCategory: (NSUInteger) categorylndex

andSeries: (NSUlInteger) globalSeriesindex

Get the border color for a category-series combination.
Parameters:

categorylndex An index corresponding to a category.

globalSeriesindex An index corresponding to a series based on all chart layers.

Returns:

The color object.

- (UIColor *) borderColorForSeries: (NSUiInteger) globalSeriesindex

Gets the border color for a series.

Parameters:
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globalSeriesindex An index corresponding to a series based on all chart layers.

Returns:

The color object.

- (id) categoryAtindex: (NSUinteger) categorylndex [required]

Gets the category at a specified index in category level 0.
Parameters:
categorylndex An index corresponding to a category.

Returns:

The category object.

- (id) categoryAtindex: (NSUlinteger) categorylndex
inCategoryLevel: (NSUinteger) categorylLevellndex
[required]

Gets the category at a specified index in a specified category level.
Parameters:
categorylndex An index corresponding to a category.
categoryLevellndex An index corresponding to a category level.

Returns:

The category object.

- (NSUInteger) categoryCount [required]

Gets the number of categories for category level 0.

Returns:

The category count.

- (NSUInteger) categoryCountinLevel: (NSUlInteger) categorylLevelindex [required]

Gets the number of categories for a specified category level.

Returns:

The category count.
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- (NSUInteger) categorylndexOfDataltem: (NSUinteger) dataltemIndex

Gets the category index of the specified data item.
Parameters:
dataltemIndex An index corresponding to a data item.

Returns:

The category index.

- (NSUInteger) categoryLevelCount [required]

Gets the number of category levels.

Returns:

The category level count.

- (NSString*) categoryTitle [required]

Gets the title of category for category level 0, which can be used for axis labelling and table headers.

Returns:

The label.

- (NSString*) categoryTitleForCategoryLevel: (NSUlInteger) categoryLevellndex [required]

Gets the title of category for a specified category level, which can be used for axis labelling and table headers.
Parameters:

categoryLevellndex An index corresponding to a category level.

Returns:

The label.

- (UIColor *) contentColorForCategory: (NSUinteger) categorylndex
andSeries: (NSUinteger) globalSeriesindex

Get the content color for a category-series combination.
Parameters:
categorylndex An index corresponding to a category.

globalSeriesIndex An index corresponding to a series based on all chart layers.

137





MAKit Developer Guide: iOS 2013

Returns:

The color object.

- (UIColor *) contentColorForSeries: (NSUlinteger) globalSeriesindex

Get the content color for a series.
Parameters:
globalSeriesindex An index corresponding to a series based on all chart layers.

Returns:

The color object.

- (NSUInteger) dataltemCount

Gets the number of data items.

Returns:

The data item count.

- (NSUInteger) dataltemCountForSeries: (NSUinteger) globalSeriesindex

Gets the number of data items at a specified series.
Parameters:
globalSeriesindex An index corresponding to a series based on all chart layers.

Returns:

The data item count in the series.

- (NSArray*) dataltemsAtCategory: (NSUinteger) categorylndex

Gets the array of data item indexes corresponding to the specified category index.
Parameters:
categoryIndex An index corresponding to category.

Returns:

The array object.

- (void) deselectCategoryAtindex: (NSUlinteger) categorylndex

Removes the specified category from the selection pool.

Parameters:
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categorylndex An index corresponding to a category in category level 0.

- (void) deselectDataltemAtindex: (NSUinteger) dataltemIndex

ofGlobalSeriesIndex: (NSUlinteger) globalSeriesindex

Removes the specified data item from the selection pool.

Parameters:
dataltemIndex An index corresponding to a data item within the series.
globalSeriesindex An index corresponding to a series based on all chart layers.

- (void) deselectSeriesAtindex: (NSUinteger) globalSeriesindex

Removes the specified series from the selection pool.
Parameters:

globalSeriesindex An index corresponding to a series based on all chart layers.

- (NSString*) formattedStringFromValueAtDimension: (NSUinteger) valueDimensionIndex
ofCategory: (NSUinteger) categorylndex
inCategoryLevel: (NSUinteger) categorylLevellndex
andSeries: (NSUiInteger) globalSeriesindex

Gets the formatted string of the value at a specified dimension of a specified category-series pair.
Parameters:

valueDimensionIndex An index corresponding to a value dimension.

categoryIndex An index corresponding to a category.

categoryLevellndex An index corresponding to a category level.

globalSeriesIndex An index corresponding to a series. The index is based on all chart layers.

Returns:

The formatted string of the value.

- (NSFormatter*) formatterForValueAtDimension: (NSUinteger) valueDimensionIindex

Gets the formatter object for values at a specified dimension.

Parameters:
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valueDimensionindex An index corresponding to a value dimension.

Returns:

The formatter object.

- (NSDictionary*) getChartExtraProperties

Gets chart extra properties.

Returns:

Chart properties.

- (NSUInteger) highlightCategorylndex

Gets the index of the highlight category.

Returns:

The index of the category.

- (NSUInteger) indexOfFirstLevelZeroSubCategoryForCategory: (NSUlnteger)

inCategoryLevel: (NSUlnteger)

Gets the index of the first subcategory in category level 0 of a specified category in a specified category level.

Parameters:
categorylndex An index corresponding to a category.
categoryLevellndex An index corresponding to a category level.

Returns:

The index of the first subcategory in category level 0.

- (NSInteger) indexOfFirstSelectedSeries

Gets the index of the first selected series.

Returns:

The index of the series.
- (NSUInteger) indexOfFirstSubCategoryForCategory: (NSUlnteger)

inCategoryLevel: (NSUlnteger)

categorylndex

categoryLevellndex

Gets the index of the first subcategory of a specified category in a specified category level.

Parameters:
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categorylndex An index corresponding to a category.
categoryLevellndex An index corresponding to a category level.

Returns:

The index of the first subcategory in the subcategory's own level.
- (NSUInteger) indexOfLastLevelZeroSubCategoryForCategory: (NSUlinteger) categorylndex

inCategoryLevel: (NSUiInteger) categorylLevellndex

Gets the index of the last subcategory in category level 0 of a specified category in a specified category level.
Parameters:

categorylndex An index corresponding to a category.

categoryLevellndex An index corresponding to a category level.

Returns:

The index of the last subcategory in category level 0.
- (NSUInteger) indexOfLastSubCategoryForCategory: (NSUlinteger) categorylndex

inCategoryLevel: (NSUinteger) categorylLevellndex

Gets the index of the last subcategory of a specified category in a specified category level.
Parameters:
categorylndex An index corresponding to a category.
categoryLevellndex An index corresponding to a category level.

Returns:

The index of the last subcategory in the subcategory's own level.

- (BOOL) isCategoryinterpretedAsValue

Queries whether category can be interpreted as a value dimension.

This is the case whereby there are multiple data items corresponding to each category/series pair.

- (BOOL) isCategorySelectedAtindex: (NSUlInteger) categorylndex

Queries whether a specified category is selected.

Parameters:
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categorylndex An index corresponding to a category in category level 0.

Returns:

A Boolean value indicating if the category is selected.
- (BOOL) isDataltemInFocusAtindex: (NSUInteger) dataltemIndex

ofGlobalSeriesindex: (NSUInteger) globalSeriesindex

Queries whether the data is in focus.
The data item is focused if it is selected. If there is no selection, all data points are in focus.
Parameters:
dataltemIndex An index corresponding to a data item within the series.
globalSeriesindex An index corresponding to a series based on all chart layers.

See also:
isDataltemSelectedAtindex
Returns:

A Boolean value indicating if the data item is in focus.
- (BOOL) isDataltemSelectedAtindex: (NSUinteger) dataltemIndex

ofGlobalSeriesIndex: (NSUinteger) globalSeriesindex

Queries whether the data is selected.

Parameters:
dataltemIndex An index corresponding to a data item within the series.
globalSeriesindex An index corresponding to a series based on all chart layers.

Returns:

A Boolean value indicating if the data item is selected.
- (BOOL) isInFocusAtCategorylndex: (NSUlInteger) categorylndex

ofGlobalSeriesindex: (NSUInteger) globalSeriesindex

Queries whether the data is in focus.
The data item is focused if it is selected. If there is no selection, all data points are in focus.

Parameters:
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categorylndex An index corresponding to a category.
globalSeriesindex An index corresponding to a series based on all chart layers.

Returns:
A Boolean value indicating if the data is in focus.
See also:

isCategorySelectedAtindex and isSeriesSelectedAtindex.

- (BOOL) isSeriesSelectedAtGloballndexForAllChartLayers: (NSUinteger) globalSeriesindex

Queries whether a specified series is selected.
Parameters:
globalSeriesindex An index corresponding to a series based on all chart layers.

Returns:

A Boolean value indicating if the series is selected.
- (float) maxSumValueOfLayer: (NSUlinteger) layerindex

andValueDimension: (NSUinteger) valueDimensionindex

Gets the maximum sum of all the values corresponding to the same category.
Parameters:
layerindex An index corresponding to a chart layer.
valueDimensionindex An index corresponding to the value dimension.

Returns:

The numeric value.
- (float) maxValueOfLayer: (NSUinteger) layerindex

andValueDimension: (NSUlinteger) valueDimensionindex

Gets the maximum value.

Parameters:
layerIindex An index corresponding to a chart layer.
valueDimensionindex An index corresponding to the value dimension.

Returns:
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The numeric value.
- (float) minSumValueOfLayer: (NSUInteger) layerindex

andValueDimension: (NSUinteger) valueDimensionIindex

Gets the minimum sum of all the values corresponding to the same category.
Parameters:
layerindex An index corresponding to a chart layer.
valueDimensionIndex An index corresponding to the value dimension.

Returns:

The numeric value.
- (float) minValueOfLayer: (NSUInteger) layerindex

andValueDimension: (NSUlInteger) valueDimensionIndex

Gets the minimum value.

Parameters:
layerindex An index corresponding to a chart layer.
valueDimensionIndex An index corresponding to the value dimension.

Returns:

The numeric value.

- (NSUInteger) numberOfSelectedCategories

Gets the number of categories in selection.

Returns:

The number of categories in selection.

- (NSUInteger) numberOfSelectedSeries

Gets the number of series in selection.

Returns:

The number of series in selection.

- (NSUInteger) numberOfValueDimensions

Gets the number of dimensions of the values in the chart view.
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Returns:

The number of value dimensions.

- (void) selectCategoryAtindex: (NSUlnteger) categorylndex

Adds the specified category to the selection pool.
Parameters:
categorylndex An index corresponding to a category in category level 0.

- (void) selectDataltemAtindex: (NSUlInteger) dataltemIndex

ofGlobalSeriesindex: (NSUlInteger) globalSeriesindex

Adds the specified data item to the selection pool.

Parameters:
dataltemIndex An index corresponding to a data item within the series.
globalSeriesindex An index corresponding to a series based on all chart layers.

- (void) selectSeriesAtindex: (NSUinteger) globalSeriesindex

Adds the specified series to the selection pool.
Parameters:
globalSeriesindex An index corresponding to a series based on all chart layers.

- (id) seriesAtindex: (NSUlinteger) globalSeriesindex

Gets the series at a specified index within all chart layers.
Parameters:
globalSeriesindex An index corresponding to a series. The index is based on all chart layers.

Returns:

The series object.

- (NSUInteger) seriesCount

Gets the total number of series for all layers.

Returns:

The series count.
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- (NSFormatter*) seriesFormatter

Gets the formatter object for series.

Returns:

The formatter object.

- (NSUInteger) seriesindexOfDataltem: (NSUinteger) dataltemIndex

Gets the category of the specified data item.
Parameters:
dataltemIndex An index corresponding to a data item.

Returns:
The category object. Gets the series index of the specified data item.

Parameters:
dataltemIndex An index corresponding to a data item.

Returns:

The series index.

- (NSString*) seriesTitle

Gets the title of series for category level 0, which could be used for axis labelling and table headers.

Returns:

The label.

- (NSString*) seriesTitleForCategoryLevel: (NSUinteger) categoryLevellndex

Gets the title of series for a specified category level, which could be used for axis labelling and table headers.

Parameters:

categoryLevellndex An index corresponding to a category level.

Returns:

The label.

- (void) setBorderColor: (UlColor *) color
forCategory: (NSUlinteger) categorylndex
andSeries: (NSUinteger) globalSeriesindex
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Set the border color for a category-series combination.

Parameters:

color The color object.

categorylndex An index corresponding to a category.

globalSeriesindex An index corresponding to a series based on all chart layers.
- (void) setBorderColor: (UlColor *) color
forSeries: (NSUinteger) globalSeriesindex

Set the border color for a series.

Parameters:
color The color object.

globalSeriesindex An index corresponding to a series based on all chart layers.

- (void) setContentColor: (UlColor *) color
forCategory: (NSUInteger) categorylndex
andSeries: (NSUlInteger) globalSeriesindex

Set the content color for a category-series combination.

Parameters:
color The color object.
categorylndex An index corresponding to a category.

globalSeriesIndex An index corresponding to a series based on all chart layers.
- (void) setContentColor: (UlColor *) color

forSeries: (NSUlinteger) globalSeriesindex

Set the content color for a series.

Parameters:
color The color object.

globalSeriesindex An index corresponding to a series based on all chart layers.

- (void) setHighlightCategoryIndex: (NSUlinteger) categorylndex
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Sets the index of the highlighted category.
Parameters:
categorylndex The index of the category.

- (void) sortSeries: (MASortingOrder)  order

Sorts the series by series hame according to the specified order.
Parameters:
order Sorting order.

- (void) sortValues: (NSUlinteger) globalSeriesindex

Sorts the assigned series values. If already sorted, reverses the sorting order.

Parameters:

globalSeriesindex An index corresponding to a series based on all chart layers.
- (void) sortValues: (NSUInteger) globalSeriesIndex
byOrder: (MASeriesSoringOrder)  ascOrder

Sorts the assigned series values.

Parameters:

globalSeriesindex An index corresponding to a series based on all chart layers.

ascOrder Sort by ascending order or not.
- (id) valueAtDimension: (NSUlinteger) valueDimensionindex
ofCategory: (NSUlinteger) categorylndex
inCategoryLevel: (NSUlinteger) categorylLevellndex
andSeries: (NSUinteger) globalSeriesindex

Gets the value at a specified dimension of a specified category-series pair.
Parameters:

valueDimensionIndex An index corresponding to a value dimension.
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categorylndex An index corresponding to a category.
categoryLevellndex An index corresponding to a category level.
globalSeriesIndex An index corresponding to a series. The index is based on all chart layers.

Returns:

The value object.
- (id) valueAtDimension: (NSUinteger) valueDimensionlndex

ofDataltem: (NSUinteger) dataltemIndex

Gets the value of the specified data item.

Parameters:
valueDimensionIndex An index corresponding to the value dimension.
dataltemIndex An index corresponding to a data item within the series.

Returns:

The value object.
- (id) valueOfCategory: (NSUlinteger) categorylndex

andSeries: (NSUinteger) globalSeriesindex

Gets the value of a specified category-series pair.

Parameters:
categorylndex An index corresponding to a category in category level 0.
globalSeriesindex An index corresponding to a series. The index is based on all chart layers.

Returns:

The value object.

- (NSString*) valueTitleAtDimension: (NSUinteger) valueDimensionIindex

Gets the title of value at the specified dimension, which may be used for axis labelling and table headers.
Parameters:
valueDimensionindex An index corresponding to the value dimension.

Returns:

The label.
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- (NSString*) valueTitleAtDimension: (NSUinteger) valueDimensionIindex

inCategoryLevellndex: (NSUinteger) categorylLevellndex

Gets the title of value at the specified dimension and category level index, which may be used for axis labelling and table
headers.

Parameters:
valueDimensionIndex An index corresponding to the value dimension.
categoryLevellndex An index corresponding to a category level.

Returns:

The label.

Property Documentation

- (NSFormatter*) categoryFormatter [read, required, assign]

Gets the formatter object for categories.

Returns:

The formatter object.

MAChartLayerModel

Protocol of chart layer model.

Inherited by MAChartView.

Public Member Functions

(NSUInteger) - chartLayerCount

(NSUlInteger) - chartTypeForChartLayer:

(MAChartRenderTyp

e) - chartRenderTypeForChartLayer:

(NSUInteger) - seriesCountForChartLayer:

(id) - seriesAtindex:forChartLayer:

(id) - valueOfCategory:andLayerSeries:forChartLayer:

(id) - valueAtDimension:ofCategory:inCategoryLevel:andLayerSeries:forChartLayer:
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(NSUinteger) - convertToGlobalSeriesindexFromLayerSeriesindex:forChartLayer:
(NSIndexPath *) - layerindexesOfSeriesindex:

(NSString *) -
formattedStringFromValueAtDimension:ofCategory:inCategoryLevel:andLayerSeries:forCh
artLayer:

Member Function Documentation

- (NSUInteger) chartLayerCount [required]

Gets the number of layers.

Returns:

The layer count.

- (MAChartRenderType) chartRenderTypeForChartLayer: (NSUinteger) layerindex [required]

Gets the chart render type for a chart layer at a specified index.
Parameters:
layerIndex An index corresponding to a chart layer.

Returns:

The chart render type for the layer.

- (NSUInteger) chartTypeForChartLayer: (NSUinteger) layerindex [required]

Gets the chart type for a chart layer at a specified index.
Parameters:
layerindex An index corresponding to a chart layer.

Returns:

The chart type for the layer.

- (NSUInteger) convertToGlobalSeriesindexFromLayerSeriesindex: (NSUlinteger) layerSeriesindex
forChartLayer: (NSUlinteger) layerindex
[required]

Converts an index corresponding to a series in a specified layer to a global series index, based on all chart layers.

Parameters:
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layerSeriesindex An index corresponding to a series in the chart layer it belongs to.
layerindex An index corresponding to a chart layer.

Returns:

An index corresponding to a series based on all chart layers.

- (NSString*) formatted StringFromValueAtDimension: (NSUinteger) valueDimensionIindex
ofCategory: (NSUinteger) categorylndex
inCategoryLevel: (NSUInteger) categoryLevellndex
andLayerSeries: (NSUInteger) layerSeriesindex
forChartLayer: (NSUInteger) layerindex
[required]

Gets the formatted string of the value at a specified dimension of a specified category-series pair. The series is located in
the chart layer it belongs to.

Parameters:
valueDimensionIndex An index corresponding to a value dimension.
categoryIndex An index corresponding to a category.
categoryLevellndex An index corresponding to a category level.
layerSeriesindex An index corresponding to a series in the chart layer it belongs to.
layerindex An index corresponding to a chart layer.

Returns:

The formatted string of the value.

- (NSIndexPath*) layerindexesOfSeriesIndex: (NSUlInteger) globalSeriesindex [required]

Gets the layer indexes of the specified series index.
Parameters:
globalSeriesindex An index corresponding to a series based on all chart layers.

Returns:

An index path, with the first index being layer index, and the second index being the series corresponding to a chart layer.

- (id) seriesAtindex: (NSUinteger)  seriesindex
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forChartLayer: (NSUinteger) layerindex

[required]

Gets the series at a specified index within a specified chart layer.

Parameters:
seriesindex An index corresponding to a series. The index is based on the chart layer the series belongs to.
layerindex An index corresponding to a chart layer.

Returns:

The series object.

- (NSUInteger) seriesCountForChartLayer: (NSUinteger) layerindex [required]

Gets the number of series at a specified layer.
Parameters:
layerIndex An index corresponding to a chart layer.

Returns:

The series count in the layer.

- (id) valueAtDimension: (NSUlinteger) valueDimensionindex
ofCategory: (NSUinteger) categorylndex
inCategoryLevel: (NSUinteger) categorylLevellndex
andLayerSeries: (NSUlinteger) layerSeriesindex
forChartLayer: (NSUlinteger) layerindex
[required]

Gets the value at a specified dimension of a specified category-series pair. The series is located in the chart layer it belongs
to.

Parameters:
valueDimensionindex An index corresponding to a value dimension.
categorylndex An index corresponding to a category.
categoryLevellndex An index corresponding to a category level.

layerSeriesindex An index corresponding to a series in the chart layer it belongs to.
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layerindex An index corresponding to a chart layer.

Returns:

The value object.

- (id) valueOfCategory: (NSUlinteger) categorylndex

andLayerSeries: (NSUlinteger) layerSeriesindex

forChartLayer: (NSUlinteger) layerindex
[required]

Gets the value of a specified category-series pair. The series is located in the chart layer it belongs to.
Parameters:
categorylndex  Anindex corresponding to a category in category level O.
layerSeriesindex An index corresponding to a series in the chart layer it belongs to.
layerindex An index corresponding to a chart layer.

Returns:

The value object.

MAChartSelection

Class representing items selected in a chart.

Properties

NSArray * selectedCategorylndexes

NSArray * selectedDataltemIindexes

Property Documentation

- (NSArray*) selectedCategorylndexes [read, write, retain]

An array of indexes identifying the selected categories.

- (NSArray*) selectedDataltemIndexes [read, write, retain]

An array of indexes identifying the selected data items.
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MAChartSeriesPainter

Protocol of chart series painter. This protocol defines methods and properties implemented by a chart series painter. A chart
series painter is responsible for painting the content of a chart series layer, such as columns, lines, and bars.

Public Member Functions

(CGPaint) - layerAnchorPointWithSeriesSpec:withChartBasePainter:
(CGRect) - layerBoundsWithSeriesSpec:inPlotAreaBounds:withChartBasePainter:
(void) - drawInContext:withSeriesSpec:inBounds:withChartBasePainter:
(void) - drawLegendMarkerinContext:withSeriesSpec:inBounds:withChartBasePainter:
(CGPaint) - layerPositionWithSeriesSpec:inPlotAreaBounds:withChartBasePainter:
(CGPaint) - pointForDataAtCategory:andSeries:withChartBasePainter:
(CGPaint) - pointForDataAtindex:withChartBasePainter:
(void) - seriesLayerDidLoadInPlotArea:withSeriesSpec:withChartBasePainter:
(CALayer *) - maskLayerWithSeriesSpec:withChartBasePainter:
(void) - setupAccessoryView:withSeriesSpec:withChartBasePainter:
(void) - layoutAccessoryView:withSeriesSpec:withChartBasePainter:
(void) - plotAreaScrollViewDidLoad:
(void) - plotAreaContentViewDidLoad:

Properties

id< MAAnimatorDelegate > animator
id< MAShape > shape

NSUinteger layerindex

Member Function Documentation

- (void) drawInContext: (CGContextRef) context
withSeriesSpec: (id< MAChartSeriesSpec >) seriesSpec
inBounds: (CGRect) bounds
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withChartBasePainter: (id< MAChartBasePainter >) chartBasePainter

Draws the series layer.

Parameters:
context Drawing context.
seriesSpec Series specification.
bounds Plot are bounds.

chartBasePainter Chart base painter.

- (void) drawLegendMarkerInContext: (CGContextRef) context
withSeriesSpec: (id< MAChartSeriesSpec >) seriesSpec
inBounds: (CGRect) rect
withChartBasePainter: (id< MAChartBasePainter >) chartBasePainter

Draws the legend marker of the series.

Parameters:
context Drawing context.
seriesSpec Series specification.
rect Plot are bounds.

chartBasePainter Chart base painter.

- (CGPoint) layerAnchorPointWithSeriesSpec:

withChartBasePainter:

Returns the anchor of the series layer.
Parameters:
seriesSpec Series specification.
chartBasePainter Chart base painter.

Returns:

(id< MAChartSeriesSpec >)

(id< MAChartBasePainter >)
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The point indicating the layer anchor.

- (CGRect) layerBoundsWithSeriesSpec: (id< MAChartSeriesSpec >)
inPlotAreaBounds: (CGRect)
withChartBasePainter: (id< MAChartBasePainter >)

Returns the bounds of the series layer.

Parameters:
seriesSpec Series specification.
bounds Plot are bounds.

chartBasePainter Chart base painter.

Returns:

The rectangle indicating the bounds.

- (CGPoint) layerPositionWithSeriesSpec: (id< MAChartSeriesSpec >)
inPlotAreaBounds: (CGRect)
withChartBasePainter: (id< MAChartBasePainter >)

Returns the point of the series layer origin.

Parameters:
seriesSpec Series specification.
bounds Plot are bounds.

chartBasePainter Chart base painter.

Returns:

The point indicating the layer origin.

seriesSpec
bounds

chartBasePainter

seriesSpec

bounds

chartBasePainter

- (void) layoutAccessoryView: (UlView *) accessoryView
withSeriesSpec: (id< MAChartSeriesSpec >) seriesSpec
withChartBasePainter: (id< MAChartBasePainter >) chartBasePainter

Method for the receiver to lay out the contents in the accessory view.
Parameters:

accessoryView The accessory view.
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seriesSpec Series specifications.
chartBasePainter Chart base painter.

- (CALayer*) maskLayerWithSeriesSpec: (id< MAChartSeriesSpec >) seriesSpec

withChartBasePainter: (id< MAChartBasePainter >) chartBasePainter

Asks for the mask layer for the series layer if necessary.
Parameters:
seriesSpec Series specifications.
chartBasePainter Chart base painter.

- (void) plotAreaContentViewDidLoad: (UlView *)  view

Tells the receiver when the plot area content view is loaded. This method is most commonly used to perform additional
initialization steps on the plot area view, for example, modifying gesture recognizers, and creating drawing layers.

Parameters:
view A UlView representing the plot area view.

- (void) plotAreaScrollViewDidLoad: (UlScrollView *)  view

Tells the receiver when the plot area scroll view is loaded. This method is most commonly used to perform additional
initialization steps on the plot area scroll view, for example, modifying gesture recognizers, and creating drawing layers.

Parameters:

view A UlScrollView representing the parent view of the plot area content view.

- (CGPoint) pointForDataAtCategory: (NSUinteger) categorylndex
andSeries: (NSUInteger) globalSeriesindex
withChartBasePainter: (id< MAChartBasePainter >) chartBasePainter

Returns the point in the content view for data identified by its category and series index.
Parameters:

categorylndex An index corresponding to a category.

globalSeriesindex An index corresponding to a series based on all chart layers.

chartBasePainter Chart base painter.
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- (CGPoint) pointForDataAtIindex: (NSUlinteger) dataltemIndex

withChartBasePainter: (id< MAChartBasePainter >) chartBasePainter

Returns the point in the content view for data identified by its data item index.

Parameters:
dataltemIndex An index corresponding to a data item.

chartBasePainter Chart base painter.

- (void) seriesLayerDidLoadInPlotArea: (UlView *) view
withSeriesSpec: (id< MAChartSeriesSpec >) seriesSpec
withChartBasePainter: (id< MAChartBasePainter >) chartBasePainter

Tells the receiver when the series layer is loaded. This method is most commonly used to perform additional initialization
steps on the plot area view, for example, modifying gesture recognizers, and creating drawing layers.

Parameters:
view A UlView representing the plot area view.
seriesSpec Series specifications.

chartBasePainter Chart base painter.

- (void) setupAccessoryView: (UlView *) accessoryView
withSeriesSpec: (id< MAChartSeriesSpec >) seriesSpec
withChartBasePainter: (id< MAChartBasePainter >) chartBasePainter

Method for the receiver to set up the contents in the accessory view.

Parameters:
accessoryView The accessory view.
seriesSpec Series specifications.

chartBasePainter Chart base painter.

Property Documentation

- (id<MAAnimatorDelegate>) animator [read, write, required, retain]
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The animator for the series layer.

- (NSUInteger) layerindex [read, write, optional, assign]

The index of the chart series layer.

- (id<MAShape>) shape [read, write, retain]

The shape of the series layer.

MAChartTheme

Protocol of chart theme.

Inherited by MAKitTheme_WelterWeight.

Public Member Functions

(id< MAChartBasePainter >) - getChartBasePainterByChartType:

(id< MAChartSeriesPainter >) - getChartSeriesPainterByChartType:

(UlIFont *) - getChartTitleFont

(UIFont *) - getChartLegendFont

(UIFont *) - getCategoryLabelFont

(UIFont *) - getValueLabelFont

(UIColor *) - chartBackgroundColor

(UIColor *) - chartBorderColor

(UIColor *) - chartTitleTextColor

(UIColor *) - chartLegendBackgroundColor
(UIColor *) - chartLegendBorderColor

(UIColor *) - chartLegendTextColor

(UIColor *) - cartesianChartValueAxisColor
(UlColor *) - cartesianChartValueAxisMarkerTextColor
(UIColor *) - cartesianChartValueLabelTextColor
(UlColor *) - cartesianChartCategoryAxisColor
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(UlColor *) - cartesianChartCategoryAxisMarkerTextColor
(UlColor *) - cartesianChartCategoryLabelTextColor
(UIColor *) - cartesianChartGuidelineColor

(UlColor *) - cartesianChartEvenCategoryBackgroundColor
(UlColor *) - cartesianChartOddCategoryBackgroundColor
(UIColor *) - chartHighlightColor

(UIColor *) - dynamicAnalyticsVariableDescriptionColor
(UIColor *) - dynamicAnalyticsVariableValueColor

(UIColor *) - getChartSeriesContentColorForIindex:
(UIColor *) - getChartSeriesBorderColorForIindex:

(UIColor *) - dataGridLinesColor

(UIColor *) - dataGridCatgeoryTextColor

(UIColor *) - dataGridHeaderBackgroundColor

(UlColor *) - dataGridBackgroundColor

(UlFont *) - dataGridFont

(UlColor *) - dataGridHorizontalLinelColor

(UIColor *) - dataGridHorizontalLine2Color

(UlColor *) - upperThresholdColor

(UIColor *) - lowerThresholdColor

(UIColor *) - referenceValueColor

(UIColor *) - cartesianChartCategoryBackgroundColorForRow:
(UIColor *) - cartesianChartCategoryLabelTextColorAt:
(NSUinteger) - chartltemWidth

(Ullmage *) - tailinglmageForindex:

Member Function Documentation

- (UIFont*) getCategoryLabelFont [required]
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Returns the font for chart category labels.

Returns:

The font for category labels.

- (id<MAChartBasePainter>) getChartBasePainterByChartType:

(NSUInteger)

Returns the chart base painter based on a chart type for the current chart theme.

Parameters:
chartType Chart type.

Returns:

The base painter for the specified chart type.

- (UIFont*) getChartLegendFont [required]

Returns the font for the chart legend.

Returns:

The font for the legend.

- (UIColor*) getChartSeriesBorderColorForindex:

Returns the border color of a chart series with index.
Parameters:
seriesindex The index of series.

Returns:

Border color of the specified series.

- (UIColor*) getChartSeriesContentColorForIndex:

Returns the content color of a chart series with index.

Parameters:
seriesIndex The index of series.

Returns:

Content color of the specified series.

(NSUInteger)

(NSUInteger)

- (id<MAChartSeriesPainter>) getChartSeriesPainterByChartType:
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Returns the chart series painter based on a chart type for the current chart theme.
Parameters:
chartType Chart type.

Returns:

The series painter for the specified chart type.

- (UIFont*) getChartTitleFont [required]

Returns the font for the chart title.

Returns:

The font for title

- (UIFont*) getValueLabelFont [required]

Returns the font for chart value labels.

Returns:

The font for value labels.

- (Ullmage?*) tailinglmageForindex: (NSUInteger) seriesindex [optionall]

Returns the tailinglmage to indicate the end of the series, or to indicate a break in data points. Applicable only to line charts.
Parameters:

seriesindex The series index.

MAChartView

Class of a chart view with contents constructed from a chart datasource. A chart view is a view for displaying a chart. It is
similar to the UlTableView, which displays a table. A chart view object must have an object that acts as a datasource and
optionally, an object that acts as a delegate. The datasource provides information that the chart view needs to construct the
view. The delegate performs tasks such as managing selections.

Inherits <MAChartDataModel>, and <MAChartLayerModel>.

Public Member Functions

(void) - refresh
(void) - refreshSync:
(void) - reloadData:
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(void)
(void)
(void)

(CGPoint)

Properties

NSString *

id< MAChartViewDataSource >
id< MAChartViewDelegate >
id< MAChartDataModel >
id< MAChartLayerModel >
id< MAChartTheme >

BOOL

BOOL

BOOL

BOOL

BOOL

BOOL

BOOL

BOOL

BOOL

BOOL

BOOL
MARangeSelectorBehavior
MAHierarchialCategoryLabelDisplay
CGFloat

CGFloat

BOOL

- reloadDataAsync:
- redraw:
- quickRedraw:

- pointForDataAtIndex:

identifier

dataSource

delegate

dataModel

layerModel

theme

isThumbnailMode
isTitleHidden
isLegendHidden
showsHorizontalAxisTitle
showsVerticalAxisTitle
showsHorizontalAxis
showsVerticalAxis
showsSeriesLabels
showsSelectedDatalL abel
showsGridLabel
showsXAxisAtTop
contentRangeSelectorBehavior
hierarchicalCategoryLabelDisplay
rowHeight

rowSpacing

horizontalZoomEnabled
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BOOL verticalZoomEnabled
NSString * title

NSString * name

CGFloat textScale

BOOL refreshing

CGFloat minDisplayValue

Member Function Documentation

- (CGPoint) pointForDataAtIindex: (NSUinteger) dataltemIndex

Returns the point in the chart view coordinate system for data identified by its data item index.

Parameters:

dataltemIndex An index corresponding to a data item

- (void) quickRedraw: (BOOL) animated

Quickly redraw chart.

Call this method to quickly redraw chart based on the current data and specifications.

- (void) redraw: (BOOL) animated

Redraws chart.

Call this method to redraw chart with all chart specifications changes (data is not reloaded).

- (void) refresh

Refreshes chart asynchronously.

Call this method to reload data and refresh all chart specifications in an asynchronous thread.

- (void) refreshSync: (BOOL) animated

Refreshes chart synchronously.

Call this method to reload data and refresh all chart specifications.
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Member Data Documentation

package { ...} MAChartView::_chartViewFlags [protected]

Chart view internal rendering flags.

Property Documentation

- (MARangeSelectorBehavior) contentRangeSelectorBehavior [read, write, assign]

A value that determines whether to show the content range selector.

Default is MARangeSelectorBehaviourAuto. No range selector is shown if both horizontal and vertical zoom are disabled.

- (id<MAChartDataModel>) dataModel [read, write, retain]

The chart model of the receiving chart view.

- (id<MAChartViewDataSource>) dataSource [read, write, assign]

The object that acts as the datasource of the receiving chart view.

- (id<MAChartViewDelegate>) delegate [read, write, assign]

The object that acts as the delegate of the receiving chart view.

- (MAHierarchialCategoryLabelDisplay) hierarchicalCategorylLabelDisplay [read, write, assign]

A value that determines the display of labels for multiple category levels.

Default is MAHierarchialCategoryLabelDisplayTopLevel.

- (BOOL) horizontalZoomEnabled [read, write, assign]

A Boolean value that determines whether horizontal zoom is enabled.

Default is YES.

- (NSstring*) identifier [read, write, copy]

A string that serves as the identifier to the chart view if necessary.
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- (BOOL) isLegendHidden [read, write, assign]

A Boolean value that determines whether chart legend view is hidden.

The default value depends on the chart type. The legend is shows only if it is applicable to the specified chart type, and if
there are multiple series.

- (BOOL) isThumbnailMode [read, write, assign]

A Boolean value that determines whether chart view is in thumbnail mode.

Default is NO.

- (BOOL) isTitleHidden [read, write, assign]

A Boolean value that determines whether chart view title is hidden.

Default is NO.

- (id<MAChartLayerModel>) layerModel [read, write, retain]

The chart layer model of the receiving chart view.

- (NSsString*) name [read, write, copy]

Name of the chart.

- (BOOL) refreshing [read, write, assign]

A Boolean value that indicates whether the chart is in the midst of refreshing its data.

- (CGFloat) rowHeight [read, write, assign]

A value that determines the height of each row in bar/horizontal bullet chart.

- (CGFloat) minDisplayVlaue [read, write, assign]

A value that determines the minimum value to appear on the chart.

- (CGFloat) rowSpacing [read, write, assign]

A value that determines the spacing of each row in a bar/horizontal bullet chart.
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- (BOOL) showsGridLabel [read, write, assign]

A Boolean value that controls whether the grid line labels should be shown.

The default value is YES. The axis is shown only if it is applicable for the specified chart type. A layout event is triggered
after setting this property.

- (BOOL) showsHorizontalAxis [read, write, assign]

A Boolean value that controls whether the horizontal axis with labels and tick marks should be shown.

The default value is YES. The axis is shown only if it is applicable for the specified chart type. A layout event is triggered
after setting this property.

- (BOOL) showsHorizontalAxisTitle [read, write, assign]

A Boolean value that controls whether the horizontal axis title should be shown.

The default value is NO. The axis title is shown only if it is applicable to the specified chart type, and the datasource
implements the related title retrival method. A layout event is triggered after setting this property.

- (BOOL) showsSelectedDataLabel [read, write, assign]

A Boolean value that controls whether the label of selected data should be shown.

The default value is YES. The data label is shown only if it is applicable to the specified chart type. A layout event is
triggered after setting this property.

- (BOOL) showsSeriesLabels [read, write, assign]

A Boolean value that controls whether to show series labels.

The default value is YES. Series labels are applicable only to pie charts. A layout event is triggered after setting this property.

- (BOOL) showsVerticalAxis [read, write, assign]

A Boolean value that controls whether to show the vertical axis with labels and tick marks.

The default value is YES. The axis shown only if it is applicable for the specified chart type. A layout event is triggered after
setting this property.

- (BOOL) showsVerticalAxisTitle [read, write, assign]

A Boolean value that controls whether to show the vertical axis title.

168





MAKit Developer Guide: iOS 2013

The default value is NO. The axis title is shown only if it is applicable for the specified chart type, and the dataSource
implements the related title retrival method. A layout event is triggered after setting this property.

- (BOOL) showsXAxisAtTop [read, write, assign]

A Boolean value that controls whether to display the x-axis at the top or bottom, for certain type of charts.

The default value is YES. The x-axis appears at the top of the chart.

- (CGFloat) textScale [read, assign]

The current scale for text rendering in the chart view.

- (id<MAChartTheme>) theme [read, write, retain]

The object that acts as the theme of the receiving chart view.

- (NSstring*) title [read, write, copyl]

Title of the chart.

- (BOOL) verticalZoomEnabled [read, write, assign]

A Boolean value that determines whether vertical zoom is enabled.

Default is NO.

MAChartViewDataSource

Protocol of chart view datasource.
This protocol defines methods and properties to be implemented by a chart view datasource.

Inherited by MAAnalyticChartView.

Public Member Functions

(NSString *) - titleForChartView:

(NSUlInteger) - chartView:chartTypeForChartLayer:
(NSUInteger) - chartView:numberOfCategoriesinLevel:

(id) - chartView:categoryAtindex:inCategoryLevel:
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(NSUinteger) - numberOfSeriesIinChartView:

(id) - chartView:seriesAtindex:

(id) - chartView:valueAtDimension:forCategory:inCategoryLevel:andSeries:
(NSUInteger) - numberOfValueDimensionsIinChartView:

(NSFormatter *) - chartView:formatterForValueAtDimension:
(NSFormatter *) - categoryFormatterForChartView:

(NSFormatter *) - seriesFormatterForChartView:

(NSString *) - chartView:categoryTitleForCategoryLevel:

(NSString *) - chartView:seriesTitleForCategoryLevel:

(NSString *) - chartView:valueTitleAtDimension:inCategoryLevellndex:
(NSUinteger) - numberOfLayersIinChartView:

(NSUinteger) - chartView:indexOfLayerForSeries:

(BOOL) - getDataByDataltemsinChartView:

(NSUInteger) - numberOfDataltemsInChartView:

(NSUInteger) - chartView:indexOfCategoryForDataltem:

(NSUlInteger) - chartView:indexOfSeriesForDataltem:

(id) - chartView:valueAtDimension:forDataltem:

(NSUlInteger) - numberOfCategoryLevelsinChartView:

(NSUlInteger) - chartView:indexOfFirstSubCategoryForCategory:inCategoryLevel:
(NSUinteger) - chartView:indexOfLastSubCategoryForCategory:inCategoryLevel:

(NSDictionary *) - getExtraChartProperties:

(UlView *) - chartView:accessoryViewforCategory:inCategoryLevel:andSeries:

Member Function Documentation

- (NSFormatter*) categoryFormatterForChartView: (MAChartView *)  chartView

Asks the datasource to return the formatter for categories in the chart view.

This method is optional. If it is not implemented, there is no formatting on the category object.
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Parameters:
chartView An object representing the chart view requesting this information.

Returns:

The NSFormatter object.

- (UIView*) chartView: (MAChartView *)  chartView
accessoryViewforCategory: (NSUlinteger) categorylndex
inCategoryLevel: (NSUinteger) categoryLevellndex
andSeries: (NSUInteger) seriesindex
[optional]

Ask the datasource to return the accessory view of the specified category and series indexes. Currently supported only for
line charts.

Parameters:
chartView An object representing the chart view requesting this information.
categoryIndex An index corresponding to a category in the chartView.

categoryLevellndex An index corresponding to a category level in the chartView. Applicable for semantic
zooming, else 0 in most cases.

seriesindex An index corresponding to a series in the chartView.

Returns:

The accessory view.

- (id) chartView: (MAChartView *)  chartView

categoryAtindex: (NSUInteger) categorylndex

inCategoryLevel: (NSUInteger) categoryLevellndex
[required]

Asks the datasource to return the category at a specific index.

In chart rendering, the description of the category object is used as the display string for that category.

Parameters:
chartView An object representing the chart view requesting this information.
categoryIndex An index corresponding to a category in the chartView.
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categoryLevellndex An index corresponding to a category level in the chartView.

Returns:

The category object.

- (NSString*) chartView: (MAChartView *)  chartView
categoryTitleForCategoryLevel: (NSUlInteger) categoryLevellndex
[optional]

Asks the datasource to return the label for category in the chart view.
This method is optional. If it is not implemented, there is no title.
Parameters:
chartView An object representing the chart view requesting this information.

categoryLevellndex An index corresponding to a category level.

Returns:
The label.
- (NSUInteger) chartView: (MAChartView *)  chartView
chartTypeForChartLayer: (NSUInteger) layerindex

[required]

Asks the datasource to return the chart type of the series at a specific index.
Parameters:
chartView An object representing the chart view requesting this information.

layerIndex An index corresponding to a chart layer in the chartView.

Returns:

The chart type.

- (NSFormatter*) chartView: (MAChartView *)  chartView
formatterForValueAtDimension: (NSUinteger) valueDimensionindex

[optional]

Asks the datasource to return the formatter for value at a specific dimension in the chart view.
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This method is optional. If it is not implemented, there is no formatting on the value object. The string representation is that
of [NSObject description].

Parameters:
chartView An object representing the chart view requesting this information.

valueDimensionindex An index corresponding to a value in the value dimension in the chartView. In normal
single-value-dimensional charts, valuelndex is usually equal to 0.

Returns:

The NSFormatter object.

- (NSUInteger) chartView: (MAChartView *)  chartView
indexOfCategoryForDataltem: (NSUlInteger) dataltemIndex
[optional]

Asks the datasource to return the category index of a data item in the chart view.

In some charts, such as a scatter chart, it is more efficient to get data by data items instead of traversing through all the
category and series combinations.

Parameters:
chartView An object representing the chart view requesting this information.
dataltemIndex An index corresponding to a data item in the chartView.

Returns:

The index corresponding to a category in the chartView.

- (NSUInteger) chartView: (MAChartView *)  chartView

indexOfFirstSubCategoryForCategory: (NSUinteger) categorylndex

inCategoryLevel: (NSUinteger) categoryLevellndex
[optional]

Asks the datasource to return the index of the first category that belongs to the supercategory in a specific location in a
supercategory level of the chart view.

In some charts, categories may be grouped in hierarchy, that is, with supercategories. For example, in a chart with 6
categories: Jan, Feb, Mar, Apr, May, and Jun, define supercategories Q1 and Q2 by grouping "Jan, Feb, Mar" and "Apr,
May, Jun" together respectively. In this example, the number of category levels is 2. The number of categories for level at
index 0 is 6. The number of categories for level at index 1 is 2. The category at index O in level at index 0 is "Jan". The
category at index 0 in level at index 1 is "Q1". The index of the first subcategory for the category at index 0 in level at index 1
is 0. The index of the last subcategory for the category at index O in level at index 1 is 2. The index of the first subcategory
for the category at index 1 in level at index 1 is 3. The index of the last subcategory for the category at index 1 in level at
index 1is 5.

Parameters:

173





MAKit Developer Guide: iOS 2013

chartView An object representing the chart view requesting this information.

categorylndex An index corresponding to a category.

categoryLevellndex An index corresponding to a category level.

Returns:

The index of a category in chartView.

- (NSUInteger) chartView: (MAChartView *)  chartView

indexOfLastSubCategoryForCategory: (NSUInteger) categorylndex

inCategoryLevel: (NSUInteger) categoryLevellndex
[optional]

Asks the datasource to return the index of the last category that belongs to the super category in a specific location in a
super category level of the chart view.

In some charts, categories may be grouped in hierarchy, that is, with supercategories. For example, in a chart with 6
categories: Jan, Feb, Mar, Apr, May, Jun, define supercategories Q1 and Q2 by grouping "Jan, Feb, Mar" and "Apr, May,
Jun" together respectively. In this example, the number of category level is 2. The number of categories for level at index 0
is 6. The number of categories for level at index 1 is 2. The category at index O in level at index 0 is "Jan". The category at
index 0 in level at index 1 is "Q1". The index of the first subcategory for the category at index 0 in level at index 1 is 0. The
index of the last subcategory for the category at index 0 in level at index 1 is 2. The index of the first subcategory for the
category at index 1 in level at index 1 is 3. The index of the last subcategory for the category at index 1 in level at index 1 is
5.

Parameters:
chartView An object representing the chart view requesting this information.
categorylndex An index corresponding to a category.

categoryLevellndex An index corresponding to a category level.

Returns:

The index of a category in chartView.

- (NSUInteger) chartView: (MAChartView *)  chartView
indexOfLayerForSeries: (NSUInteger) seriesindex
[optional]

Asks the datasource to return the index of the layer that the specific series belongs to.
Parameters:

chartView An object representing the chart view requesting this information.
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seriesindex An index corresponding to a series in the chartView.

Returns:

The index of the layer.

- (NSUInteger) chartView: (MAChartView *)  chartView
indexOfSeriesForDataltem: (NSUInteger) dataltemIndex
[optional]

Asks the datasource to return the series index of a data item in the chart view.

In some charts, such as a scatter chart, it is more efficient to get data by data items instead of traversing through all the
category and series combinations.

Parameters:
chartView An object representing the chart view requesting this information.
dataltemIndex An index corresponding to a data item in the chartView.

Returns:

The index corresponding to a series in the chartView.

- (NSUInteger) chartView: (MAChartView *)  chartView
numberOfCategoriesinLevel: (NSUinteger) categoryLevellndex
[required]

Asks the datasource to return the number of categories in the chart view.

Parameters:
chartView An object representing the chart view requesting this information.
categoryLevellndex An index corresponding to a category level.

Returns:

The number of categories in chartView.

- (id) chartView: (MAChartView *)  chartView
seriesAtindex: (NSUInteger) seriesindex
[required]

Asks the datasource to return the series at a specific index.
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In chart rendering, the description of the series object is used as the display string for that series.
Parameters:
chartView An object representing the chart view requesting this information.
seriesindex An index corresponding to a series in the chartView.

Returns:

The series object.

- (NSString*) chartView: (MAChartView *)  chartView
seriesTitleForCategoryLevel: (NSUInteger) categoryLevellndex
[optional]

Asks the datasource to return the label for series in the chart view.
This method is optional. If it is not implemented, there will be no title.
Parameters:
chartView An object representing the chart view requesting this information.

categoryLevellndex An index corresponding to a category level.

Returns:

The label.

- (id) chartView: (MAChartView *)  chartView
valueAtDimension: (NSUInteger) valueDimensionIndex
forCategory: (NSUInteger) categorylndex
inCategoryLevel: (NSUinteger) categoryLevellndex
andSeries: (NSUInteger) seriesindex

[required]

Ask the datasource to return the value of the category and the series at their specific indexes.
Some charts may require more than one value for each category-series pair. The valuelndex indicates the index of the value.
Parameters:

chartView An object representing the chart view requesting this information.

valueDimensionindex 5, index corresponding to a value in the value dimension in the chartView. In normal
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single-value-dimensional charts, valuelndex is usually equal to 0.
categorylndex An index corresponding to a category in the chartView.
categoryLevellndex An index corresponding to a category level in the chartView.
seriesindex An index corresponding to a series in the chartView.

Returns:

The value object.

- (id) chartView: (MAChartView *)  chartView

valueAtDimension: (NSUlinteger) valueDimensionIndex

forDataltem: (NSUinteger) dataltemIndex
[optional]

Ask the datasource to return the value of a data item at its specific index.
Some charts may require more than one value for each data item. The valuelndex indicates the index of the value.
Parameters:

chartView An object representing the chart view requesting this information.

valueDimensionindex An index corresponding to a value in the value dimension in the chartView. In normal
single-value-dimensional charts, valuelndex is usually equal to 0.

dataltemIndex An index corresponding to a data item in the chartView.

Returns:

The value object.

- (NSString*) chartView: (MAChartView *)  chartView

valueTitleAtDimension: (NSUInteger) valueDimensionindex

inCategoryLevellndex: (NSUInteger) categoryLevellndex
[optional]

Asks the datasource to return the title for value at a specific dimension in the chart view.
This method is optional. If it is not implemented, there is no title.
Parameters:

chartView An object representing the chart view requesting this information.
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valueDimensionindex An index corresponding to a value in the value dimension in the chartView. In normal
single-value-dimensional charts, valuelndex is usually equal to 0.

categorylLevellndex An index corresponding to a category level.

Returns:

The label.

- (BOOL) getDataByDataltemsInChartView: (MAChartView *)  chartView [optional]

Asks the datasource to whether it provides data in the form of data items.

In some charts, such as scatter charts, it is more efficient to get data by data items instead of traversing through all the
category and series combinations. An optional set of datasource APIs are provided to get data in this way. If
getDataByDataltemsInChartView: is not implemented or returns NO, the default
chartView:valueAtDimension:forCategoryAtindex:andSeries: method is used to fetch data.

Parameters:
chartView An object representing the chart view requesting this information.

Returns:

Boolean value to indicate if chart should fetch data by data items. Default is NO.

- (NSDictionary*) getExtraChartProperties: (MAChartView *)  chartView [optional]

Gets chart extra properties.
Currently supports upperThreshold, lowerThreshold, and referenceValue for line chart.
Parameters:

chartView An object representing the chart view requesting this information.

Returns:

Extra properties for the specified chart view.

- (NSUInteger) numberOfCategoryLevelsinChartView: (MAChartView *)  chartView [optional]

Asks the datasource to return the number of category levels in the cateogry hierarchy of the chart view.

In some charts, categories may be grouped in hierarchy, that is, with supercategories. For example, in a chart with 6
categories: Jan, Feb, Mar, Apr, May, Jun, define supercategories Q1 and Q2 by grouping "Jan, Feb, Mar" and "Apr, May,
Jun" together respectively. In this example, the number of category level is 2. The number of categories for level at index 0
is 6. The number of categories for level at index 1 is 2. The category at index O in level at index 0 is "Jan". The category at
index 0 in level at index 1 is "Q1". The index of the first subcategory for the category at index 0O in level at index 1 is 0. The
index of the last subcategory for the category at index 0 in level at index 1 is 2. The index of the first subcategory for the
category at index 1 in level at index 1 is 3. The index of the last subcategory for the category at index 1 in level at index 1 is

Parameters:
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chartView An object representing the chart view requesting this information.

Returns:

The number of category levels in chartView.

- (NSUinteger) numberOfDataltemsInChartView: (MAChartView *)  chartView [optional]

Asks the datasource to return the number of data items in the chart view.

In some charts, such as scatter charts, it is more efficient to get data by data items instead of traversing through all the
category and series combinations.

Parameters:
chartView An object representing the chart view requesting this information.

Returns:

The number of data items in chartView.

- (NSUInteger) numberOfLayersinChartView: (MAChartView *)  chartView [optional]

Asks the datasource to return the number of layers of the chart view.
Chart layers enable chart overlay.
Parameters:
chartView An object representing the chart view requesting this information.

Returns:

The number of layers in chartView.

- (NSUInteger) numberOfSeriesIinChartView: (MAChartView *)  chartView [required]

Asks the datasource to return the number of series in the chart view.
Parameters:
chartView An object representing the chart view requesting this information.

Returns:

The number of series in chartView. The default value is 1.

- (NSUinteger) numberOfValueDimensionsInChartView: (MAChartView *)  chartView [optional]

Asks the datasource to return the number of dimensions of values in the chart view.
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Some charts may require more than one value for each category-series pair; use this method to specify the dimensions.
This method is optional. If it is not implemented, a return value of 1 is assumed.

Parameters:
chartView An object representing the chart view requesting this information.

Returns:

The number of value dimensions in chartView. Default value is 1.

- (NSFormatter*) seriesFormatterForChartView: (MAChartView *)  chartView [optional]

Asks the datasource to return the formatter for series in the chart view.
This method is optional. If it is not implemented, there is no formatting on the series object.
Parameters:

chartView An object representing the chart view requesting this information.

Returns:

The NSFormatter object.

- (NSString*) titleForChartView: (MAChartView *)  chartView [required]

Asks the datasource to return the title of the chart view.
Parameters:
chartView An object representing the chart view requesting this information.

Returns:

The title of the chartView.

MAChartViewDelegate

Protocol of chart view delegate.
This protocol defines methods and properties that needs to be implemented by a chart view delegate.

Inherited by MAAnalyticChartView, and MAView.

Public Member Functions

(BOOL) - willRefreshDatalnChartView:

(void) - didRefreshDatalnChartView:
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(void) - chartViewWillBeginScrollingOrZooming:
(void) - chartViewDidEndScrollingOrZooming:

(NSUInteger) - visibleCategoryRangeOnLoadOfChartView:

(void) - chartView:didUpdateHorizontalRangeWithLowerBound:andUpperBound:
(void) - chartView:didUpdateVerticalRangeWithLowerBound:andUpperBound:
(BOOL) - chartView:willSelectCategory:

(void) - chartView:didSelectCategory:

(BOOL) - chartView:willDeselectCategory:

(void) - chartView:didDeselectCategory:

(BOOL) - chartView:willSelectSeries:

(void) - chartView:didSelectSeries:

(BOOL) - chartView:willDeselectSeries:

(void) - chartView:didDeselectSeries:

(BOOL) - chartView:willSelectDataltem:ofSeries:

(void) - chartView:didSelectDataltem:ofSeries:

(void) - chartView:didSelectDataltem:

(BOOL) - chartView:willDeselectDataltem:ofSeries:

(void) - chartView:didDeselectDataltem:ofSeries:
(BOOL) - willSelectltems:

(void) - chartView:didSelectltems:

(void) - categoryLevelChanged:

(BOOL) - chartView:didDoubleTapOnCategory:

(BOOL) - chartView:didDoubleTapOnSeries:

(BOOL) - chartView:didDoubleTapOnCategory:andSeries:
(void) - chartView:sortBySeries:

(void) - chartView:sortBySeriesName:

(void) - chartView:sortAscedingBySerieName:
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Member Function Documentation

- (void) categorylLevelChanged: (MAChartView *)  chartView [optional]

Tells the delegate that the treemap level has changed.
Parameters:

chartView An object representing the chart view requesting this information.

- (void) chartView: (MAChartView *)  chartView
didDeselectCategory: (NSUlnteger) categorylndex
[optional]

Tells the delegate that the specified category is now unselected.

Deprecated:

Parameters:
chartView An object representing the chart view requesting this information.
categorylndex An index corresponding to a category in chartView.

- (void) chartView: (MAChartView *)  chartView

didDeselectDataltem: (NSUInteger) dataltemIndex

ofSeries: (NSUlinteger) seriesIndex

[optional]

Informs the receiver that the data item is deselected.

Deprecated:

Parameters:
chartView An object representing the chart view requesting this information.
dataltemIndex An index corresponding to a data item within the series.
seriesindex  Anindex corresponding to a series based on all chart layers

Returns:

YES to unselect. NO otherwise.
- (void) chartView: (MAChartView *)  chartView

didDeselectSeries: (NSUInteger) seriesindex
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[optional]

Tells the delegate that the specified series is now deselected.
Parameters:
chartView An object representing the chart view requesting this information.

seriesindex An index corresponding to a series in chartView.

- (BOOL) chartView: (MAChartView *)  chartView
didDoubleTapOnCategory: (NSUinteger) categorylndex
[optional]

Tells the delegate that the specified category has been double-tapped.

Parameters:
chartView An object representing the chart view requesting this information.
categorylndex An index corresponding to a category in chartView.

Returns:

YES if the double-tap gesture has been processed.

- (BOOL) chartView: (MAChartView *)  chartView

didDoubleTapOnCategory: (NSUInteger) categorylndex

andSeries: (NSUInteger) seriesindex
[optional]

Tells the delegate that the specified category has been double-tapped.

Parameters:
chartView An object representing the chart view requesting this information.
categoryIndex An index corresponding to a category in chartView.
seriesindex  Anindex corresponding to a series in chartView.

- (BOOL) chartView: (MAChartView *)  chartView

didDoubleTapOnSeries: (NSUInteger) seriesindex
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[optional]

Tells the delegate that the specified series has been double-tapped.
Parameters:
chartView An object representing the chart view requesting this information.

seriesindex An index corresponding to a series in chartView.

- (void) chartView: (MAChartView *)  chartView
didSelectCategory: (NSUlInteger) categorylndex
[optional]

Tells the delegate that the specified category is now selected.

Parameters:
chartView An object representing the chart view requesting this information.
categorylndex An index corresponding to a category in chartView.

- (void) chartView: (MAChartView *)  chartView
didSelectDataltem: (NSUInteger) dataltemIndex

[optional]

Informs the receiver that the data item is selected.

Parameters:
chartView An object representing the chart view requesting this information.
dataltemIndex An index corresponding to a data item within the series.

- (void) chartView: (MAChartView *)  chartView
didSelectDataltem: (NSUlInteger) dataltemIndex
ofSeries: (NSUlInteger) seriesindex

[optional]

Informs the receiver that the data item is selected.

Parameters:
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chartView An object representing the chart view requesting this information.
dataltemIndex An index corresponding to a data item within the series.

seriesindex  Anindex corresponding to a series based on all chart layers

- (void) chartView: (MAChartView *) chartView
didSelectltems: (MAChartSelection *)  selection
[optional]

Informs the receiver that multiple items have been selected.

Parameters:
chartView An object representing the chart view requesting this information.

selection An object representing the selected items.

- (void) chartView: (MAChartView *)  chartView
didSelectSeries: (NSUInteger) seriesindex
[optional]

Tells the delegate that the specified series is now selected.

Parameters:
chartView An object representing the chart view requesting this information.

seriesindex An index corresponding to a series in chartView.

- (void) chartView: (MAChartView *)  chartView

didUpdateHorizontalRangeWithLowerBound: (float) lowerBound

andUpperBound: (float) upperBound
[optional]

Tells the receiver when the horizontal range has been updated.

Parameters:
chartView  An object representing the chart view requesting this information.

lowerBound Lower bound of the range (0 ~ 1).
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upperBound Upper bound of the range (0 ~ 1).

- (void) chartView: (MAChartView *)  chartView

didUpdateVerticalRangeWithLowerBound: (float) lowerBound

andUpperBound: (float) upperBound
[optional]

Tells the receiver when the vertical range has been updated.

Parameters:
chartView  An object representing the chart view requesting this information.
lowerBound Lower bound of the range (0 ~ 1).
upperBound Upper bound of the range (0 ~ 1).

- (void) chartView: (MAChartView *)  chartView

sortBySeries: (NSUinteger) seriesindex

[optional]

Tells the delegate to sort the specified series values.

Parameters:
chartView An object representing the chart view requesting this information.

seriesIndex An index corresponding to a series in chartView.

- (BOOL) chartView: (MAChartView *)  chartView
willDeselectCategory: (NSUInteger) categorylndex
[optional]

Tells the delegate that a specified category is about to be deselected.

Deprecated:

Parameters:
chartView An object representing the chart view requesting this information.

categorylndex An index corresponding to a category in chartView.

Returns:
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Return YES if you want the category deselected; NO if you do not.

- (BOOL) chartView: (MAChartView *)  chartView

willDeselectDataltem: (NSUlInteger) dataltemIndex

ofSeries: (NSUlnteger) seriesindex
[optional]

Queries whether to deselect data item.

Deprecated:

Parameters:

chartView An object representing the chart view requesting this information.

dataltemIndex An index corresponding to a data item within the series.
seriesindex  Anindex corresponding to a series based on all chart layers

Returns:

YES to deselect. NO otherwise.

- (BOOL) chartView: (MAChartView *)  chartView
willDeselectSeries: (NSUinteger) seriesIndex
[optional]

Tells the delegate that a specified series is about to be deselected.

Deprecated:

Parameters:

chartView An object representing the chart view requesting this information.

seriesindex An index corresponding to a series in chartView.

Returns:

Return YES if you want the series deselected; NO if you do not.

- (BOOL) chartView: (MAChartView *)  chartView
willSelectCategory: (NSUInteger) categorylndex
[optional]

Tells the delegate that a specified category is about to be selected.
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Deprecated:

Parameters:

chartView An object representing the chart view requesting this information.

categoryIndex An index corresponding to a category in chartView.

Returns:

Return YES if you want the category selected; NO if you do not.

- (BOOL) chartView: (MAChartView *)  chartView

willSelectDataltem: (NSUInteger) dataltemIndex

ofSeries: (NSUInteger) seriesindex
[optional]

Queries whether to select data item.

Deprecated:

Parameters:

chartView An object representing the chart view requesting this information.

dataltemIndex An index corresponding to a data item within the series.
seriesindex  Anindex corresponding to a series based on all chart layers.

Returns:

YES to select. NO otherwise.

- (BOOL) chartView: (MAChartView *)  chartView
willSelectSeries: (NSUInteger) seriesindex
[optional]

Tells the delegate that a specified series is about to be selected.

Deprecated:

Parameters:
chartView An object representing the chart view requesting this information.
seriesIindex An index corresponding to a series in chartView.

Returns:

Return YES if you want the series selected; NO if you do not.
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- (void) chartViewDidEndScrollingOrZooming: (MAChartView *)  chartView [optional]

Tells the delegate when scrolling or zooming ended in the chart view.
Parameters:
chartView An object representing the chart view requesting this information.

- (void) chartViewWillIBeginScrollingOrZooming: (MAChartView *)  chartView [optional]

Tells the delegate when the chart view is about to start scrolling or zooming the plot area content.
Parameters:
chartView An object representing the chart view requesting this information.

- (void) didRefreshDatalnChartView: (MAChartView *)  chartView [optional]

Tells the delegate that data in the chart view has been refreshed.
Parameters:
chartView An object representing the chart view requesting this information.

- (BOOL) willRefreshDatalnChartView: (MAChartView *)  chartView [optional]

Tells the delegate that data in the chart view is about to be refreshed.
Parameters:
chartView An object representing the chart view requesting this information.

Returns:

Return YES if you want the data refreshed; NO if you do not.

- (BOOL) willSelectltems: (MAChartView *)  chartView [optional]

Queries the receiver whether multiple items selection should be enabled.
Parameters:
chartView An object representing the chart view requesting this information.

Returns:

YES to enable mutiple items selection; NO otherwise.
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MADashboardItemView

Class of an dashboard item presented in a dashboard.

Public Member Functions

(void) - setSelected:animated:
Properties

NSIndexPath * indexPath

MADashboardView * dashboard

id< MADashboardTheme > theme

UlButton * selectButton
UlLabel * titleLabel
UlView * contentView
BOOL selected

Member Function Documentation

- (void) setSelected: (BOOL) selected

animated: (BOOL) animated

Selects the dashboard item.
Parameters:
selected If YES, selected; otherwise deselect

animated If YES, animates the transition; otherwise, does not.

Property Documentation

- (UlView*) contentView [read, write, retain]

The content view.
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- (MADashboardView*) dashboard [read, write, assign]

The dashboard in which the item should appear.

- (NSIndexPath*) indexPath [read, write, retain]

The index path locating the dashboard item in the dashboard.

- (UIButton*) selectButton [read, write, retain]

The select button.

- (BOOL) selected [read, write, assign]

A Boolean value indicating the selection state.

- (id<MADashboardTheme>) theme [read, write, retain]

The object acting as the theme of the dashboard.

- (UlLabel*) titleLabel [read, write, retain]

The title label.

MADashboardTheme

Protocol that defines the dashboard theme.

Inherited by MAKitTheme_WelterWeight.

Public Member Functions

(void) - drawSkinForDashboardltemView:context:rect:
(UIColor *) - dashboardBackgroundColor

(UIColor *) - dashboardBorderColor

(UIColor *) - dashboardltemTitleTextColor

(UIColor *) - dashboardltemBackgroundColor

(UIColor *) - dashboardltemBorderColor
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(CGRect) - selectButtonFrameForDashboardltemView:itemBounds:

(CGRect) - titleLabelFrameForDashboardltemView:itemBounds:

(CGRect) - contentFrameForDashboardltemView:itemBounds:
Properties

NSMutableDictionary *  sliderControlMinimumTrackThemes
NSMutableDictionary *  sliderControlMaximumTrackThemes

NSMutableDictionary *  sliderControlThumbThemes

Member Function Documentation

- (CGRect) contentFrameForDashboardltemView: (MADashboardltemView *) itemView
itemBounds: (CGRect) bounds
[optional]

Asks the theme object for the region whereby the content view should be drawn.
Parameters:
itemView An object representing the dashboard item view requesting the skin.

bounds The bounds of the drawing area.

- (void) drawSkinForDashboardltemView: (MADashboardltemView *)  itemView

context: (CGContextRef) context

rect: (CGRect) rect
[required]

Asks the theme object to draw skin for the dashboard item view.

Parameters:
itemView An object representing the dashboard item view requesting the skin.
context A CGContextRef for the graphic context.

rect The bounds of the drawing area.
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- (CGRect) selectButtonFrameForDashboardltemView: (MADashboardltemView *)  itemView
itemBounds: (CGRect) bounds
[optional]

Asks the theme object for the region whereby the dashboard item view is selected.
Parameters:
itemView An object representing the dashboard item view requesting the skin.

bounds The bounds of the drawing area.

- (CGRect) titleLabelFrameForDashboardltemView: (MADashboardltemView *)  itemView
itemBounds: (CGRect) bounds
[optional]

Asks the theme object for the region whereby the title label should be drawn.
Parameters:
itemView An object representing the dashboard item view requesting the skin.

bounds The bounds of the drawing area.

Property Documentation

- (NSMutableDictionary*) sliderControlIMaximumTrackThemes [read, write, retain]

Slider control maximum track image for different states.

- (NSMutableDictionary*) sliderControlMinimumTrackThemes [read, write, optional, retain]

Slider control minimum track image for different states.

- (NSMutableDictionary*) sliderControlThumbThemes [read, write, retain]

Slider control thumb image for different states.

MADashboardView

Class of a dashboard with its contents constructed from a dashboard datasource.
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Public Member Functions

(void) - reloadData

(UlLabel *) - titleLabelAtIndexPath:

(UlView *) - contentViewAtindexPath:

(void) - selectltemAtindexPath:animated:

(void) - deselecltemAtindexPath:animated:
Properties

id< MADashboardViewDelegate > delegate
id< MADashboardViewDataSource > dataSource

NSArray * contentViews

Member Function Documentation

- (UIView*) contentViewAtIndexPath: (NSIndexPath *)  indexPath

Returns the title label at the specified index path.
Parameters:
indexPath The index path locating the content view.

Returns:

A view representing the content of the specified dashboard item.
- (void) deselecltemAtindexPath: (NSIndexPath *)  indexPath

animated: (BOOL) animated

Deselects an item in the dashboard identified by index path.

Parameters:
indexPath The index path locating the dashboard item.
animated If YES, animates the transition; otherwise, does not.

- (void) selectltemAtindexPath: (NSIndexPath *)  indexPath

animated: (BOOL) animated
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Selects an item in the dashboard identified by index path.

Parameters:
indexPath The index path locating the dashboard item.
animated If YES, animates the transition; otherwise, does not.

- (UlLabel*) titleLabelAtIndexPath: (NSIndexPath *)  indexPath

Returns the title label at the specified index path.
Parameters:
indexPath The index path locating the title label.

Returns:

A label displaying the title of the specified dashboard item.

Property Documentation

- (NSArray*) contentViews [read, assign]

The dashboard items.

- (id<MADashboardViewDataSource>) dataSource [read, write, assign]

The object acting as the datasource of the dashboard view.

- (id<MADashboardViewDelegate>) delegate [read, write, assign]

The object acting as the delegate of the dashboard view.

MADashboardViewDataSource

Protocol of dashboard datasource delegate.

This protocol defines methods and properties that must be implemented by a dashboard datasource delegate. The
datasource provides the dashboard-view object with the information it needs to construct and modify a dashboard view.

Inherited by MAView.

195





MAKit Developer Guide: iOS 2013

Public Member Functions

(UlView *) - dashboardView:contentForltemAtindexPath:
(NSinteger) - numberOfitemsinDashboardView:

(NSString *) - dashboardView:titleForltemAtindexPath:

Member Function Documentation

- (UIView *) dashboardView: (MADashboardView *)  dashboardView
contentForltemAtindexPath: (NSIndexPath *) indexPath
[required]

Asks the datasource for an item content at a particular location of the dashboard view.
Parameters:
dashboardView A dashboard-view object requesting the item content.
indexPath An index path locating an item in dashboardView.

Returns:

An object inheriting from UlView that the dashboard view can use for the specified item content. An assertion is raised if you
return nil.

- (NSString *) dashboardView: (MADashboardView *)  dashboardView
titleForltemAtindexPath: (NSIndexPath *) indexPath
[optional]

Asks the datasource for an item title at a particular location of the dashboard view.
Parameters:
dashboardView A dashboard-view object requesting the item content.
indexPath An index path locating an item in dashboardView.

Returns:

The title string.

- (NSInteger) numberOfitemsIinDashboardView: (MADashboardView *)  dashboardView [required]

Asks the datasource to return the number of items in the dashboard view.
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Parameters:
dashboardView A dashboard-view object requesting the item content.

Returns:

The number of items in dashboardView.

MADashboardViewDelegate

Protocol of dashboard view delegate.

This protocol defines methods and properties that must be implemented by a dashboard view delegate. The delegate of
a MADashboardView object must adopt the MADashboardViewDelegate protocol.

Inherited by MAView.

Public Member Functions

(id< MADashboardTheme >) -themeForDashboardView:

(CGSize) - dashboardView:contentSizeWithFrameSize:

(CGRect) - dashboardView:frameForltemAtindexPath:withContentSize:
(BOOL) - dashboardView:isTitleVisibleAtIndexPath:

(BOOL) - dashboardView:isSelectButtonEnabledAtindexPath:
(BOOL) - dashboardView:willSelectltemAtindexPath:

(void) - dashboardView:didSelectltemAtindexPath:

(BOOL) - dashboardView:willDeselectltemAtindexPath:

(void) - dashboardView:didDeselectltemAtindexPath:

Member Function Documentation

- (CGSize) dashboardView: (MADashboardView *) dashboardView
contentSizeWithFrameSize: (CGSize) frameSize
[optional]

Asks the delegate to return the content size of the dashboard view.

If not implemented, frameSize is used as the default content size. Scrolling is enabled if content size is bigger than the
frameSize.
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Parameters:

dashboardView A dashboard-view object.

frameSize Size of the current dashboard content area in the dashboardView.

Returns:

Size of the content.

- (void) dashboardView: (MADashboardView *)  dashboardView
didDeselectltemAtindexPath: (NSIndexPath *) indexPath
[optional]

Tells the delegate that the specified item is now deselected.
Parameters:

dashboardView A dashboard-view object.

indexPath An index path that locates an item in dashboardView.
- (void) dashboardView: (MADashboardView *)  dashboardView
didSelectltemAtindexPath: (NSindexPath *) indexPath
[optional]

Tells the delegate that the specified item is now selected.
Parameters:

dashboardView A dashboard-view object.

indexPath An index path that locates an item in dashboardView.
- (CGRect) dashboardView: (MADashboardView *)  dashboardView
frameForltemAtindexPath: (NSIndexPath *) indexPath
withContentSize: (CGSize) contentSize
[optional]

Asks the delegate for the frame for a item in a specified location.
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Parameters:
dashboardView A dashboard-view object.
indexPath An index path that locates an item in dashboardView.
contentSize The dashboard content size.

Returns:

A rect representing a frame for the specified item.

- (BOOL) dashboardView: (MADashboardView *)  dashboardView
isSelectButtonEnabledAtindexPath: (NSIndexPath *) indexPath
[optional]

Asks the delegate whether the select button for an item in a specified location is visible.
Parameters:

dashboardView A dashboard-view object.

indexPath An index path that locates an item in dashboardView.

Returns:

YES if the select button is to be enabled.

- (BOOL) dashboardView: (MADashboardView *)  dashboardView
isTitleVisibleAtindexPath: (NSIndexPath *) indexPath
[optional]

Asks the delegate whether the title label for an item in a specified location is visible.
Parameters:

dashboardView A dashboard-view object.

indexPath An index path that locates an item in dashboardView.

Returns:

YES if the item title should be visible.

- (BOOL) dashboardView: (MADashboardView *)  dashboardView
willDeselectltemAtindexPath: (NSIndexPath *) indexPath
[optional]
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Tells the delegate that a specified item is about to be deselected.
Parameters:
dashboardView A dashboard-view object.
indexPath An index path that locates an item in dashboardView.

Returns:

A BOOL value that confirms the deselected item. Return YES if you want the item to be deselected. Return NO if you do not
want the item deselected.

- (BOOL) dashboardView: (MADashboardView *)  dashboardView
willSelectltemAtindexPath: (NSIndexPath *) indexPath
[optional]

Tells the delegate that a specified item is about to be selected.
Parameters:
dashboardView A dashboard-view object.
indexPath An index path that locates an item in dashboardView.

Returns:

A BOOL value that confirms the selected item. Return YES if you want the item to be selected. Return NO if you do not want
the item selected.

- (id<MADashboardTheme>) (MADashboardView *) dashboardVie [required
themeForDashboardView: w 1

Asks the delegate for the theme to use for the dashboard view.
Parameters:
dashboardView A dashboard-view object.

Returns:

An object implementing MADashboardTheme that the dashboard view can use for the specified theme.

MADiagramSpec

Class of diagram specifications.

Inherited by MAInfluenceDiagramSpec.
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Properties
NSString * name
MADiagramType diagramType

MADiagramDrawType drawType

MADiagramLineType lineType

uint diameter
uint lineWidth
NSString * query

Property Documentation

- (MADiagramType) diagramType [read, write, assign]

Type of diagram.

- (uint) diameter [read, write, assign]

Diameter of node in diagram.

- (MADiagramDrawType) drawType [read, write, assign]

Draw type of diagram.

- (MADiagramLineType) lineType [read, write, assign]

Line type of diagram.

- (uint) lineWidth [read, write, assign]

Width of line in diagram.

- (NSstring*) name [read, write, copy]

Name of diagram.

- (NSstring*) query [read, write, copy]
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Name of query.

MADiagramTheme

Protocol of diagram theme.

Inherited by MADiagramTheme_Vallina.

Public Member Functions

(Ullmage *) - alerticon

(Ullmage *) - largeNodeLayer0O

(Ullmage *) - largeNodeLayerl

(Ullmage *) - largeNodeLayer2

(Ullmage *) - largeNodeLabellmage
(Ullmage *) - largeNodeLabellLeftimage
(Ullmage *) - largeNodeLabelRightimage
(Ullmage *) - largeAxisimage

(Ullmage *) - largeScroller

(Ullmage *) - smallNodeLayer0

(Ullmage *) - smallNodelLayerl

(Ullmage *) - smallNodeLayer2

(Ullmage *) - smallNodelLabellmage
(Ullmage *) - smallNodeLabelLeftimage
(Ullmage *) - smallNodeLabelRightimage
(Ullmage *) - smallAxisimage

(Ullmage *) - miniNodeLayer0

(Ullmage *) - miniAxislmage

(UlColor *) - linkColor

(UlColor *) - backgroundColor

(UlColor *) - labelTextColor
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(UlFont *) - labelTextFont
(UIColor *) - valueTextColor
(UIFont *) - valueTextFont

(UlColor *) - pieFillingColor

Member Function Documentation

- (Ullmage*) alertlcon [required]

Image of alert icon.

- (UIColor*) backgroundColor [required]

Color of background.

- (UIColor*) labelTextColor [required]

Color of label text.

- (UIFont*) labelTextFont [required]

Font of label text.

- (Ullmage*) largeAxisimage [required]

Image of large axis.

- (Ullmage*) largeNodeLabellmage [required]

Image of lable of large node.

- (Ullmage*) largeNodeLabelLeftimage [required]

Image of left lable of large node.

- (Ullmage*) largeNodeLabelRightimage [required]

Image of right lable of large node.
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- (Ullmage*) largeNodeLayer0 [required]
Image of large node layerO.

- (Ullmage*) largeNodelLayer1 [required]
Image of large node layerl.

- (Ullmage*) largeNodelLayer2 [required]
Image of large node layer2.

- (Ullmage*) largeScroller [required]
Image of large scroller.

- (UIColor*) linkColor [required]

Color of link.

- (Ullmage*) miniAxisimage [required]
Image of mini axis.

- (Ullmage*) miniNodeLayer0 [required]
Image of mini node layer0.

- (UIColor*) pieFillingColor [required]
Color of filling pie.

- (Ullmage*) smallAxislmage [required]
Image of small axis.

- (Ullmage*) smallNodeLabellmage [required]

Image of lable of small node.

- (Ullmage*) smallNodeLabelLeftimage

[required]
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Image of left lable of small node.

- (Ullmage*) smallNodeLabelRightimage [required]

Image of right lable of small node.

- (Ullmage*) smallNodeLayer0 [required]

Image of small node layerO.

- (Ullmage*) smallNodeLayer1 [required]

Image of small node layer1l.

- (Ullmage*) smallNodeLayer2 [required]

Image of small node layer2.

- (UIColor*) valueTextColor [required]

Color of value text.

- (UIFont*) valueTextFont [required]

Font of value text.

MADiagramTheme_Vallina

Class of MAKit influence diagram theme: Vallina.
This class contains the Vallina theme. It is the default diagram theme provided by MAKIit.

Inherits <MADiagramTheme>.

MAError

Class of error information.
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Static Public Member Functions

(MAError *) + errroWithCode:andLevel:andDetails:

Properties

MAErrorCode errorCode
MAErrorLevel errorLevel

NSDictionary * errorDetails

Member Function Documentation

+ (MAError*) errroWithCode: (uint) code
andLevel: (uint) level
andDetails: (NSDictionary *) details

Create an MAError object.

Property Documentation

- (MAErrorCode) errorCode [read, write, assign]

The error code.

- (NSDictionary*) errorDetails [read, write, retain]

Detailed error information. Details can be accessed with predefined keys.

- (MAErrorLevel) errorLevel [read, write, assign]

The error level.

MAErrorHandlingDelegate

The MAKit error handler delegate.
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Public Member Functions

(void) - handleError:

Member Function Documentation

- (void) handleError: (MAError *)  error

Notifies the delegate when runtime error is detected.
Parameters:

error The error object that contains error information.

MAlInfluenceDiagramDelegate

Protocol of influence diagram delegate.

This protocol defines methods to be implemented by an influence diagram delegate.

Public Member Functions

(void) - didChangeValueOnMetricNode:actualValues:

(void) - didChangeValueOnMetricNodeDragEnd:actualValues:

(void) - didPanOnInfluenceDiagram:metricNodes:

(void) - didSelectOnMetricNode:aMetricNode:

(void) - didDoubleTapOnMetricNode:aMetricNode:associatedCharts:
(void) - didTapOninfluenceDiagramInSnapshotMode:

(void) - didSingleTapOnMetricNode:aMetricNode:

Member Function Documentation

- (void) didChangeValueOnMetricNode: (MAInfluenceDiagramView *)  influenceDiagram
actualValues: (NSDictionary *) values

[optional]

A event is triggered when the values of nodes are changed during goal seek.
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Parameters:

influenceDiagram The instance of influence diagram.

actualValues A dictionary with node name as key and changed actual value as value.
- (void) didChangeValueOnMetricNodeDragEnd: (MAInfluenceDiagramView *)  influenceDiagram
actualValues: (NSDictionary *) values
[optional]

A event is triggered when the values of nodes are changed after goal seek.

Parameters:

influenceDiagram The instance of influence diagram.

actualValues A dictionary with node name as key and changed actual value as value.
- (void) didDoubleTapOnMetricNode: (MAInfluenceDiagramView *) influenceDiagram
aMetricNode: (NSString *) node
associatedCharts: (NSArray *) charts
[optional]

A event is triggered when a node with associated charts is double-tapped.

Parameters:
influenceDiagram The instance of influence diagram.
aMetricNode The name of the node double-tapped.

associatedCharts A list of chart names associated with the node double-tapped.

- (void) didPanOnInfluenceDiagram: (MAInfluenceDiagramView *)  influenceDiagram
metricNodes: (NSArray *) nodes
[optional]

A event is triggered when the influence diagram is panned.

Parameters:
influenceDiagram The instance of influence diagram.

metricNodes A list of node names that are visible in the view after panning.
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- (void) didSelectOnMetricNode: (MAInfluenceDiagramView *)  influenceDiagram
aMetricNode: (NSString *) node
[optional]

A event is triggered when a new node is selected.
Parameters:

influenceDiagram The instance of influence diagram.

aMetricNode The name of new selected node.
- (void) didSingleTapOnMetricNode: (MAInfluenceDiagramView *) influenceDiagram
aMetricNode: (NSString *) node

[optional]

A event is triggered when a node is single-tapped.
Parameters:

influenceDiagram The instance of influence diagram.

aMetricNode The name of the node single-tapped.
- (void) (MAInfluenceDiagramView influenceDiagra [optional
didTapOninfluenceDiagramInSnapshotMode: *) m 1

A event is triggered when tapping the influence diagram in snapshot mode.
Parameters:

influenceDiagram The instance of influence diagram.

MAlInfluenceDiagramNode

Class of influence diagram node.

Properties
NSString * formulaKey
NSString * name
NSString * parentNode
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NSString * text
NSString * expression
NSString * format
BOOL root
NSString * charts

NSMutableArray * nodeTos

Property Documentation

- (NSstring*) charts [read, write, copy]

A list of chart names associated with node.

- (NSString*) expression [read, write, copyl

Goal seek expression of node.

- (NSstring*) format [read, write, copy]

Display format of node.

- (NSString*) formulaKey [read, write, copy]

Formula key of node.

- (NSString*) name [read, write, copy]

Name of node.

- (NSMutableArray*) nodeTos [read, write, retain]

An array of nodes that node points to.

- (NSString*) parentNode [read, write, copy]

Parent node of node.
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-(BOOL)root [read, write, assign]

Whether node is root node.

- (NSsString*) text [read, write, copy]

Display text of node.

MAlInfluenceDiagramNodeTo

Class of influence diagram nodeTo node.

Properties

NSString* name

Property Documentation

- (NSString*) name [read, write, copyl

Name of node.

MAlInfluenceDiagramSpec

Class of influence diagram specifications.

Inherits MADiagramSpec.

Properties

NSMutableArray * nodes

Property Documentation

- (NSMutableArray*) nodes [read, write, retain]

An array of nodes in diagram.
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MAlInfluenceDiagramView

Influence diagram view class.

Inherits <MAMetricNodeViewDelegate>.

Public Member Functions

(id) - initWithFrame:metaDataFile:viewMode:

(id) - initWithFrame:viewMode:

(id) - initWithFrame:

(void) - setNeedsDisplay:

(void) - reloadData

(void) - setAlertForNodes:

(void) - setSelectedNode:

(void) - resetActualValues
Properties

NSString * metaDataPath

MAInfluenceDiagramMode viewMode

MADiagramSpec * metaDataSpec

NSMutableDictionary * metaDict

id< MAlInfluenceDiagramDelegate > delegate
id< MAQueryDelegate > dataSource

id< MADiagramTheme > theme

Member Function Documentation

- (id) initWithFrame: (CGRect) frame

A constructor of influence diagram with frame.

Parameters:
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frame The frame of influence diagram.

- (id) initWithFrame: (CGRect) frame
metaDataFile: (NSString *) filePath
viewMode: (MAlInfluenceDiagramMode) mode

A constructor of influence diagram with frame, metadata file path, and view mode.

Parameters:
frame The frame of influence diagram.
metaDataFile The metadata file path of influence diagram.
viewMode  The view mode of influence diagram.

- (id) initWithFrame: (CGRect) frame

viewMode: (MAInfluenceDiagramMode) mode

A constructor of influence diagram with frame and view mode.
Parameters:
frame The frame of influence diagram.
viewMode The view mode of influence diagram.

- (void) reloadData

Refreshs the diagram view.

Call this method to reload data from the datasource in an asynchornous thread and redraw the view.

- (void) setAlertForNodes: (NSDictionary *)  alertNodes

Set number of alerts for nodes.

Parameters:

alertforNodes A dictionary with node name as key and number of alerts as value.

- (void) setNeedsDisplay: (BOOL) animated

Redraw the diagram view.

Parameters:
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animated Whether to display animation.

- (void) setSelectedNode: (NSString *)  node

Set new selected node.
Parameters:

The Name of the selected node.

Property Documentation

- (id<MAQueryDelegate>) dataSource [read, write, retain]

Datasource of diagram.

- (id<MAlInfluenceDiagramDelegate>) delegate [read, write, assign]

Delegate of diagram.

- (NSString*) metaDataPath [read, write, copy]

Metadata file path.

- (MADiagramSpec*) metaDataSpec [read, write, retain]

Metadata specification of diagram.

- (NSMutableDictionary*) metaDict [read, write, retain]

Metadata dictionary of diagram.

- (id<MADiagramTheme>) theme [read, write, retain]

Theme of diagram.

- (MAInfluenceDiagramMode) viewMode [read, write, assign]

View mode of diagram.
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MAKitTheme_WelterWeight

Class of MAKit theme: WelterWeight.
This class contains the WelterWeight theme, which is one of the chart themes provided by MAKit.
Inherits <MAChartTheme>, and <MADashboardTheme>.

Inherited by MAKitTheme_WelterWeightDark.

MAKitTheme_WelterWeightDark

Class of MAKIt theme: WelterWeight Dark.

Inherits MAKitTheme_WelterWeight.

MALog

Class for logging.

Static Public Member Functions

(void) + performanceTrace:
(void) +trace:

(void) +verbose:

(void) +forceTrace:

(void) + error:

(void) +warning:

(int) + setTracelLevel:

(int) + getTracelLevel

Member Function Documentation

+ (void) error: (NSString *) format

) NS_REQUIRES_NIL_TERMINATION

Logs an error message to the Apple System Log facility regardless of trace level. Error messages are prefixed with ###.
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Note: You must end the argument list with nil, for example, [MALog error:"somestring”, nil ].

+ (void) forceTrace: (NSString *) format

, NS_REQUIRES_NIL_TERMINATION

Logs a message to the Apple System Log facility regardless of trace level.

Note: You must end the argument list with nil, for example, [MALog trace:"somestring", nil ].

+ (int) getTracelLevel

Returns the trace level.

+ (void) performanceTrace: (NSString *) format

) NS_REQUIRES_NIL_TERMINATION

Logs a performance message to the Apple System Log facility only if trace level is 3.

Note: You must end the argument list with nil, for example, [MALog trace:"somestring", nil ].

+ (int) setTraceLevel: (int) newTraceLevel

Sets the trace level; whereby 0 indicates no tracing and 1 or greater creates trace messages.

+ (void) trace: (NSString *) format

, NS_REQUIRES_NIL_TERMINATION

Logs a message to the Apple System Log facility only if trace level is less than or equal to 2.

Note: You must end the argument list with nil, for example, [MALog trace:"somestring", nil ].

+ (void) verbose: (NSString *) format

, NS_REQUIRES_NIL_TERMINATION

Logs a message to the Apple System Log facility only if trace level is equal to 2.

Note: You must end the argument list with nil, for example, [MALog trace:"somestring", nil ].
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+ (void) warning: (NSString *) format

, NS_REQUIRES_NIL_TERMINATION

Logs a waning message to the Apple System Log facility regardless of trace level. Warning messages are prefixed with ===.

Note: You must end the argument list with nil, for example, [MALog warning:"somestring", nil ].

MAMailSharingController

Class to share an image of a view via an e-mail message.

Public Member Functions

(void) - pushSharingControllerWithViewController:andDelegate:forView:

Properties

NSString * subject

Member Function Documentation

- (void) (UlViewController *)
pushSharingControllerWithViewController:

andDelegate: (id<
MFMailComposeViewControllerDelegate >)

forView: (UlView *)

Pushes a sharing controller onto the receiver’s stack and updates the display.
Parameters:

controller The current view controller.

mailDelegate The object that acts as the mail delegate.

View The view image used as the mail attachment.

Property Documentation

- (NSString*) subject [read, write, copy]
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The string used as the subject of the mail.

MAMetaDictionaryFactory

Class to construct metadata from property file.

Static Public Member Functions

(void) + populateMetaTable:FromDictionary:

Member Function Documentation

+ (void) populateMetaTable: (MAMetaDataTable *) table

FromDictionary: (NSMutableDictionary *) metaDict

Populate the metadata table with dictionary obtained from properties file.

Parameters:
Table Metadata table.
metaDict Metadata dictionary.

MAMetricNodeViewDelegate

Protocol of delegate for metric node view.

Inherited by MAInfluenceDiagramView.

Public Member Functions

(void) - handleSingleTapOnNode:

(void) - handleDoubleTapOnNode:

(void) - didChangeValueForGoalSeekNode:newValue:
(void) - touchesBeginOnGoalSeekNodeDial:

(void) - touchesEndedOnGoalSeekNodeDial:

(void) - EditBeginsOnGoalSeekNodeTextField:

(void) - EditEndedOnGoalSeekNodeTextField:
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MAQueryDataTable

Protocol that retrieves data for chart rendering.

Public Member Functions

(int) - getColumnCount

(int) - getRows

(id) - getData:atindex:

(UlView *) - getAccessoryViewAtIndex:seriesindex:
Properties

BOOL sorted

NSNumber * upperThreshold
NSNumber * lowerThreshold
NSNumber * referenceValue

id predictiveStartCategory

Member Function Documentation
- (UIView*) getAccessoryViewAtIindex: (int)

seriesindex: (int)

Gets the accessory view by row index.
Parameters:
categorylndex Category index.
serindex Series index.

Returns:

Accessory view. If no acessory is required for the specified rowindex, nil is returned.

- (int) getColumnCount [required]

categorylndex

serindex

[optional]
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Get column number in the data table.

Returns:

Column count.

- (id) getData: (NSString *)  colName
atindex: (int) rowlndex
[required]

Get data by column name and row index.
Parameters:
colName Requested column name.
rowindex Row index in the data table.

Returns:

Data of assigned column. If the column or rowlndex does not exist, nil is returned.

- (int) getRows [required]

Get row number in the data table.

Returns:

Row count.

Property Documentation

- (NSNumber*) lowerThreshold [read, write, retain]

The lower threshold.

- (id) predictiveStartCategory [read, write, retain]

Category from which predictive data starts.

- (NSNumber*) referenceValue [read, write, retain]

The reference value.

-(BOOL) sorted [read, write, optional, assign]
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Whether data in this table is already sorted for the chart.

- (NSNumber*) upperThreshold [read, write, retain]

The upper threshold.

MAQueryDelegate

Protocol of query used to retrieve chart data.

Public Member Functions

(id< MAQueryDataTable >) - executeQuery:withArgument:

Member Function Documentation

- (id<MAQueryDataTable>) executeQuery: (NSString *) gueryName

withArgument: (NSDictionary *)  args

Executes the query and returns the query result.
Parameters:
gueryName Query to be executed.
args Arguments for the query.

Returns:

id<MAQueryDataTable> object. If queryName is not defined, nil is returned.

MAShape

Protocol of chart basic shape.

This protocol defines methods and properties to be implemented by a chart shape. A chart shape is responsible for painting
the basic element for a chart series. For example, a shape can be a column/bar, a line, or a pie piece. It provides users with
a way to customize the chart look and feel. Users may implement this protocol to create their own drawings for a basic
shape, for example, a pencil shape for a column chart.

Public Member Functions

(void) - drawInContext:model:
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Member Function Documentation

- (void) drawlInContext: (CGContextRef) context

model: (MAShapeModel *)  model

Draws the shape using the specified shape model.
Parameters:
context Drawing context.

model Shape model.

MAShapeModel

Class of model for shape.

Properties

UlColor * fillColor

UlColor * borderColor
CGRect  bounds

CGFloat dashPatternWidth
CGFloat dashStartingXValue

int lineWidth

Property Documentation

- (UIColor*) borderColor [read, write, retain]

The border color.

- (CGRect) bounds [read, write, assign]

The bounds.

- (CGFloat) dashPatternWidth [read, write, assign]
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The width of dash pattern.

- (CGFloat) dashStartingXValue [read, write, assign]

The starting x-coordinate to draw dash pattern.

- (UIColor*) fillColor [read, write, retain]

The fill color.

- (int) linewidth [read, write, assign]

The width of the border.

MATabularCategoryChartBasePainter

Base painter for drawing categories in a tabular format in the left area.

Inherits <MAChartBasePainter>.

Inherited by MAXValueCartesianChartBasePainter.

Public Member Functions

(UlColor *) - dataGridBackgroundColor
(UIColor *) - headerBackgroundColor

(UIColor *) - catgeoryTextColor

Member Function Documentation

- (UIColor*) catgeoryTextColor

The color of the data grid text.

- (UIColor*) dataGridBackgroundColor

The background color of the data grid.

- (UIColor*) headerBackgroundColor

The color of the data grid header.
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MAValueBubbleLegendViewDelegate

Protocol of delegate for value bubble legend view.

Inherited by MAXValueCartesianChartBasePainter.

Public Member Functions

(void) -legendView:didSelectltem:

(void) -legendView:didDeselectltem:

Member Function Documentation

- (void) legendView: (MAValueBubbleLegendView *)

didDeselectltem: (NSUlnteger)

Notifies the receiver that a legend item has been deselected.
Parameters:
legendView A legend view notifing the delegate.
itemindex Index of item deselected.

- (void) legendView: (MAValueBubbleLegendView *)

didSelectltem: (NSUInteger)

Notifies the receiver that a legend item has been selected.
Parameters:

legendView A legend view notifing the
delegate.

itemIndex Index of item selected.

MAView

VView class that contains main functions of MAKit.

legendView
itemIndex

[optional]

legendView
itemIndex

[optional]
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MAView accepts MAKit metadata configurations and renders a dashboard or a single chart with analytic features based on
the configurations.

Code Example

MAView *view = [[MAViewController alloc] initWithFrame:CGRectMake (0, 0, 500, 500)];
view.metaDataPath = [[NSBundle mainBundle] pathForResource:@"MAMeta" ofType:@"xml"];
view.theme = [[[MAKitTheme WelterWeight alloc] init] autorelease];

[view refresh];

Inherits <MADashboardViewDelegate>, <MADashboardViewDataSource>, and <MAChartViewDelegate>.

Public Member Functions

(void) - refresh
Properties

NSString * metaDataPath

NSMutableDictionary * metaDict

id< MAChartTheme,

MADashboardTheme > theme
id< MAQueryDelegate > dataSource
UlViewController * controller

id< MAErrorHandlingDelegate > errorHandler

id< MAViewDelegate > delegate

Property Documentation

- (UlViewController*) controller [read, write, assign]

View controller.

- (id<MAQueryDelegate>) dataSource [read, write, retain]

Datasource object.

- (id<MAErrorHandlingDelegate>) errorHandler [read, write, retain]

The error handler delegate.
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- (NSString*) metaDataPath [read, write, retain]

Metadata file path.

- (NSMutableDictionary*) metaDict [read, write, retain]

A dictionary of metadata definition.

- (id<MAChartTheme, MADashboardTheme>) theme [read, write, retain]

Theme of charts and dashboard in the view.

MAViewController

View controller class that contains main functions of MAKit.

MAViewController accepts MAKIt metadata configurations and renders a dashboard or a single chart with analytic features
based on the configurations.

Code Example

MAViewController *viewController = [[MAViewController alloc] init];
viewController.metaDataPath = [[NSBundle mainBundle] pathForResource:@"MAMeta"
ofType:@"xml"];

viewController.theme = [[[MAKitTheme WelterWeight alloc] init] autorelease];

Public Member Functions

(void) - refresh
Properties

NSString * metaDataPath

NSMutableDictionary * metaDict

id< MAChartTheme,
MADashboardTheme > theme

id< MAQueryDelegate > dataSource
id< MAErrorHandlingDelegate > errorHandler

id< MAViewDelegate > delegate
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Property Documentation

- (id<MAQueryDelegate>) dataSource [read, write, retain]

Datasource object.
- (id<MAViewDelegate>) delegate [read, write, assign]
The object that acts as the delegate of the receiving dahboard view.

- (id<MAErrorHandlingDelegate>) errorHandler [read, write, retain]

The error handler delegate.

- (NSString*) metaDataPath [read, write, retain]

Metadata file path.

- (NSMutableDictionary*) metaDict [read, write, retain]

A dictionary of metadata definition.

- (id<MAChartTheme, MADashboardTheme>) theme [read, write, retain]

Theme of charts and dashboard in the view controller.

MAViewDelegate

Protocol of delegate for MAView class.

Public Member Functions

(BOOL) - willRefreshDatalnView:
(void) - didRefreshDatalnView:

(void) - charView:singleTapRow:column:

Member Function Documentation

- (void) didRefreshDatalnView: (MAView *) view [optional]
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Tells the delegate that data in the dashboard view has been refreshed.
Parameters:
view An object representing the dashboard view requesting this information.

- (BOOL) willRefreshDatalnView: (MAView *)  view [optional]

Tells the delegate that data in the dashboard view is about to be refreshed.

This event is invoked whenever the refresh button of MAView is being pressed. The event is not invoked when MAView is
first loaded or when the data refresh is due to drilldown or filtering.

Parameters:
view An object representing the dashboard view requesting this information.

Returns:

Return YES if the data should be refreshed

-(void)chartView: (MAChartView *)  chartView singleTapRow:(NSUInteger)rowindex [optional]
column:(NSUInteger)columnindex

Tells the delegate that a row of RFTable is tapped.
Parameters:

ChartView An object representing the chart view requesting this information.

MAXValueCartesianChartBasePainter

Base painter for charts with values as the x-axis and categories as the y-axis.

Inherits MATabularCategoryChartBasePainter, <MAChartBasePainter>, <MACartesianChartPainter>,
and <MAValueBubbleLegendViewDelegate>.

Public Member Functions

(CGFloat) - categoryHeight

Member Function Documentation

- (CGFloat) categoryHeight

Gets the height of each category row.
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Introduction

Mobile Analytics Kit (MAK:it) allows users to graphically view data in different types of charts. The MAKit
Tutorial: iOS Metadata-Driven Development is to help developers quickly understand MAKit concepts,
and expedite application development. MAKit, which lets users graphically view data and modify chart
values to examine “what-if” scenarios, is distributed as a static library on the iPhone/iPad. MAKit can be
used with the SAP® Mobile Platform Hybrid Web Container.

Prerequisites
Before beginning the tutorials:

e  Verify that you are running Intel-based Mac 10.6 or higher.
e Install Xcode 4.0 with iOS 4.3 SDK.

e Copy the latest iOS Mobile Analytics Kit (MAKit) build (library and header files) to a local Mac
machine.

e On alocal Mac machine, copy the iOS MAK:it build to /Users/<username>/MAKit, where
<username> is the user who is currently logged in.

e Download and unzip MAKitTutorialDatabase.zip to a local folder on the Mac. This file contains
the SQLite® database MAKitTutorials.sqlite, which is used in the tutorial.

e C(Createa /Users/<username>/MAKitTutorial folder.

Note: All the path information in the tutorial is based on /Users/<username>/MAKitTutorial. If you
create the sample on a different folder, adjust the path according to your local settings.

Lesson 1: Setting Up the iOS Development Environment for MAKit

This lesson describes:

e Creating a new project in Xcode 4.0 IDE
e Adding files to the Xcode project

e Adding MAKit libraries and header files
e Changing the project build settings

Note: This tutorial is developed using Xcode 4.0 and iOS SDK 4.3. If you use a different version of Xcode,
some steps may vary. For more information on Xcode, see the Apple Developer Connection at
http://developer.apple.com/technologies/tools/xcode.html.

1. Start Xcode and select File > New > New Project.
2. Select iOS Application and Window-based Application as the project template, then click Next.

3. Enter MAKitSample as the product name, and iPad as the device family. Select Use Core Data,
unselect Include Unit Tests, then click Next.

4. Save the projectin /Users/<username>/MAKitTutorial, then click Create to open it.
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10.

Xcode creates a folder called MAKitSample, which contains a project file called
MAKitSample.xcodeproij and a subfolder called MAKitSample, which contains all the
Xcode-generated files in the /Users/<username>/MAKitTutorial folder.

After finishing this step, the project looks similar to this in Xcode:

800
@ (M ) | MAKitSample | iPad 4.3 Simu... ;| [ m® |
= .
Run Stop Scheme Breakpoints
| m | T & a = = B |::::|-4 thI‘uMKitSample
W e pc— PROJECT
. . "
- MAKitSample i
| |MAKitSample —
@ MAKitsampleAppDelegate.h TARGETS
@ MAKitSampleAppDelegate.m Fﬁﬂ
o MainWindow.xib
|| MAaKitsample.xcdatamodeld
| _|5upporting Files
| | Frameworks C

| | Products

In the Xcode Project Navigator, right-click MAKitSample and select Add Files to “MAKitSample”.

Navigate to the folder containing the SQLite database, select MAKitTutorials.sqlite, select Copy
items into destination group's folder (if needed), and click Add.

This adds the MAKitTutorials.sqglite database to the project.
Right-click the Frameworks folder of the MAKitSample project and select Add Files to
“MAKitSample”. Navigate to /Users/<username>/MAKit/libs/Debug-iphonesimulator

folder, select the 1ibMAKit.a library, unselect Copy items into destination group's folder (if
needed), and click Add.

This adds 1ibMAKit.a tothe Frameworks folder of the project.

Right-click the project root, select New Group, and rename it Resources.

Right-click the Resources folder and select Add Files to “MAKitSample”. Navigate to
/Users/<username>/MAKit, select the MAKit .bundle file, select Copy items into destination
group's folder (if needed) and click Add.

This adds the MAKit.bundle file to the Resources folder.
Click the project root and in the middle pane, click the MAKitSample target.

a. Intheright pane, click the Build Settings tab, then scroll down to the Search Paths section.
b. Double-click Library Search Paths.

This populates the Library Search Paths with $SRCRoot/../../MAKit/1libs/Debug-
iphonesimulator for the 1ibMAKit.a library.

6|Page





Search Paths

Always Search User Paths No No
Framework Search Paths

Header Search Paths

Library Search Paths “fUsersfaabdul /MAKITTut... "/Users/aabdul /MAKitTutorial /MAKitSample/../../ MAKit/li...

Rez Search Paths | Recursive  Path

S(inherited)
"S(SRCROOT)/../../MAKit/libs /Debug-iphonesimulator”

Sub-Directories to Exclude in Recursiv... *.nib *.lproj *.framework *.g|

oo

Sub-Directories to Include in Recursive. ..
User Header Search Paths

Unit Testing ]
Other Test Flags

Test After Build No
Test Host

Test Rig

) | Done
Versioning .

c. Replace the text Debug-iphonesimulator with $ (BUILD STYLE)-$ (PLATFORM NAME)
macros and click Done.

| Recursive Path
[] L(inherited)
O “S(SRCROOT)/../../MAKit/libs/ S(BUILD_STYLE}-5(PLATFORM_MAME)"

Daone

d. Double-click the Header Search Paths property entry, click the + icon, enter the location of
the MAK:it header files, such as $ (SRCROOT) /../../MAKit/includes, and click Done.

Search Paths
Always Search User Paths No No 7
Framework Search Paths
Header Search Paths
Library Search Paths <Multiple values> | Recursive | Path
Debug “/Users/aabdul IMAKITTUL, - ¢ cRCROOT).../.. /MAKit/includes
Release “fUsers faabdul /{MAKitTut]
Rez Search Paths
Sub-Directories to Exclude in Recursiv... *.nib *.lproj *.framework *.g|
Sub-Directories to Include in Recursive...
User Header Search Paths +
Unit Testing

Other Test Flags

Done
Tact Aftar Ruild YR

11. Inthe middle pane, click the MAKitSample target.

a. Inthe right pane, select the Build Phases tab, then expand the Link Binary with Libraries
section.
b. Click the + icon below the list, select the following frameworks, and click Add to add them
from the iOS 4.3 SDK to the project:
=  MessageUl.framework
= QuartzCore.framework
=  libsqlite3.0.dylib
12. Drag the frameworks you added in step 11 to the Frameworks folder.

After completing these steps, the Project Navigator looks similar to:
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ao0o0

f!\

) (M) [MAKitSample | iPad 4.3
Run Stop Scheme

m @ A = = B

o m—— T T

43 3l

| MAKitTutorials.sglite
| | Resources
MAKIt.bundle
| | MAKitsample
| | Frameworks
* libMAKit.a
| libsglite3.0.dylib
= MessageUl.framework
[? QuartzCore._framework

-

B= UIKit.framework
§= Foundation.framework
= CoreGraphics.framework
= CoreData.framework

| | Products

13. Select Product > Clean, then Product > Build to test the initial setup. If you correctly followed all
the steps, you see a Build Succeeded message.

Lesson 2: Building Basic MAKit Charts Using Metadata

This lesson describes:

e Creating the ChartsDatasource class

e Creating an XML metadata file containing charts configuration
e Implementing the MAKit Query module for charts

e Configuring the user interface for the iOS application

e The build and execute procedure

Creating ChartsDatasource Class

Create the ChartsDatasource class to include a method to connect to the tutorial database
MAKitTutorials.sqlite, and methods to retrieve data for the charts configured in the XML metadata
file. The methods implemented in this class are called by the MAKit Query module.

Tip: To create the ChartsDatasource file, copy and paste the code below.
1. Openthe MAKitSample.xcodeproj inthe Xcode IDE.
2. Inthe MAKitSample project, select File > New > New File.
3. Select iOS > Cocoa Touch > Objective-C class and click Next.
4. Accept NSObject in the Subclass of field and click Next.
5

Enter ChartsDatasource in the Save As field and click Save.
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This creates ChartsDatasource.h and ChartsDatasource.m files in the Project Navigator.

6. Click chartsDatasource.h and replace the existing code with:

#import <Foundation/Foundation.h>
#import "sqglite3.h"

@interface ChartsDatasource : NSObject {
sglite3 *dbInstance;
}

//Database Methods
- (void) OpenDatabase;
- (void) CloseDatabase;

// Basic Charts Datasource Methods
- (NSArray *) NumberOfOrders;

- (NSArray *) SalesPerformance;

@end

7. Click File > Save.

8. Click chartsDatasource.mand replace the existing code with:
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#import "ChartsDatasource.h"

@implementation ChartsDatasource

//Open Database connection & assign to pointer dbInstance variable
- (void) OpenDatabase {

@try {

NSArray *path = NSSearchPathForDirectoriesInDomains (NSDocumentDirectory,
NSUserDomainMask, YES);

NSString *documentDir = [path objectAtIndex:0];

NSString *dbPath = [documentDir stringByAppendingPathComponent:
@"MAKitTutorials.sqglite"];

if (sglite3 open v2([dbPath UTF8String], &dbInstance, SQLITE OPEN NOMUTEX,
NULL) == SQLITE OK) {
NSLog (@"Database Open Succeeds");
}
else {
sglite3 close (dbInstance);

}

}
@catch (NSException * e) {
NSLog (@"Failed to open the database. Reason %@", [e reason] );

}
}

//Close Database connection

- (void) CloseDatabase {
sqlite3 close (dbInstance);

}

-(id) init {
if (self == [super init]) {
dbInstance = nil;
[self OpenDatabase];
}
return self;

}
- (void) dealloc {

[self CloseDatabase];
NSLog (@"Database Closed");
[super dealloc];

}

//Sales Order Count by Year
- (NSArray *) NumberOfOrders {

NSMutableArray *returnArray = [[NSMutableArray alloc] initl];
const char * SELECTQry = "SELECT strftime('%Y',OrderDate) as OrderYear, Region,

Count (OrderID) from SalesOrder Header "
" Group By strftime('%Y',OrderDate),Region

".
’

sglite3 stmt *selectStmt = nil;

if (sglite3 prepare v2(dbInstance, SELECTQry, -1, &selectStmt, NULL)==SQLITE OK) {
NSString *year = @"";
NSString *region = @"";

int ordercount=0;
while (sglite3 step(selectStmt)==SQLITE ROW) {
year = [NSString stringWithUTF8String: (char *)
sglite3 column text (selectStmt, 0)];
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region = [NSString stringWithUTF8String: (char *)
sgqlite3 column text (selectStmt, 1)];

ordercount = sglite3 column_ int (selectStmt, 2);

NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];
[dict setObject:year forKey:@"Year"];
[dict setObject:region forKey:@"Region"];
[dict setObject: [NSNumber numberWithInt:ordercount] forKey:@"OrderCount"];
[returnArray addObject:dict];
[dict release];
}

}

else {
NSLog (@"Failed at Prepare Statement in NumberOfOrders.

Reason %s",sglite3 errmsg(dbInstance));
}

return returnArray;
}

//Sales Performance by Product/Region
- (NSArray *) SalesPerformance {

NSMutableArray *returnArray = [[NSMutableArray alloc] init];

const char * SELECTQry = "SELECT Region,ProductType, sum(UnitPrice * Quantity)
FROM SalesOrder Header oh, SalesOrder Details od, Product p "
" WHERE oh.OrderID = od.OrderID AND od.ProductID = p.ProductID "
" GROUP BY Region, ProductType ";

sqlite3 stmt *selectStmt = nil;

if (sglite3 prepare v2(dbInstance, SELECTQry, -1, &selectStmt, NULL)==SQLITE OK) {
NSString *region = @"";
NSString *product = @"";
float salesamount = 0.0;
while (sglite3 step(selectStmt)==SQLITE ROW) {
region = [NSString stringWithUTF8String: (char *)
sglite3 column text (selectStmt, 0)];
product = [NSString stringWithUTF8String: (char *)
sglite3 column text (selectStmt, 1)];
salesamount = sglite3 column double (selectStmt, 2);

NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];

[dict setObject:region forKey:@"Region"];

[dict setObject:product forKey:@"ProductType"];

[dict setObject: [NSNumber numberWithFloat:salesamount]
forKey:@"SalesAmount"];

[returnArray addObject:dict];

[dict release];
}
}

else {
NSLog (@"Failed at Prepare Statement in SalesPerformance.
Reason %s",sglite3 errmsg(dbInstance));
}

return returnArray;

}

@end

9. Click File > Save.

Creating the XML Metadata File
The XML metadata file includes the:
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e  Charts configuration, which includes the chart name, the query for the chart that pumps the data,
and the chart’s category, series, and value axis information. The chart configuration resides in the
<dashboard> .. </dashboard>tag.

e Dashboard screen layout, for both landscape and portrait modes, which is configured in the
<DashboardLayout> .. </DashboardLayout>tag.

1. Inthe MAKitSample project, click File > New > New File.

2. Select iOS > Other > Empty and click Next.

3. Enter SalesMetadata.xml in the Save As field and click Save.
This creates the SalesMetadata.xml file.

4. Click salesMetadata.xml and add this content to the file:

<?xml version="1.0" encoding="utf-8"?2>
<MobileAnalytic MAKitVersion="1.1" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation="MAKitMetaFile.xsd">

<!-- Dashboard Charts configuration -->
<Dashboard>
<!-- Column Chart configuration for Number of Sales Orders by Year -->

<Chart Name="SalesOrderCount" Title="Number of Sales Orders" ChartType="Column"
Query="OrderCount">

<Category Format="" Column="Year" DisplayName="Sales Year" />
<Series Format="" Column="Region" DisplayName="Region" />
<Values>

<Value Format="RoundedO" Expression="OrderCount" ValueSequence="1" DisplayName="# of
Order for year" />
</Values>
</Chart>

<!-- Line Chart configuration for Sales Performance -->
<Chart Name="SalesPerformance" Title="Sales Performance By Region" ChartType="Line"
Query="SalesPerf">

<Category Format="" Column="Region" DisplayName="Reason for Sales" />
<Series Format="" Column="ProductType" DisplayName="Product" />
<Values>

<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="Sales
Amount" />
</Values>
</Chart>
</Dashboard>

<!-- Dashboard Layout Configuration -->
<DashboardLayout>
<Landscape>
<!-- Dashboard display in Landscape Orientation -->
<!-- Column Chart occupy 60% of the screen height and 100% width -->
<Layout Name="SalesOrderCount" Top="0" Left="0" Width="100" Height="60" />
<Layout Name="SalesPerformance" Top="61" Left="0" Width="100" Height="40" />

</Landscape>
<Portrait>
<!-- Dashboard display in Portrait Orientation -->
<!-- Column Chart occupy 50% of the screen height and 100% width -->

<Layout Name="SalesOrderCount" Top="0" Left="0" Width="100" Height="50" />
<Layout Name="SalesPerformance" Top="51" Left="0" Width="100" Height="50" />
</Portrait>
</DashboardLayout>
</MobileAnalytic>

5. Click File > Save.

Implementing the MAKit Query Module

The MAKit Query module contains two Objective-C protocols: MAQueryDelegate and

MAQueryDataTable.

MAQueryDelegate includes the executeQuery method, which executes the name of the query defined

in the XML metadata configuration of the chart.
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MAQueryDataTable holds the result of the query and is passed to the chart to draw the chart.

Creating the ChartDataTable Class

The ChartDataTable class must conform to MAQueryDataTable protocol and must implement all the
protocol methods defined in MAQueryDataTable. The ChartDataTable holds the result set of the query,
which is passed to the chart to draw the chart.

In the MAKitSample project, select File > New > New File.
Select iOS > Cocoa Touch >Objective-C class and click Next.

Accept NSObject in the Subclass of field and click Next.

A

Enter ChartDataTable in the Save As field and click Save.
This creates the ChartDataTable.h and ChartDataTable.m files.

5. Click chartDataTable.h and replace the existing code with:

#import <Foundation/Foundation.h>
#import "MAKit.h"

@interface ChartDataTable : NSObject<MAQueryDataTable> ({

}

@property (nonatomic,retain) NSArray *tabularData;

@end

6. Click File > Save.

7. Click chartDataTable.mand replace the existing code with:
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#import "ChartDataTable.h"
@implementation ChartDataTable
@synthesize tabularData;

#pragma mark -
#pragma mark MAQueryDataTable Delegate methods

- (int)getColumnCount {

if (self.tabularData != nil && [self.tabularData count] > 0)

{
NSDictionary* row = (NSDictionary*) [self.tabularData objectAtIndex:0];
return [row count];

}

else

{

return 0;

}

- (int)getRows {

if (self.tabularData != nil) {
return [self.tabularData count];
}
else {
return 0;

}

- (id)getbata: (NSString*)colName atIndex: (int)rowIndex {
if (self.tabularData != nil && [self.tabularData count] > rowIndex)
{
NSDictionary* row = (NSDictionary*) [self.tabularData objectAtIndex:rowlIndex];
return [row objectForKey:colName] ;

}

else

{
return nil;
}
}

#pragma mark -
- (void) dealloc {

[self.tabularData release];
[super dealloc];

}

@end

8. Click File > Save.

Creating the ChartQuery Class

The ChartQuery class must conform to MAQueryDelegate protocol and must implement the
executeQuery method to execute the query associated with the chart. (The name of the query is
configured in the XML metadata in the Query attribute of the chart tag.)

1. Inthe MAKitSample project, select File > New > New File.

14| Page





2. Select iOS > Cocoa Touch >Objective-C class and click Next.
3. Accept NSObject in the Subclass of field and click Next.
4. Enter ChartQuery in the Save As field and click Save.

This creates the ChartQuery.h and ChartQuery.mfiles.

5. Click chartQueryClass.h and replace the existing code with:

#import <Foundation/Foundation.h>
#import "MAKit.h"

@interface ChartQuery : NSObject<MAQueryDelegate> ({

}

@end

6. Click File > Save.

7. Click chartQuery.mand replace the existing code with:

#import "ChartQuery.h"
#import "ChartsDatasource.h"
#import "ChartDataTable.h"

@implementation ChartQuery

#pragma mark -
#pragma mark MAQueryDelegate method

- (id<MAQueryDataTable>) executeQuery: (NSString*) queryName withArgument:
(NSDictionary*)args {

ChartDataTable *dataTable = [[ChartDataTable alloc] init];

if ([queryName isEqualToString:@"OrderCount"]) {
ChartsDatasource *cds = [[ChartsDatasource alloc] init];
dataTable.tabularData = [cds NumberOfOrders];

[cds release];

}

else if ([queryName isEqualToString:@"SalesPerf"]) {
ChartsDatasource *cds = [[ChartsDatasource alloc] init];
dataTable.tabularData = [cds SalesPerformance];

[cds release];

}

return dataTable;

}

@end

8. Click File > Save.
Creating the User Interface for the Application

Configuring MAKitSampleAppDelegate Files

The MAKitSampleAppDelegate.h and MAKitSampleAppDelegate .m files are created when you

create the Xcode project, but you must add the view controller property to the header file and create the

view controller instance in the implementation file to display the initial view.





1. Click MAKitSampleAppDelegate.h and replace the existing code with the code below to add
the view controller property to the application delegate.

#import <UIKit/UIKit.h>
@interface MAKitSampleAppDelegate : NSObject <UIApplicationDelegate> {

}

@property (nonatomic, retain) IBOutlet UIWindow *window;
@property (nonatomic, retain) IBOutlet UINavigationController *navController;

@property (nonatomic, retain, readonly) NSManagedObjectContext *managedObjectContext;
@property (nonatomic, retain, readonly) NSManagedObjectModel *managedObjectModel;
@property (nonatomic, retain, readonly) NSPersistentStoreCoordinator
*persistentStoreCoordinator;

- (void)saveContext;
- (NSURL *)applicationDocumentsDirectory;

- (void) copySampleDbToDevice;

@end

2. Click File > Save.

3. ClickMAKitSampleAppDelegate.mand replace the portions of existing code as indicated
below, to create an instance of view controller property and to copy the database to the device:

#import "MAKitSampleAppDelegate.h"

@implementation MAKitSampleAppDelegate

@synthesize window=_window;

@synthesize navController;

@synthesize managedObjectContext= managedObjectContext;

@synthesize managedObjectModel= managedObjectModel;

@synthesize persistentStoreCoordinator= persistentStoreCoordinator;

- (BOOL)application: (UIApplication *)application
didFinishLaunchingWithOptions: (NSDictionary *) launchOptions
{

//Copy database to device

[self copySampleDbToDevice];

//Create & Add view controller instance
[self.window addSubview:navController.view];
[self.window makeKeyAndVisible];

return YES;
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//Copy MAKitTutorials.sglite database to device

- (void) copySampleDbToDevice {
NSFileManager *fm = [NSFileManager defaultManager];
NSError *copyError;

NSArray *pathArray = NSSearchPathForDirectoriesInDomains (NSDocumentDirectory ,
NSUserDomainMask, YES);

NSString *appDocDir = [paths objectAtIndex:0];

NSString *deviceDBPath = [appDocDir
stringByAppendingPathComponent:@"MAKitTutorials.sqglite"];

BOOL dbExist = [fm fileExistsAtPath:deviceDBPath];

if (!dbExist) {

NSString *sourceDBPath = [[[NSBundle mainBundle] resourcePath]
stringByAppendingPathComponent:@"MAKitTutorials.sqglite"];
dbExist = [fm copyltemAtPath:sourceDBPath toPath:deviceDBPath

error:&copyError];

if (!dbExist)
NSLog (@"Failed to Copy Sample Database to device/simulator. Error
Msg = '%Q@'.", [copyError localizedDescription]);

4. Click File > Save.

Adding the MainViewController
Create a MainViewController view controller, which functions as the main screen for the MAKitSample
application.

1. Inthe MAKitSample project, select File > New > New File.
2. Select iOS > Cocoa Touch > UlViewController subclass and click Next.

3. SelectUITableViewController inthe Subclass of field, unselect With XIB for user interface,
select Targeted for iPad, then click Next.

4, EnterMainViewController inthe Save As field and click Save.
This creates the MainViewController.h and MainViewController.m files.

5. ClickMainvViewController.h and replace the existing code with:

#import <UIKit/UIKit.h>
@interface MainViewController : UITableViewController {

}

@property (nonatomic, retain) NSMutableArray *viewControllers;

@end

6. Click File > Save.

7. ClickMainviewController.mand replace the existing code with:
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#import "MainViewController.h"
#import "ChartQuery.h"
#import "MAKit.h"

@implementation MainViewController
@synthesize viewControllers;

- (void)dealloc
{
[super dealloc];
}
#pragma mark - View lifecycle
- (void)viewDidLoad
{
[super viewDidLoad];
self.viewControllers = [[NSMutableArray alloc] init];

NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];
[dict setObject:@"MAKit Basic Charts" forKey:Q@"Title"];

[dict setObject:@"SalesMetadata" forKey:W@"MetaData"];
[self.viewControllers addObject:dict];

[dict release];

- (void)viewDidUnload

[super viewDidUnload];

self.viewControllers nil;

- (BOOL) shouldAutorotateToInterfaceOrientation: (UIInterfaceOrientation)
interfaceOrientation
{
// Return YES for supported orientations
return YES;
}
#pragma mark - Table view data source
- (NSInteger)tableView: (UITableView *)tableView
numberOfRowsInSection: (NSInteger) section
{
return [self.viewControllers count];

}

- (UITableViewCell *)tableView: (UITableView *)tableView cellForRowAtIndexPath:
(NSIndexPath *)indexPath

{
static NSString *CellIdentifier = @"Cell";

UITableViewCell *cell = [tableView
dequeueReusableCellWithIdentifier:CellIdentifier];
if (cell == nil) {
cell = [[[UITableViewCell alloc] initWithStyle:UITableViewCellStyleDefault

reuseldentifier:CellIdentifier] autorelease];

}

// Configure the cell...

NSMutableDictionary *dict = [self.viewControllers objectAtIndex:indexPath.row];
cell.textLabel.text = [dict objectForKey:@"Title"];

cell.accessoryType = UlTableViewCellAccessoryDisclosurelIndicator;

return cell;
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#pragma mark - Table view delegate

- (void) tableView: (UITableView *)tableView didSelectRowAtIndexPath: (NSIndexPath

*) indexPath

{
NSMutableDictionary *dict = [self.viewControllers objectAtIndex:indexPath.row];
NSString *metaFile = [dict objectForKey:@"MetaData"];

//Create MAViewController

ChartQuery *query = [[ChartQuery alloc] init];

MAViewController *mv = [[MAViewController alloc] init];

mv.metaDataPath = [[NSBundle mainBundle] pathForResource:metaFile ofType:@"xml"];
mv.theme = [[[MAKitTheme WelterWeight alloc] init] autorelease];

mv.dataSource = query;

[self.navigationController pushViewController:mv animated:YES];
[query releasel;
[mv release];

}

@end

8. Click File > Save.

Making Connections
Add the Navigation Controller to the MainWindow.xib file, and connect the navController outlet
defined in MAKitSampleAppDelegate to the Navigation Controller.

1. Click the MainWindow.xib file and, if the Objects Library pane is not already visible, select View >
Utilities > Object Library.

2. Dragand drop the Navigation Controller onto the Objects pane below the MAKit Sample App
Delegate icon.

3. Control-drag from the MAKit Sample AppDelegate icon to the new Navigation Controller icon to
create a navController outlet.

4. Click the expansion arrow on the Navigation Controller icon, select Navigation Controller > View
Controller, and in the identity inspector, select MainviewController in the Class field.

n B8 E v < ©
¥ Custom Class
| Class | MainViewController & =] l]
¥ Identity
- Label [Xeode Specific Label |
obean| 11
Lok

Motes (] Show With Selection

.-:3:"\4 > | [ MAKitSample » | |MAKitSa. . )

[ Placeholders

File's Owner
@) First Responder

i# Objects

|| Window
1 Kit Sample App Delegate
v @ Navigation Controller
" Navigation Bar

» @ Main View Controller - Root View ...

x
[
I
0
I
[}
1
I
[«1»(

Objects @E
-I-W ADBannerView class provides a view

| that displays banner...

‘Object - Provides a template for

objects and controllers not directly
available in Interface Builder.

External Object - Provides a
placeholder for an object that exists
outside of the decument.

The ViewController name in the hierarchy changes to MainviewController, and the
connection from the AppDelegate to the Navigation Controller is created.

19|Page





5. Click File > Save.

Deploying the Application
Deploy the MAKitSample application to the iPad Simulator for testing.
1. Inthe Xcode MAKitSample project, verify that the Scheme is set to MAKitSample > iPad 4.3
Simulator, and select Product > Clean.
2. Select Product > Build.
If you correctly followed all the steps in the tutorial, you see a Build Succeeded message.
3. Select Product > Run.

The project is rebuilt, and the iPad Simulator starts and loads the application. You see the initial
screen:

9:52 AM

MAKit Tutorial

MAKit Basic Charts >

4. Click MAKit Basic Charts.
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iPad = 11:26 AM

MAKit Tutorial MAKit Basic Charts
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5. Click the arrow image to the right to load the chart in full screen.
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iPad = 11:46 AM

Done Sales Performance By Region
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6. Click Done to return to the previous (dashboard) view.
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Lesson 3: Building Semantic Zooming Charts Using Metadata

This lesson creates a sales performance zooming chart. At the highest level, the chart depicts sales
performance in North America and Europe, by year. The chart includes user interface controls that allow
you to zoom into lower levels, for example, to see sales performance by quarter and by month.

This lesson describes:

e  Configuring multiple zooming levels for a chart in metadata
e Writing queries for each zooming level in datasource class
e  How semantic zooming works at runtime

Adding Methods to the ChartsDataSource Class

To create a zooming chart that has three levels (year, quarter, and month), create three methods—one
for each level.

1. Inthe Xcode IDE, open MAKitSample.xcodepro].

2. Inthe Project Navigator, click ChartsDatasource.h file and add these method definitions:

#import <Foundation/Foundation.h>
#import "sglite3.h"

@interface ChartsDatasource : NSObject ({
sglite3 *dbInstance;
}

//Zooming Charts Datasource methods
- (NSArray *) SalesByYear;

- (NSArray *) SalesByQuarter;

- (NSArray *) SalesByMonth;

3. Click File > Save.

4. C(Click chartbatasource.m file and add the method implementation code for the three
methods:

23| Page





#import "ChartsDatasource.h"

@implementation ChartsDatasource

//Zooming Charts Datasource methods
//SalesByYear Method
- (NSArray *) SalesByYear ({
NSMutableArray *returnArray = [[NSMutableArray alloc] init];

const char * SELECTQry = "SELECT SalesYear, RegionGroup,Sum(SalesAmount) "
" FROM ResellerSales WHERE SalesYear>2001 AND RegionGroup <>'Pacific'"
" GROUP BY SalesYear,RegionGroup ";

sglite3 stmt *selectStmt = nil;

if (sglite3 prepare v2(dbInstance, SELECTQry, -1, &selectStmt, NULL)==SQLITE OK) {
NSString *year = @"";
NSString *region = @"";
float salesamount = 0.0;
while (sglite3 step(selectStmt)==SQLITE ROW) {
year = [NSString stringWithUTF8String: (char *)
sqlite3 column text (selectStmt, 0)];
region = [NSString stringWithUTF8String: (char *)
sqlite3 column text (selectStmt, 1)];
salesamount = sglite3 column double (selectStmt, 2);

NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];
[dict setObject:year forKey:@"SalesYear"];
[dict setObject:region forKey:@"Region"];
[dict setObject: [NSNumber numberWithFloat:salesamount]
forKey:@"SalesAmount"];
[returnArray addObject:dict];
[dict release];
}
}
else {
NSLog (@"Failed at Prepare Statement in SalesByYear.
Reason %s",sglite3 errmsg(dbInstance));
}
return returnArray;

}

//SalesByQuarter Method
- (NSArray *) SalesByQuarter ({
NSMutableArray *returnArray = [[NSMutableArray alloc] init];

const char * SELECTQry = "SELECT SalesYear, SalesQuarter, RegionGroup, "
" Sum(SalesAmount) FROM ResellerSales "
" WHERE SalesYear>2001 AND RegionGroup <>'Pacific'"
" GROUP BY SalesYear, SalesQuarter,RegionGroup ";

sglite3 stmt *selectStmt = nil;

if (sglite3 prepare v2(dbInstance, SELECTQry, -1, &selectStmt, NULL)==SQLITE OK) {
NSString *year = @"";
NSString *gtr = @"";
NSString *region = @"";
float salesamount = 0.0;
while (sglite3 step(selectStmt)==SQLITE ROW) {
year = [NSString stringWithUTF8String: (char *)
sgqlite3 column text (selectStmt, 0)];

gtr = [NSString stringWithUTF8String: (char *)
sglite3 column text (selectStmt, 1)];

region = [NSString stringWithUTF8String: (char *)
sglite3 column text (selectStmt, 2)];

salesamount = sqlite3 column_double (selectStmt, 3);
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NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];

[dict setObject:year forKey:@"SalesYear"];

[dict setObject:gtr forKey:Q@"SalesQuarter"];

[dict setObject:region forKey:@"Region"];

[dict setObject: [NSNumber numberWithFloat:salesamount]
forKey:@"SalesAmount"];

[returnArray addObject:dict];

[dict release];
}
}
else {
NSLog (@"Failed at Prepare Statement in SalesByQuarter.
Reason %s",sqglite3 errmsg(dbInstance));
}

return returnArray;
}

//SalesByMonth Method
- (NSArray *) SalesByMonth({
NSMutableArray *returnArray = [[NSMutableArray alloc] init];

const char * SELECTQry = "SELECT SalesYear, SalesQuarter, SalesMonth, RegionGroup,

" Sum(SalesAmount) FROM ResellerSales "
" WHERE SalesYear>2001 AND RegionGroup <>'Pacific'"

sglite3 stmt *selectStmt = nil;

if (sglite3 prepare v2(dbInstance, SELECTQry, -1, &selectStmt, NULL)==SQLITE OK)

NSString *year = @"";
NSString *gtr = @"";
NSString *mth = @"";
NSString *region = @"";

float salesamount = 0.0;
while (sglite3 step(selectStmt)==SQLITE ROW) {
year = [NSString stringWithUTF8String: (char *)

sqlite3 column text (selectStmt, 0)];

gtr = [NSString stringWithUTF8String: (char *)
sgqlite3 column text (selectStmt, 1)];

mth = [NSString stringWithUTF8String: (char *)
sglite3 column text (selectStmt, 2)];

region = [NSString stringWithUTF8String: (char *)
sqlite3 column_ text (selectStmt, 3)];

salesamount = sglite3 column double (selectStmt, 4);

NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];
dict setObject:year forKey:@"SalesYear"];
dict setObject:qgtr forKey:Q@"SalesQuarter"];
dict setObject:mth forKey:Q@"SalesMonth"];
dict setObject:region forKey:@"Region"];

[dict setObject: [NSNumber numberWithFloat:salesamount]
forKey:@"SalesAmount"];

[returnArray addObject:dict];

[
[
[
[

[dict release];

}
}
else {

NSLog (@"Failed at Prepare Statement in SalesByMonth.

Reason %s",sglite3 errmsg(dbInstance));

}
return returnArray;

}

@end

GROUP BY SalesYear,SalesQuarter,SalesMonth,RegionGroup ";

{

5. Click File > Save.
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Creating XML Metadata File with Zooming Levels

Next, create a new XML metadata file with which to configure the zooming chart. Zoom behavior for each
level is configured in the <ZoomingLevels> .. </ZoomingLevels>taginthe metadata.
Configure the first zooming level to display the sales performance by year:
1. Inthe MAKitSample project, click File > New > New File.
2. Select iOS > Other > Empty and click Next.
3. Enter ZoomingChartMetadata.xml in the Save As field and click Save.
This creates the ZoomingChartMetadata.xml file.

4, Click ZoomingChartMetadata.xml and add this content to the file:

<?xml version="1.0" encoding="utf-8"?2>
<MobileAnalytic MAKitVersion="1.1" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalLocation="MAKitMetaFile.xsd">

<Dashboard>

<!-- Zooming Chart configuration for Sales Performance ByYear/Qtr/Month -->
<Chart Name="ZoomingChart" Title="Sales Performance" ChartType="Column" >

<Category Format="" DisplayName="Sales ByYear—-Quarter-Month" />
<Series Format="" Column="Region" DisplayName="Sales Region" />
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="" />
</Values>
<!-- Zooming Levels Configuration -->
<ZoomingLevels>

<ZoomingLevel Query="SalesByYear" CategoryColumn="SalesYear" Title="ByYear" />

<ZoomingLevel Query="SalesByQuarter" CategoryColumn="SalesQuarter" Title="ByQuarter" />

<ZoomingLevel Query="SalesByMonth" CategoryColumn="SalesMonth" Title="ByMonth" />
</ZoomingLevels>

</Chart>

</Dashboard>
<DashboardLayout>
<Landscape>
<!-- Dashboard display in Landscape Orientation -->
<Layout Name="ZoomingChart" Top="0" Left="0" Width="100" Height="80" />
</Landscape>

<Portrait>
<!-- Dashboard display in Portrait Orientation -->
<Layout Name="ZoomingChart" Top="0" Left="0" Width="100" Height="85" />
</Portrait>
</DashboardLayout>
</MobileAnalytic>

5. Click File > Save.
Adding Scripts in ChartQuery and ViewController Classes

Modifying ChartQuery Class
Add code to the ChartQuery class to execute the appropriate datasource query method, depending on
the zooming level.

1. Inthe Project Navigator, click the ChartsQuery.mfile.

2. Append this code to the executeQuery method with the existing script in the method:
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3.

#import "ChartQuery.h"
#import "ChartsDatasource.h"
#import "ChartDataTable.h"

@implementation ChartQuery

#pragma mark -
#pragma mark MAQueryDelegate method

- (id<MAQueryDataTable>)executeQuery: (NSString*)queryName withArgument:

(NSDictionary*)args {

ChartDataTable *dataTable = [[ChartDataTable alloc] init];

else if ([queryName isEqualToString:@"SalesByYear"]) {
ChartsDatasource *cds = [[ChartsDatasource alloc] init];
dataTable.tabularData = [cds SalesByYear];

[cds release];

}
else if ([queryName isEqualToString:@"SalesByQuarter"]) {

ChartsDatasource *cds [ [ChartsDatasource alloc] init];
dataTable.tabularData = [cds SalesByQuarter];
[cds release];

}

else if ([queryName isEqualToString:@"SalesByMonth"]) {
ChartsDatasource *cds = [[ChartsDatasource alloc] init];
dataTable.tabularData = [cds SalesByMonth];

[cds release];

}

return dataTable;

@end

Click File > Save.

Adding Script to MainViewController Class

1.
2.

3.

In the Project Navigator, click the MainviewController.mfile.

Add this code to the ViewDidLoad method with the existing script in the method:

- (void)viewDidLoad

{

//Zooming Chart

dict = [[NSMutableDictionary alloc] init];

[dict setObject:@"MAKit Zooming Chart" forKey:@"Title"];
[dict setObject:@"ZoomingChartMetadata" forKey:@"MetaData"];
[self.viewControllers addObject:dict];

[dict releasel;

Click File > Save.
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Deploying the Application
Deploy the MAKitSample application to the iPad Simulator for testing.
1. Inthe Xcode MAKitSample project, verify that the Scheme is set to MAKitSample > iPad 4.3
Simulator, and select Product > Clean.
2. Select Product > Build.

If you correctly followed all the steps in the tutorial, you see a Build Succeeded message.

3. Select Product > Run.

The project is rebuilt and iPad Simulator starts and loads the application. The initial screen now
contains additional entry for “Zooming Chart.”

9:52 AM

MAKIt Tutorial

MAKit Basic Charts >

MAKit Zooming Chart >

4. Click MAKit Zooming Chart.
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MAKit Tutorial MAKit Zooming Chart

Sales Performance
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Click the arrow image in the upper-right corner to load the chart in full screen.

The zooming chart loads in full screen with zooming level 1 (Sales ByYear) selected:
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6. Click ByQuarter.
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7. Click ByMonth.
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Lesson 4: Building Drilldown Charts Using Metadata

This lesson describes how to create three levels of drilldown chart on reseller sales data. At the highest
level, the chart shows reseller sales, aggregated by product category. Tapping a particular product
category loads a sales performance for the selected product category grouped by product subcategory in
three regions. Tapping a particular region loads a detailed chart for that region.

This lesson describes:

e  Configuring the metadata for a drilldown group with three levels in a drilldown chart
e Creating datasource queries for drilldown charts by passing query parameters

e Userinteractions in drilldown charts

Adding Methods to the ChartsDataSource Class

To create a drilldown chart with three levels of drilldown, create three methods: one to retrieve summary
data, one to retrieve data based on selected product category, and one to retrieve data for a selected
product category and region.

1. Openthe MAKitSample.xcodeproj inthe Xcode IDE.

2. Inthe Project Navigator, click the Chartsbatasource.h file and add these method definitions:

#import <Foundation/Foundation.h>
#import "sglite3.h"

@interface ChartsDatasource : NSObject {
sglite3 *dbInstance;
}

//Drilldown Charts Datasource methods

- (NSArray *) ResellerSummary;

- (NSArray *) ResellerDataForProduct: (NSString *) product;

- (NSArray *) ResellerDataForProduct: (NSString *) product andRegion: (NSString *) region;

w

Click File > Save.

E

Click ChartDatasource.m file and add the method implementation code for the methods:
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#import "ChartsDatasource.h"

@implementation ChartsDatasource

//Drilldown Charts Datasource methods
//ResellarSummary Data
- (NSArray *) ResellerSummary {

const char* SELECT="SELECT ProductCategory, RegionGroup, round(sum( SalesAmount),2) "
" FROM ResellerSales Group By ProductCategory,RegionGroup ";

NSMutableArray *data = [[NSMutableArray alloc] init];

sqlite3 stmt *selectStmt = nil;

if (sqlite3 prepare v2(dbInstance, SELECT, -1, &selectStmt, NULL)==SQLITE OK) {
NSString *pc=@"";
NSString *rg=@"";
double amount =0;

while (sglite3 step(selectStmt)==SQLITE ROW) {

pc = [NSString stringWithUTF8String: (char *) sqlite3 column text (selectStmt, 0
rg = [NSString stringWithUTF8String: (char *) sqglite3 column text (selectStmt, 1)
amount = sqlite3 column double(selectStmt, 2);

)1:
17

NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];
[dict setObject:pc forKey:@"ProductCategory"];
[dict setObject:rg forKey:@"Region"];
[dict setObject: [NSNumber numberWithDouble:amount] forKey:@"SalesAmount"];
[data addObject:dict];
[dict releasel;
}
}
elsel |
NSLog (@"Failed at Prepare Statement in ResellerSummary.
Reason %s",sqlite3 errmsg(dbInstance));
}

return data;

//ResellerData for specific product
- (NSArray *) ResellerDataForProduct: (NSString *) product {

const char * SELECT = "SELECT RegionGroup, ProductSubCategory, "
"round (sum (SalesAmount), 2) FROM ResellerSales "
" WHERE ProductCategory = ? GROUP BY RegionGroup, ProductSubCategory";

NSMutableArray *data = [[NSMutableArray alloc] init];
sglite3_stmt *selectStmt = nil;
if (sqglite3 prepare v2(dbInstance, SELECT, -1, &selectStmt, NULL)==SQLITE OK) {

sqglite3 bind text (selectStmt, 1, [product UTF8String], -1, SQLITE STATIC);

NSString *region=Q@"";
NSString *psc=@"";
double amount =0;

while (sglite3_step (selectStmt)==SQLITE_ROW) {
region = [NSString stringWithUTF8String: (char *)sglite3 column_text (selectStmt,0)];
psc = [NSString stringWithUTF8String: (char *)sglite3 column text (selectStmt, 1)];
amount = sglite3_column_double (selectStmt, 2);

NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];
[dict setObject:region forKey:@"Region"];
[dict setObject:psc forKey:@"ProductSubCategory"];
[dict setObject: [NSNumber numberWithDouble:amount] forKey:@"SalesAmount"];
[data addObject:dict];
[dict release];
}
}
else {
NSLog (@"Failed at Prepare Statement in ResellerProductByRegion. Reason %s",
sglite3_errmsg (dbInstance)) ;
}

return data;

//ResellerData for Selected product & region
- (NSArray *) ResellerDataForProduct: (NSString *) product andRegion: (NSString *) region {
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const char * SELECT = "SELECT Country,ProductSubCategory, round (sum(SalesAmount),2)
" FROM ResellerSales WHERE ProductCategory = ? AND RegionGroup = ? "
" GROUP BY Country, ProductSubCategory ";

"

NSMutableArray *data =

[ [NSMutableArray alloc] init];
sglite3 stmt *selectStmt nil;

if (sqglite3 prepare v2(dbInstance, SELECT, -1,
sqglite3_bind text (selectStmt, 1,

&selectStmt, NULL)==SQLITE OK) {
[product UTF8String], -1, SQLITE_ STATIC);
sqlite3 bind text (selectStmt, 2, [region UTF8String], -1, SQLITE STATIC);

NSString *country = @"";
NSString *psc=@"";
double amount =0;
while (sglite3_step(selectStmt)==SQLITE ROW) {
country = [NSString stringWithUTF8String: (char *)
psc [NSString stringWithUTF8String: (char *)
amount = sqlite3 column double (selectStmt, 2);

sqlite3 column text (selectStmt, 0)];
sglite3_column_text (selectStmt, 1)];

NSMutableDictionary *dict

[ [NSMutableDictionary alloc] init];
[dict

setObject:country forKey:Q@"Country"];
[dict setObject:psc forKey:@"ProductSubCategory"];

[dict setObject: [NSNumber numberWithDouble:amount] forKey:@"SalesAmount"];
[data addObject:dict];

[dict release];

}

else {

NSLog (@"Failed at Prepare Statement in ResellerProductByRegion. Reason %s",
sqlite37errmsg( dbInstance)) ;
}

return data;

@end

5. Click File > Save.

Creating XML Metadata File Configured with DrillDownGroup
Create a new XML metadata file to configure drilldown charts within the DrillDownGroup. Configure all

the charts in the drilldown in the <DrillDownGroup> .. </DrillDownGroup>tag in the metadata.

Individual drilldown levels are identified by ChartSequence attribute in the chart configuration.

1. Inthe MAKitSample project, click File > New > New File.

2. Select iOS > Other > Empty and click Next.

3. EnterDrilldownChartMetadata.xml in the Save As field and click Save.

This creates the DrilldownChartMetadata.xml file.

4., Click DrilldownChartMetadata.xml and add this content to the file:
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<?xml version="1.0" encoding="utf-8"?2>
<MobileAnalytic MAKitVersion="1.1" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation="MAKitMetaFile.xsd">

<Dashboard>
<!-- Drilldown Chart configuration -->
<DrillDownGroup Name="DrilldownChart" Title="Drilldown By ProductCategory to Zooming Chart">
<!-- Chart Sequence 1 -->

<Chart Name="SalesSummary" Title="Reseller Sales Summary For All Regions"
ChartType="Column" ChartSequence="1" Query="ResellerSummary" ByCategory="1" >

<Category Format="" Column="ProductCategory" DisplayName="ProductCategory" />
<Series Format="" Column="Region" DisplayName="" />
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="" />
</Values>
</Chart>
<!-- Chart Sequence 2 -->

<Chart Name="SalesByRegion" Title="Reseller Sales By Region" ChartType="Column"
ChartSequence="2" Query="ResaleByRegion">

<Category Format="" Column="Region" DisplayName="RegionGroup" />
<Series Format="" Column="ProductSubCategory" DisplayName="" />
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="" />
</Values>
</Chart>
<!-- Chart Sequence 3 -->

<Chart Name="SalesByCountry" Title="Reseller Sales By Country" ChartType="Column"
ChartSequence="3" Query="ResaleByCountry">
<Category Format="" Column="Country" DisplayName="Country" />
<Series Format="" Column="ProductSubCategory" DisplayName="" />
<Values>
<Value Format="Currency" Expression="SalesAmount" ValueSequence="1" DisplayName="" />
</Values>
</Chart>

</DrillDownGroup>
</Dashboard>

<DashboardLayout>
<Landscape>
<!-- Dashboard display in Landscape Orientation -->
<Layout Name="DrilldownChart" Top="0" Left="0" Width="100" Height="80" />
</Landscape>
<Portrait>
<!-- Dashboard display in Portrait Orientation -->
<Layout Name="DrilldownChart" Top="0" Left="0" Width="100" Height="85" />
</Portrait>
</DashboardLayout>

</MobileAnalytic>

5. Click File > Save.
Adding Scripts in ChartQuery and ViewController Classes

Modifying ChartQuery Class
Add the code in ChartQuery class to execute the appropriate datasource query method, depending on
the drilldown level.

1. Inthe Project Navigator, click the ChartsQuery.m file.

2. Append this code to the executeQuery method with the existing script.
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#import "ChartQuery.h"
#import "ChartsDatasource.h"
#import "ChartDataTable.h"

@implementation ChartQuery

#pragma mark -
#pragma mark MAQueryDelegate method

- (id<MAQueryDataTable>)executeQuery: (NSString*)queryName withArgument:
(NSDictionary*)args {

ChartDataTable *dataTable = [[ChartDataTable alloc] init];

else if ([queryName isEqualToString:@"ResellerSummary"]) {
ChartsDatasource *cds = [[ChartsDatasource alloc] init];
dataTable.tabularData = [cds ResellerSummary];

[cds release];

}

else if ([queryName isEqualToString:@"ResaleByRegion"]) {
ChartsDatasource *cds = [[ChartsDatasource alloc] init];
NSString *product = (NSString *) [args objectForKey:@"ProductCategory"];
dataTable.tabularData = [cds ResellerDataForProduct:product];
[cds release];

}

else if ([queryName isEqualToString:@"ResaleByCountry"]) {
ChartsDatasource *cds = [[ChartsDatasource alloc] init];
NSString *product = (NSString *) [args objectForKey:@"ProductCategory"];
NSString *region = (NSString *) [args objectForKey:@"Region"];
dataTable.tabularData = [cds ResellerDataForProduct:product andRegion:
region];

[cds release];

} return dataTable;

@end

3. Click File > Save.

Adding Script to MainViewController Class
1. Inthe Project Navigator, click the MainViewController.m file.

2. Add this code to the viewDidLoad method with the existing script in the method:

- (void)viewDidLoad

{

//DrillDown Chart

dict = [[NSMutableDictionary alloc] init];

[dict setObject:@"MAKit DrillDown Chart" forKey:@"Title"];
[dict setObject:@"DrilldownChartMetadata" forKey:@"MetaData"];
[self.viewControllers addObject:dict];

[dict release];

3. Click File > Save.
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Deploying the Application
Deploy the MAKitSample application to the iPad Simulator for testing.
1. Inthe Xcode MAKitSample project, verify that the Scheme is set to MAKitSample > iPad 4.3
Simulator, and select Product > Clean.
2. Select Product > Build.

If you correctly followed all the steps in the tutorial, you see a Build Succeeded message.

3. Select Product > Run.

The project is rebuilt and iPad Simulator starts and load the application. The initial screen now
contains a “MAKit Drilldown Chart” row.

12:25 PM
MAKIt Tutorial
MAKIit Basic Charts >
MAKit Zooming Chart >
MAK:it Drilldown Chart >

4. Click MAKit Drilldown Chart.
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iPad 12:33 PM

MAKit Tutorial MAKit Drilldown Chart

Reseller Sales Summary For All Regions
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5. Click the arrow image in the upper-right corner to load the chart in full screen.
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iPad 12:25 PM

Reseller Sales Summary For All Regions
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6. Double-tap Bikes.
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7. Double-tap North America.

41| Page





iPad 12:25 PM 100% B3
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Lesson 5: Adding Dynamic Analytics to Charts

Dynamic analytics is a powerful feature of MAKit that provides on-device analytic capability to give end
users instant insight into dynamic data for effective decision making, and allow them to explore
alternative scenarios and outcomes.

The core components of dynamic analytics include:

e Variable declaration
e Chart value-expression using the declared variables
e The DA Panel

This lesson describes:

e Declaring variables in metadata
e Creating expressions for chart value axis by using variables
e Creating the DA Panel and its layout

e  Runtime behavior

Creating Dynamic Analytic XML Metadata Configuration

This lesson reuses the ChartDatasource method NumberOfOrders and the OrderCount query.

o Declare these two variables: $globalpromotion of type boolean and Sregionalsalesdrive
of type enum.

e  Write a chart value expression as if Sglobalpromotion is true, double the OrderCount value
(multiply it by 2)

e If $globalpromotion is false, determine which region currently has sales promotion (by
checking the $regionalsalesdrive value) and apply the expression as OrderCount * 6 for
that region only.

1. Inthe MAKitSample project, click File > New > New File.

2. Select iOS > Other > Empty and click Next.

3. Enter DAPanelMetadata.xml inthe Save As field and click Save.
This creates the DAPanelMetadata.xml file.

4. Click DAPanelMetadata.xml and add this content to the file:
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<?xml version="1.0" encoding="utf-8"?2>
<MobileAnalytic MAKitVersion="1.1" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation="MAKitMetaFile.xsd">

<Dashboard>

<!-- Variable Declaration -->
<Variables>
<Variable Name="$globalpromotion" DisplayName="Is Global Sales Promotion On?2"
VariableType="boolean" Value="0" />
<Variable Name="$regionalsalesdrive" DisplayName="Sales Drive in "
VariableType="enum" Selection="0">
<Choices>
<Choice Display="Eastern" Value="Eastern" />
<Choice Display="Western" Value="Western" />
<Choice Display="Central" Value="Central" />
<Choice Display="South" Value="South" />
<Choice Display="Canada" Value="Canada" />

</Choices>
</Variable>

</Variables>
<!-- Configure Chart Value Axis with Expression using Variables declared -->
<Chart Name="DAChart" Title="Number Of Sales Orders" ChartType="Column" Query="OrderCount">

<Category Format="" Column="Year" DisplayName="Sales Year" />

<Series Format="" Column="Region" DisplayName="Region" />

<!-- Expression. IF Global Sales Promotion is ON, THEN #of Orders is doubled.

ELSE #of Orders is 6 times more in Regional Sales Drive END IF -->

<Values>
<Value Format="RoundedQO"
Expression="1if ($globalpromotion==1,0rderCount * 2,
if (Region==S$regionalsalesdrive, OrderCount * 6,0OrderCount))"
ValueSequence="1" DisplayName="Number Of Orders" />
</Values>
</Chart>

<!-- DAPanel Configuration -->
<DAPanel Name="SalesDAPanel" Title="Sales Dynamic Analytic Panel">
<VariableName Name="$globalpromotion" Sequence="1" />
<VariableName Name="S$regionalsalesdrive" Sequence="2" />
</DAPanel>

</Dashboard>

<DashboardLayout>
<Landscape>
<!-- Dashboard display in Landscape Orientation -->
<Layout Name=" DAChart " Top="0" Left="0" Width="100" Height="70" />
<Layout Name="SalesDAPanel" Top="71" Left="0" Width="100" Height="30" />
</Landscape>
<Portrait>
<!-- Dashboard display in Portrait Orientation -->
<Layout Name=" DAChart " Top="0" Left="0" Width="100" Height="70" />
<Layout Name="SalesDAPanel" Top="71" Left="0" Width="100" Height="30" />
</Portrait>
</DashboardLayout>

</MobileAnalytic>

5. Click File > Save.
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Adding Scripts in ChartQuery and ViewController Classes

Modifying ChartQuery Class
No script is needed in ChartQuery class; we are reusing the OrderCount query.

Adding Script to the MainViewController Class
1. Inthe Project Navigator, click the MainViewController.mfile.

2. Add this code to the ViewDidLoad method with the existing script in the method:

- (void)viewDidLoad

{

//Dynamic Analytic Chart

dict = [[NSMutableDictionary alloc] init];

[dict setObject:@"MAKit Dynamic Analytic Chart" forKey:@"Title"];
[dict setObject:@"DAPanelMetadata" forKey:@"MetaData"];
[self.viewControllers addObject:dict];

[dict releasel];

3. Click File > Save.

Deploying the Application
Deploy the MAKitSample application to the iPad Simulator for testing.
1. Inthe Xcode MAKitSample project, verify that the Scheme is set to MAKitSample > iPad 4.3
Simulator, and select Product > Clean.
2. Select Product > Build.
If you correctly followed all the steps in the tutorial, you see a Build Succeeded message.
3. Select Product > Run.

The project is rebuilt and iPad Simulator starts and load the application. The initial screen now
contains an “MAKit Dynamic Analytic Chart” row.

4:20 PM

MAK:Iit Tutorial

MAKIit Basic Charts >
MAKit Zooming Chart >
MAK:it Drilldown Chart >
MAKit Dynamic Analytic Chart >

4. Click MAKit Dynamic Analytic Chart.
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5. Set the Global Sales Promotion switch to ON.

The OrderCount across all regions in all categories is doubled, and the chart redrawn.
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Lesson 6: Adding What-If Analysis to Charts

What-if analysis is similar to dynamic analytics. Both allow the user to change data behind the chart and
immediately see the chart updated; both map the data to Ul controls on the screen. However, dynamic
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analytics changes the variables defined in expressions, while what-if analysis changes the data retrieved
from the datasource.

This lesson describes:

e  Configuring what-if columns in XML metadata
e  How what-if columns are mapped to Ul controls

e  Runtime behavior of what-if analysis

Adding Methods to ChartsDataSource Class
To illustrate what-if analysis, create a new datasource method in ChartsbDatasource class and use some
of the datasource columns to configure what-if columns in the metadata.

1. Openthe MAKitSample.xcodeproj inthe Xcode IDE if it is not already open.

2. Inthe Project Navigator, click the ChartsDatasource.h file and add these method definitions:

#import <Foundation/Foundation.h>
#import "sglite3.h"

@interface ChartsDatasource : NSObject {
sglite3 *dbInstance;
}

//What-If Chart Datasource methods
- (NSArray *) ProductSales;

3. Click File > Save.

4. Clickthe ChartDatasource.m file and add the method implementation code:
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#import "ChartsDatasource.h"

@implementation ChartsDatasource

//WhatIf Chart Datasource method
- (NSArray *) ProductSales {

const char * SELECT "SELECT Region,ProductTypel|'-"'||ProductName, UnitPrice,sum(sd.Quantity) "

" FROM SalesOrder Header s, SalesOrder Details sd, Product p "
" WHERE s.0rderID = sd.OrderID AND sd.ProductID = p.ProductID AND "
" p.ProductID < 500 GROUP BY Region, ProductType,UnitPrice";

NSMutableArray *data = [[NSMutableArray alloc] init];
sqlite3 stmt *selectStmt = nil;

if (sqglite3_prepare_v2 (dbInstance, SELECT, -1, &selectStmt, NULL)==SQLITE_OK) {
NSString *region=@"";

NSString *product = @"";

float unitprice=0.0;

double gty =0;

while (sglite3_step(selectStmt)==SQLITE ROW) {

region = [NSString stringWithUTF8String: (char *) sqglite3 column text (selectStmt, 0)];
product = [NSString stringWithUTF8String: (char *) sglite3_column_text (selectStmt, 1)];
unitprice = sglite3 column_double (selectStmt, 2);

gty = sqglite3 column double(selectStmt, 3);
NSMutableDictionary *dict = [[NSMutableDictionary alloc] init];
[dict setObject:region forKey:Q@"Region"];

[dict setObject:product forKey:@"Product"];

[dict setObject: [NSNumber numberWithFloat:unitprice]

forKey:Q@"UnitPrice"];
[dict setObject: [NSNumber numberWithDouble:qty]

forKey:@"Quantity"];

[data addObject:dict];
[dict release];
}
}
else {
NSLog (@"Failed at Prepare Statement in ProductSales.Reason %s",sglite3_ errmsg(dbInstance));
}

return data;

@end

5. Click File > Save.

Creating XML Metadata File Configured with What-If Columns

Create a new XML metadata file to configure charts with what-if analysis. In the chart configuration
metadata, add datasource columns in the <whatIfColumns> .. </WhatIfColumns> tag.

1. Inthe MAKitSample project, click File > New > New File.

2. Select iOS > Other > Empty and click Next.

3. Enter WhatIfChartMetadata.xml in the Save As field and click Save.
This creates the WhatIfChartMetadata.xml file.

4. Click WhatlfChartMetadata.xml and add this content to the file:
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<?xml version="1.0" encoding="utf-8"?2>

<MobileAnalytic MAKitVersion="1.1" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"

xsi:noNamespaceSchemaLocation="MAKitMetaFile.xsd">
<Dashboard>

<!-- WhatIf Chart Configuration -->
<Chart Name="WhatIfChart" Title="Product Sales Across Regions" ChartType="Column"
Query="ProductSales">

<Category Format="" Column="Region" DisplayName="Region" />
<Series Format="" Column="Product" DisplayName="Product" />
<Values>

<Value Format="Currency" Expression="UnitPrice * Int(Quantity)" ValueSequence="1"

DisplayName="Sales Amount" />
</Values>

<!-- What If Columns -->
<WhatIfColumns>
<Column Name="Quantity" DisplayName="Sales Quantity" VariableType="integer"
Value="200" Min="1" Max="3000" />
<Column Name="UnitPrice" DisplayName="Unit Price" VariableType="float"
Value="0.0" Min="0.0" Max="50.0" Step="0.5" Decimals="2" />
</WhatIfColumns>

</Chart>
</Dashboard>

<DashboardLayout>
<Landscape>
<!-- Dashboard display in Landscape Orientation -->
<Layout Name=" WhatIfChart" Top="0" Left="0" Width="100" Height="80" />
</Landscape>
<Portrait>
<!-- Dashboard display in Portrait Orientation -->
<Layout Name=" WhatIfChart" Top="0" Left="0" Width="100" Height="85" />
</Portrait>
</DashboardLayout>

</MobileAnalytic>

5. Click File > Save.
Adding Scripts in ChartQuery and ViewController Classes

Modifying the ChartQuery Class
Add code to the ChartQuery class to execute the query method.

1. Inthe Project Navigator, click the ChartsQuery.m file.

2. Append this code to the executeQuery method with the existing script in the method:
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#import "ChartQuery.h"
#import "ChartsDatasource.h"
#import "ChartDataTable.h"

@implementation ChartQuery

#pragma mark -
#pragma mark MAQueryDelegate method

- (id<MAQueryDataTable>)executeQuery: (NSString*)queryName withArgument:
(NSDictionary*)args {

ChartDataTable *dataTable = [[ChartDataTable alloc] init];

else if ([queryName isEqualToString:@"ProductSales"]) {
ChartsDatasource *cds = [[ChartsDatasource alloc] init];
dataTable.tabularData = [cds ProductSales];

[cds release];

return dataTable;

@end

3. Click File > Save.

Adding Script to the MainViewController Class
1. Inthe Project Navigator, click the MainViewController.mfile.

2. Add this code to the ViewDidLoad method with the existing script in the method:

- (void)viewDidLoad

{

//What-If Analysis Chart

dict = [[NSMutableDictionary alloc] init];

[dict setObject:@"MAKit What-If Analysis Chart" forKey:@"Title"];
[dict setObject:@"WhatIfChartMetadata" forKey:@"MetaData"];
[self.viewControllers addObject:dict];

[dict release];

3. Click File > Save.

Deploying the Application
Deploy the MAKitSample application to the iPad Simulator for testing.

1. Inthe Xcode MAKitSample project, verify that the Scheme is set to MAKitSample > iPad 4.3
Simulator, and select Product > Clean.

2. Select Product > Build.

If you correctly followed all the steps in the tutorial, you see a Build Succeeded message.

3. Select Product > Run.
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The project is rebuilt and iPad Simulator starts and load the application. The initial screen now
contains an “MAKit What-If Analysis Chart” row.

11:22 AM

MAKIt Tutorial

MAKIit Basic Charts >
MAKit Zooming Chart >
MAKit Drilldown Chart >
MAKit Dynamic Analytic Chart >
MAKit What-If Analysis Chart >

4. Click MAKit What-If Analysis Chart.
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5. Click the arrow image in the upper-right corner to load the chart in full screen.
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6. Tap the category “Western.”
The Western region is selected and the value bubble is updated with values for the Western

region.
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7. While in full-view mode, tap the W.I toolbar button to see the what-if controls for the columns
specified in the metadata.

11:23 AM

( Western
Baseball Cap-Cotton Cap: $2,808.00 Baseball Cap-Wool cap: $2,160.00 | @ Tee Shirt-Crew Ne
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8. Modify the values in the what-if controls to redraw the chart based on those values.
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Lesson 7: MAKit Chart E-Mail Sharing

E-mail sharing is a built-in feature of all MAKit charts that are configured through metadata; no coding is
required.
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With MAKit e-mail sharing, a chart in its current state (as it appears in a device) is captured as an image
and can be further annotated and sent to the business users or peers whose contacts are stored in the
device.

This lesson describes:

e Invoking the e-mail sharing feature

e Annotating a chart and sending it as an e-mail attachment

Sending a Chart Through E-mail

1. Inthe Xcode MAKitSample project, verify that the Scheme is set to MAKitSample > iPad 4.3
Simulator.

2. Select Product > Run.

The project is rebuilt and iPad Simulator starts and load the application.

11:22 AM

MAKIit Tutorial

MAKit Basic Charts >
MAKit Zooming Chart >
MAKit Drilldown Chart >
MAKit Dynamic Analytic Chart >
MAKit What-If Analysis Chart >

3. Click MAKit What-If Analysis Chart.
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4. Click the arrow image in the upper-right corner to load the chart in full screen.
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Tap the W.I toolbar button, which shows the what-if controls for the columns configured in the

metadata.

Tap the mail image E toolbar button. This captures the current screen image and loads it; the
annotation toolbar appears below the image.
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7. Use the annotation toolbar items to annotate the image as shown below:
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8. Tap Send to load the annotated image in a new e-mail message as shown:
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